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1 Introduction

This CIP User Guide assists first time users of OrCAD® Component Information Portal (CIP) get started. The
information presented also provides reference information such as user administration, rule administration and
setting up and using email notifications.

Once CIP is installed, it provides an interface for entering, deleting or modifying parts without the need to access the
master CIS database using native tools. CIP enables the general user to view data in the CIS database without
using a CIS license. CIP also facilitates the conversion of temporary parts to formal parts. Persons in the
administrative role can assign login and passwords to those who need to use CIP. 

CIP is a web-based application that helps you manage components used in schematic designs.

The CIP User Guide is organized in three sections:

· CIP Administration – Explains how the Admin sets up:

o Build rules for part type and description 

o Distributors configuration and synchronization

o Configurations for fields and views, part number prefix, email notifications, pick lists, and
data values

o Bulk Operations

o User accounts, roles and field permissions

· Using CIP – Explains how non-administrative users:

o Manage their components by searching, adding, deleting, and modifying parts

o Place parts

o Create and place reuse modules 

o Import and export BOMs

· Appendix – Additional information on topics regarding usage of CIP

2 Getting Started with CIP

You can open CIP from a standard browser such as Chrome or Edge. You can access CIP from OrCAD Capture or
System Capture (23.1 or 24.1) after you install the corresponding CIP Client plugin. 

To start CIP, launch Chrome and enter the URL address:  http://<servername>/CIP-E  where the <servername> is
the hostname of the CIP web application server. 

Log into CIP with the username and password that your CIP Administrator assigned to you. 
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First time Admin login information is provided in the CIP Installation Guide. The first time login to the local account
uses the Username “Admin”.  User accounts are created and modified with the menu selection: Admin > User,
Roles & Permissions Administration. We recommend that the Admin user change the Admin password after the
first log in. 

You can launch CIP from OrCAD Capture after you install the CIP Client plugin and configure the CIP URL in
Capture. 

The CIP Client Installation Guide includes additional information regarding the usage of CIP as well as information
to help you set up your Capture.ini file. 

CIP Login Screen

If you are unable to see the CIP login screen, please contact your administrator or IT team who installed CIP.

If a version incompatibility screen displays when you navigate to the CIP URL, please contact your administrator or IT
team who installed CIP. A partial upgrade of CIP may cause this error. An example of the screen in shown in the
following figure.
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3 CIP Administration

CIP Administrative features are available through the Admin menu. Users need to be granted specific administrative
role permissions to configure options. 

Admin Menu Items

The Admin menu enables access to the following admin options:

§ Build Rules – Set-up build rules for auto-build of part type and description   

§ Bulk Operations

o Bulk Delete parts in CIP from CSV

o Bulk Rename parts in CIP from CSV

o Component View Mover – Move parts between views within a table

o Import parts from CSV to CIP

o TMPPRTS Import

§ Configuration

o Component Views, Customizable Fields, and Field Transfer Options

o Reorder and Group View Fields

o BOM/Design Options for BOM Format and Design Parts Sync

o Email Notifications

o Color Indicator for Manufacturer Part Status

o Separator selection for Import and Export files

o Part Number Prefix

o CIP Link setup (for viewing of CIP parts from CIS)

o Configure Reuse Module Location

o Ultra Librarian download options

o Enable Virtual Librarian Service (VLS) menu item and Manufacturer PN request button

o Configure fields to be transferred to design

o System Capture Configuration

o Show link to active users on the log in page

§ Distributors – Distributors Administration

o Automatic sync of data from distributors
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o Country settings and customer ID

§ Scheduled Reports – Create regularly scheduled exports of any saved Global Search

§ Users, Roles, & Permissions – Users, Roles & Permission Administration

o Add, remove and modify users

o Configure user specific notification

o Define new roles

o Configure field permissions for each role

Users who have partial administrative permissions can view only the list of options that are specifically granted to
them. Conversely, a user without granted permission to the build rules option is unable to view those options. The
figure that follows, for example, shows a view of the menu items that are available to an admin user who lacks
privileges to the build rules. Refer to User Administrative Role Permissions for more info.

Admin Menu Items Without

Privilege to Build Rules

3.1  Build Rules

The Rule Administration page is used to manage build rules. This includes editing predefined rules and deleting
rules. Rules can be set for the description and part type fields only. The default rules are provided in the Appendix
topics, Part Type Standards and Description Standards. More samples of rules can be found later in this document.

Admin > Build Rules

3.1.1  Rule Basics

A rule is a set of instructions used to automatically create data using data that has been derived elsewhere. An
example of this would be creating a description for a part based on other data, which has already been provided
such as Part Type, Package Size, Value, Tolerance, etc. A person in the role of Librarian will find the Rule building
capability useful when trying to pull existing data from various fields relating to a specific part, and “build” new data
descriptions or part types using the Auto-Build function. This capability promotes a consistent and accurate method
for adding data to the description or part type fields in the database. 
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A sample of the output of a rule is shown below, where the results have been populated into the Description field or

the Part Type field by clicking the Auto-Build  button. The data in the Description field and the data in the Part
Type field is a result of requesting specific information from parametric data that resides in the CIS database.  

Note: CIP users with Edit Formal Parts permission may use the Auto-Build button. However, only CIP users with Set
Rules administrative permission may define rules. The process for creating and using rules is explained in the
following sections. 

Sample Rule Results

Each Rule is defined for a Table which the rule applies to, and the Field name (Part Type or Description) that will be
populated when the Auto-Build feature is used. Rules can only be applied to two parametric fields: Part Type and
Description. Each rule has a set of one or more data blocks. Additionally, a Block Delimiter may be set to add a
predefined character delimiter between each data block. The default Block Delimiter is “None,” which puts one field
immediately after another. In general, the Block Delimiter should be set to one of the options provided. The Block
Delimiter may be set to “None” for complex rules. If more than one of the same rule has been defined, the one that is
lowest on the list will take effect.

3.1.2  Block Types

There are three Block Types that can be used to build each block of a rule.  Up to 10 blocks can be applied per rule.
You may change between block types at any time by selecting a new block type from the drop down list. The block
types available are If, Switch, and Value. Each behaves in a specific manner.

Block Types
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3.1.2.1  Value Blocks

When the Block Type is set to Value, a simple value is added to the output either in the form of a constant or a value
pulled directly from another CIS field. The “Value from Field” checkbox, when checked, allows the use of another CIS
field as the value. 

Value Block Type

3.1.2.2  If Blocks

When the Block Type is set to "If," the value set is based on the conditions you select from the drop list menus as
well as the text strings you type into the input boxes. For example, when you select "If" as the Block Type, you need to
select values from the drop list menus to define the "Data Source" and "Condition." The menu options for Data
Source are values from the CIP database. 

You need to type in a text string to define the value for the "Value to compare to" condition. The "Value to compare to"
box is the specified value used for testing the condition. 

When you check the "Value from Field?" checkbox, the value you select in the "Field" column is used. When this
checkbox is unchecked, you need to type a text string into the "Field" input box. The "Value from Field?" checkbox
operates just like it does in Value Blocks switching between a “Constant” value and pulling a value from a specified
field for use in the output if the condition is true.   

If Blocks

The result of the above example after Auto-Build is shown below, where, IF the Data Source “Dielectric Type” uses
the Condition “Contains”, and the "Value to compare to" is Ceramic, then the Description field would be populated
with the Dielectric Type (Ceramic) after the Auto-Build button is selected. 
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If Block Results

Conditions

The Data Source box is used to select the CIS field that the condition will test.  The Condition box is the test condition
to be used.  Allowable conditions can be any one of the following (conditions are tested in a case insensitive
fashion):

o Equals – Used to see if the field’s data matches the value provided.

o Does Not Equal – This is the negative case of “Equals” and is used to see if the field data
does not match the value provided.

o Contains – This test is used to find a certain string within the field.  For example: Our field
has the value “Metallic Film” and our test is: Contains “film”. In this case the condition is true
because “Metallic Film” does contain “film” and the constant or field value defined would be
used for the output.

o Does Not Contain – This is the negative case of “Contains” and using the example from
“Contains.”  Our field has the value “Metallic Film” and our test is: Does Not Contain “film”.
This time the condition is false because “Metallic Film” does in fact contain “film” so nothing
will be added to the output from this Block.

o Contains Data – This is used to simply determine whether the specified field has any data at
all.

o Does Not Contain Data – This is the negative case of “Contains Data” and is used to test
whether the field is empty.

o Starts With – Used to see if the field’s data has the specified value at the beginning.

o Does Not Start With – This is the negative case of “Starts With” and is used to see if the
field data does not have the specified value at the beginning.

o Ends With – Used to see if the field’s data has the specified value at the end.

o Does Not End With – This is the negative case of “Ends With” and is used to see if the
field’s value does not have the specified value at the end.
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Build Rule If Block 

3.1.2.3  Switch Blocks

Switch Blocks are used to compare a single field’s value sequentially against multiple conditions (Cases) to find a
true condition (uses the first true condition).  All conditions that can be used with If Blocks can be used with Switch
Blocks and additionally there is the Default Case condition, which is used if all conditions up to that point are false.
To add additional cases to the Switch Block click the Add Case button. A sample of a set of Switch Blocks is shown
below.

Note: A Default Case is required at the end of each Switch Block. 
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Sample Switch Blocks

The results for the sample shown are below, where the Description field was populated with the Output Values
indicated in the Switch Block rule if the conditions were met as true.
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Switch Block Sample Results

If you have added too many cases you may remove a case by clicking the Remove Case button. With switch blocks
you may mix and match conditions, values to compare to, and determine whether the output value is a constant or is
pulled directly from a field. Click the Add Block button to add an additional block (of any type).

Note: There is a maximum limit of 10 blocks that a rule may possess. Removing a block if too many were added is
easy; simply click the Remove Block button. The last block will be removed from the rule once clicked.

To save rules you have just constructed click the Add button. If you are editing a rule, click Update to save.

3.1.3  Editing a Rule

Each of the tables has a set of predefined rules for description and part type. You may remove any of these by
selecting the Clear button. You will be required confirm to complete the deletion. To add a new rule that has been
removed or edit an existing rule, click on the Edit button.



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 11

September 2025

Editing a Rule

Once the appropriate Edit button is clicked the existing rule corresponding to your selection becomes visible. The
following figure shows an example of the ICs Part Type rule.
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Updating a Rule

You may change the following:

· Block Delimiter – is used to separate individual blocks. 

· Block Type  – defines how each block is built. There are three block types available. 

When you are finished editing the rule, click the Update button to complete the edit.  

To cancel current editing changes made to a rule click the Cancel button.  Clicking Cancel also closes the editing
mode.

3.1.4  Using a Rule

After a rule is defined, you can apply the rule when editing part information of a component. Click the Edit button 

 and then click the field Auto-Build button.   
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Using Auto-Build

 

When you click Auto-Build, the field updates with the rule output. The image above shows the Auto-Build buttons for
the Description and Part Type fields. 

3.2  Bulk Operations

The Admin > Bulk Operations menu allows you to perform the operations shown below. Only users belonging to a
user role with Bulk Operations permission will be allowed to access these features.

Admin > Bulk Operations

These options enable you to process the following routine bulk operations:

§ Bulk Delete –  Delete specified parts and/or their associated Manufacturer/Manufacturer PN
and Distributor/Distributor PN pairs from a Comma Separated Value (CSV) file.

§ Bulk Rename –  Rename specified part numbers to new part numbers from a Comma
Separated Value (CSV) file.

§ Component View Mover –  Move parts from one component view to another view that is
associated to the same table.

§ Import – Add parts or Update existing part properties from a Comma Separated Value (CSV)
file.

§ TMPPRTS Import – Import TMP part (TMPPRT) associations when migrating data from a non-CIP CIS
database into your CIP/CIS database. This is required to migrate existing and converted TMP parts and will
allow them to be properly associated in CIS Part Manager.
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3.2.1  Bulk Delete

The Bulk Delete feature allows a list of parts to be deleted from a Comma Separated Value (CSV) file. In CIP, a
company part number (component PN, PART_NUMBER) can have zero-to-many child

Manufacturer/Manufacturer PN (MFR/MFR PN) associations. Each of the
Manufacturer/Manufacturer PN pairs can have zero-to-many child Distributor/Distributor PN
(Dist/Dist PN) associations. Bulk deletion allows you to map these fields to determine what will be
deleted in bulk. Component PN is always required when using Bulk Delete.

You are not able to undo database deletions. It is recommended that you back up your database prior to
performing the Bulk Delete, or at least confirm that regular backups are being created.

Note: Backing up your database may require assistance from your IT or your DBA (database administrator).

Bulk Delete can be accessed from Admin > Bulk Operations > Bulk Delete.

Admin > Bulk Operations > Bulk Delete

A warning shows immediately, informing you that deletion is permanent and advising you to back up your database
before proceeding.

Bulk Delete Warning Message

 

Configure for Deletion explains how to:

· Select and upload your CSV file 
· Map fields from CSV to CIP

Delete Parts explains how to:

§ Preview and simulate the impact of part deletion
§ Delete parts from your CIS/CIP database
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When using Bulk Delete, it's important to know how to properly specify what you are trying to
delete.

· Component PN – Delete the specified component PN and ALL associated child MFR/MFR
PN and Dist/Dist PN pairs.

· Component PN and MFR/MFR PN – Delete only the specified MFR/MFR PN associations
from the component PN, along with ALL MFR/MFR PN child Dist/Dist PN associations.

· Component PN, MFR/MFR PN, and Dist/Dist PN – Delete only the specified Dist/Dist PN
associations from the MFR/MFR PN.

3.2.1.1  Configure for Deletion

The bulk delete process begins with the selection of the Admin > Bulk Operations > Bulk Delete menu. Each time
you select the menu, you are required to verify part configuration before you can simulate and delete parts. This gives
you the opportunity to review and update part mappings when fields have changed.

Admin > Bulk Operations > Bulk Delete

A warning shows immediately, informing you that deletion is permanent and advising you to back up your database
before proceeding.

Bulk Delete Warning Message

 

To configure part data from CSV to CIP

1. Select the Admin > Bulk Operations > Bulk Delete menu.

2. Click the Configuration button.
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Note: If for some reason the bulk delete was interrupted by unforeseen activity (e.g. database restart) or the
deletion stalls at the same state, the Configuration button will be disabled and will be enabled after 30
minutes.

3. Click the Choose File or Browse button (depending on your browser) to select the .CSV file
you want to upload. 

Note: The CSV file must be a valid CSV file without duplicate column headers. Extra columns of data without
headings are considered duplicate headings.

4. Verify that the delimiter selected by default matches the delimiter of your file. Enter another
delimiter if needed.

5. Click the Upload button. If successful, the Key Field Configuration screen will appear when
the upload process is complete.

Choose File, Delimiter, and Upload

6. The Key Field Configuration screen shows the CIP fields and the .CSV fields of your uploaded
file side-by-side to help you map the key fields. Select desired Import Fields from your
uploaded .CSV file to map them to the CIP fields. 

· PART_NUMBER – This is the company part number (component PN) field. This field is a
required field that must be mapped.

· Manufacturer/Manufacturer PN – These fields identify the manufacturer name and
manufacture part number, only required when you want to delete specific
Manufacturer/Manufacturer PN associations from a component PN. Once you specify
Manufacturer, Manufacturer PN becomes required, and vice versa.

· Distributor/Distributor PN  – These fields identify the distributor name and distributor
part number, only required when you want to delete specific Distributor/Distributor PN
associations from a specific Manufacturer/Manufacturer PN. Once you specify Distributor,
Distributor PN becomes required, and vice versa. In addition, Manufacturer/Manufacturer
PN becomes required.

7. Click the Save button to complete configuration and take you back to the Delete tab's
summary screen. You are now ready to Delete Parts.
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Delete the specified component PN and ALL associated child MFR/MFR PN and Dist/Dist PN

pairs.

Delete only the specified MFR/MFR PN associations from the component PN, along with ALL

MFR/MFR PN child Dist/Dist PN associations.

Delete only the specified Dist/Dist PN associations from the MFR/MFR PN.

Import File Format
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Ensure your .CSV file satisfies the following formatting conventions:

· The import file must be in CSV format. Excel can be used to generate CSV files. After
creating your file, you need to save the file as a .CSV file. 

· The first line of the file must contain the field names for each column. If a title is in the first few
lines of the file, you will need to remove those lines first. The field name for each column must
be unique.

· There must be a column for the component PN (PART_NUMBER). Parts without a part
number will not be deleted and will be considered Not Found. Manufacturer, Manufacturer PN,
Distributor, and Distributor PN are optional columns, only required when you want to delete
specific associations to a component PN.

· The CSV file must not have any duplicate column headers. This includes duplicate blank
columns with blank headings.

· All rows within the CSV file should have the same number of columns.

· Characters in the CSV file must be UTF-8 encoded to avoiding encoding warnings.

Warning about using Excel

Older versions of Excel, when used to create or edit .CSV, have caused problems with creating files that are not well-
formed. When this occurs, you will either need to manually fix the file or use a later version of Excel.

3.2.1.2  Delete Parts

After you configure your file for deletion, you can review the log file to preview a description of changes before you
delete your parts from the CIP database. The preview functionality is enabled when the Simulate check box is
selected.

The Simulate check box allows you to verify actions before they are performed on the database. Each time you click
the Delete button a deletion or simulated deletion will occur and a log file will be created. The log file name

corresponding to the Simulate option contains a date-time code and the Simulate text in the file name. The log

file name without the Simulate option contains a date-time code and the Delete text in the file name. The

Component PNs, Manufacturer/Manufacture PNs, and Distributor/Distributor PNs deleted (or to be deleted in the
case of simulation) are recorded in the log file.

The summary section below the Configuration and Delete buttons shows details like Total Rows, Not Found, Parts
Deleted, Mfr Parts Deleted, etc. Additional details can be found by reviewing the log files shown in the Logs tab.

1. Click the Simulate check box to enable simulation mode and click the Delete button to
continue.
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Simulate the Deletion

2. The summary will be updated until the simulation is completed. No deletions will occur during
simulation.
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Deletion Summary

3. Click the Logs tab to view the list of completed logs. Simulation log files will have the
Simulate text while deletion logs will have the Delete text. Click an individual log file name to

view it. Click the  button to save the file. Notice that logs with the Simulate text in the file
name also have the simulation message at the top and bottom of the log file, as shown
below.

Log File Selected, Displaying Simulation Message at the Top of Log
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Summary and Simulation Message at the End of Log

4. Review the log file and confirm the desired changes. When ready, click the Delete tab.

Keep in mind that once parts are deleted from the database, the only way to recover is to restore a previous
database backup. Re-importing the deleted parts would bring the parts back, but all parametric field values
would be lost unless you also saved a file to import those. Reviewing the log file simulation before deleting
parts from your database helps minimize problems associated with accidental deletion.

5. Uncheck the Simulate check box and click Delete.

Uncheck Simulate and Proceed with Deletion

6. A Delete Parts? confirmation window appears. Enter the word DELETE in ALL CAPS. The
Delete button will be disabled until you do so. Click Delete. The summary will be updated
until the deletion is completed.
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Delete Parts Confirmation Pop-up Window

7. Click the Logs tab to view the list of completed logs. Simulation log files will have the
Simulate text in the file name, while deletion logs will have the Delete text. Click an individual
log file name to view it. Click the Download button to save the file. Notice that logs with the
Delete text in the file name do not have a simulation message at the top and bottom of the
log file, as shown below.

Log File Selected



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 23

September 2025

Summary at the End of Log

Here's an example of what you can specify. The column header names in your CSV file are up to
you, since you'll be mapping those when you Configure for Deletion. 

PN MFR MFR PN Dist Dist PN Expected Behavior

PN001

Delete PN001 and ALL associated child

Manufacturer/Manufacturer PN and Distributor/Distributor PN pairs.

PN002 MFR02 MFRPN11

Delete MFR02/MFRPN11 association from PN002, along w ith ALL

child Distributor/DIstributor PN associations on MFR02/MFRPN11.

PN003 MFR03 MFRPN25 Dist3 DistPN20   Delete Dist3/DistPN20 association from MFR03/MFRPN25.

PN003 MFR04 MFRPN39

Delete MFR04/MFRPN39 association from PN003, along w ith ALL

child Distributor/DIstributor PN associations on MFR04/MFRPN39.

PN004 MFRPN54   No action, MFR not found.

MFR04 MFRPN54   No action, PN not found.

PN004 MFR04 MFRPN54 DistPN33   No action, Dist not found.

Below is the log file from the example above, showing how deletions are output in the log. A pipe
(|) delimiter separates Component PN, MFR/MFR PN, and Dist/Dist PN. A comma (,) delimiter
separates MFR and MFR PN pairs and Dist and Dist PN pairs. Each parent or child deletion is
logged on a new line.
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Import File Format

Ensure your .CSV file satisfies the following formatting conventions:

· The import file must be in CSV format. Excel can be used to generate CSV files. After
creating your file, you need to save the file as a .CSV file. 

· The first line of the file must contain the field names for each column. If a title is in the first few
lines of the file, you will need to remove those lines first. The field name for each column must
be unique.

· There must be a column for the component PN (PART_NUMBER). Parts without a part
number will not be deleted and will be considered Not Found. Manufacturer, Manufacturer PN,
Distributor, and Distributor PN are optional columns, only required when you want to delete
specific associations to a component PN.

· The CSV file must not have any duplicate column headers. This includes duplicate blank
columns with blank headings.
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· All rows within the CSV file should have the same number of columns.

· Characters in the CSV file must be UTF-8 encoded to avoiding encoding warnings.

Warning about using Excel

Older versions of Excel, when used to create or edit .CSV has caused problems with creating files that are not well-
formed. When this occurs, you will either need to manually fix the file or use a later version of Excel.

Log files 

Log files are accessible from the Admin > Bulk Operations > Bulk Delete > Log tab.  Two types of log files may be
generated, (Simulate and Delete). The file name of each log file consists of the date, separated by a "T" and the time,
followed by "Simulate" or "Delete." For example, the file name of the log is based on one of the two naming
conventions:

YYYYMMDDTHHMMSS_Simulate.txt – generated each time you run Delete with the Simulate check box selected. 

YYYYMMDDTHHMMSS_Delete.txt – generated each time you run Delete without the Simulate check box selected,
where: 

YYYY =  year 
MM = month
DD = day
T -  separates the date and time of log generation.
HH = hour
MM = minutes
SS = seconds

The log files record information for potential or actual deletions, warnings, and errors. Warnings are generated for
parts that are not processed. This is often caused by improperly configured field mappings.

3.2.2  Bulk Rename

The Bulk Rename feature allows a list of parts to be renamed from one company PN to another, using a Comma
Separated Value (CSV) file. The CSV file requires a column identifying the current Company PN (PART_NUMBER),

Component View to which it belongs, and the desired New Company PN.

It is recommended that you back up your database prior to performing the Bulk Rename, or at least confirm that
regular backups are being created.

Note: Backing up your database may require assistance from your IT or your DBA (database administrator).

Bulk Rename can be accessed from Admin > Bulk Operations > Bulk Rename.
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Admin > Bulk Operations > Bulk Rename

A warning shows immediately, informing you that renaming is permanent and advising you to back up your
database before proceeding.

Bulk Rename Warning Message

 

Configure for Rename explains how to:

· Select and upload your CSV file 
· Map fields from CSV to CIP

Rename Parts explains how to:

§ Rename parts in your CIP/CIS database

When using Bulk Rename, it's important to know how to properly specify what you are trying to
rename.

· Component View – This is the Component View of the current company part number
(component PN) being renamed. This field is a required field that must be mapped.

· PART_NUMBER – This is the company part number (component PN) field. This field is a
required field that must be mapped.

· New PART_NUMBER – This is the company part number (component PN) field. This field is
a required field that must be mapped.

3.2.2.1  Configure for Rename

The bulk rename process begins with the selection of the Admin > Bulk Operations > Bulk Rename menu.
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Admin > Bulk Operations > Bulk Rename

A warning shows immediately, informing you that renaming is permanent and advising you to back up your
database before proceeding.

Bulk Rename Warning Message

 

To configure part data from CSV to CIP

1. Select the Admin > Bulk Operations > Bulk Rename menu.

2. Click the Configuration button.

Note: If for some reason the bulk rename was interrupted by unforeseen activity (e.g. database restart) or the
rename stalls at the same state, the Configuration button will be disabled and will be enabled after 30
minutes.

3. Click the Choose File or Browse button (depending on your browser) to select the .CSV file
you want to upload. 

Note: The CSV file must be a valid CSV file without duplicate column headers. Extra columns of data without
headings are considered duplicate headings.

4. Verify that the delimiter selected by default matches the delimiter of your file. Enter another
delimiter if needed.

5. Click the Upload button. If successful, the Key Field Configuration screen will appear when
the upload process is complete.
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Choose File, Delimiter, and Upload

6. The Key Field Configuration screen shows the CIP fields and the .CSV fields of your
uploaded file side-by-side to help you map the key fields. Select desired Import Fields from
your uploaded .CSV file to map them to the CIP fields. 

· Component VIew – This is the Component VIew of the current company part number
(component PN) being renamed. This field is a required field that must be mapped.

· PART_NUMBER – This is the company part number (component PN) field. This field is a
required field that must be mapped.

· New PART_NUMBER  – This is the company part number (component PN) field. This
field is a required field that must be mapped.

7. Click the Save button to complete configuration and take you back to the Rename tab's
summary screen. You are now ready to Rename Parts.

Rename mapped PART_NUMBER to NEW PART_NUMBER, and validate w ith Component View

Import File Format

Ensure your .CSV file satisfies the following formatting conventions:

· The import file must be in CSV format. Excel can be used to generate CSV files. After
creating your file, you need to save the file as a .CSV file. 

· The first line of the file must contain the field names for each column. If a title is in the first few
lines of the file, you will need to remove those lines first. The field name for each column must
be unique.
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· There must be a column for the Component View, current Company PN (PART_NUMBER), and

desired new Company PN. Parts without a part number or with one that doesn't exist in CIP will
not be renamed and will be considered Not Found.

· The CSV file must not have any duplicate column headers. This includes duplicate blank
columns with blank headings.

· All rows within the CSV file should have the same number of columns.

· Characters in the CSV file must be UTF-8 encoded to avoiding encoding warnings.

Warning about using Excel

Older versions of Excel, when used to create or edit .CSV, have caused problems with creating files that are not well-
formed. When this occurs, you will either need to manually fix the file or use a later version of Excel.

3.2.2.2  Rename Parts

After you configure your file for rename, you can proceed with the bulk rename. As part of the rename action, a pre-
check validation will confirm that the existing parts to be renamed exist in CIP and belong to the specified component
view. This helps ensure the correct parts are renamed.

The summary section below the Configuration and Rename buttons shows details like Missing Data, Not Found,
ExistingPN, Duplicate Source, Duplicate Target, etc. Additional details can be found by reviewing the log files shown
in the Logs tab.

1. Click the Rename button to continue. Each time you click the Rename button, the CSV data
will be validated before proceeding with the rename.

Rename After Configuration
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2. A Rename Parts? confirmation window appears. Enter the word RENAME in ALL CAPS.
The Rename button will be disabled until you do so. Click Rename.

Rename Parts Confirmation Pop-up Window

3. The summary will be updated until the rename is completed. The validation pre-check will
confirm that the existing parts to be renamed exist in CIP and belong to the specified component view. Once
validation is completed successfully, the rename will begin.

Rename Summary

4. Click the Logs tab to view the list of completed logs. Validation log files are only created when
the validation pre-check fails and they will have the ValidationError text in the file name.
Rename logs will have the BulkRename text. Click an individual log file name to view it. Click



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 31

September 2025

the  button to save the file. Notice that logs with the BulkRename text in the file name do
not have a validation message at the top and bottom of the log file, as shown below.

Log File Selected

Summary at the End of Log

Here's an example of what you can specify. The column header names in your CSV file are up to
you, since you'll be mapping those when you Configure for Rename. 

Compo
nent
View

PART_
NUMBE

R

NEW
PART_NU

MBER Expected Behavior

Capacitors PNCAP001 CAP-001-00

Validate that PNCAP001 exists in CIP and belongs to the Capacitors view , then

Rename PNCAP001 to CAP-001-00.

Resistors PNRES002 RES-002-00

Validate that PNRES002 exists in CIP and belongs to the Capacitors view , then

Rename PNRES002 to RES-002-00.
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Import File Format

Ensure your .CSV file satisfies the following formatting conventions:

· The import file must be in CSV format. Excel can be used to generate CSV files. After
creating your file, you need to save the file as a .CSV file. 

· The first line of the file must contain the field names for each column. If a title is in the first few
lines of the file, you will need to remove those lines first. The field name for each column must
be unique.

· There must be columns for the Component View, Component PN (PART_NUMBER), and
New Component PN (PART_NUMBER). If any single part does not exist in your CIP or exists
in a different component view than specified, validation will fail and rename will not begin.
Review the log, fix the issues, and repeat the process to try again.

· The CSV file must not have any duplicate column headers. This includes duplicate blank
columns with blank headings.

· All rows within the CSV file should have the same number of columns.

· Characters in the CSV file must be UTF-8 encoded to avoiding encoding warnings.

Warning about using Excel

Older versions of Excel, when used to create or edit .CSV has caused problems with creating files that are not well-
formed. When this occurs, you will either need to manually fix the file or use a later version of Excel.

Log files 

Log files are accessible from the Admin > Bulk Operations > Bulk Rename > Log tab.  Two types of log files may be
generated, (ValidationError and BulkRename). The file name of each log file consists of the date, separated by a "T"
and the time, followed by "ValidationError" or "BulkRename." For example, the file name of the log is based on one of
the two naming conventions:

YYYYMMDDTHHMMSS_ValidationError.txt – generated each time you run Rename and the validation pre-check
encounters errors.

YYYYMMDDTHHMMSS_BulkRename.txt – generated each time you run Rename and validation pre-check succeeds
and rename begins. 

YYYY =  year 
MM = month
DD = day
T -  separates the date and time of log generation.
HH = hour
MM = minutes
SS = seconds

The log files record information for validation errors (ValidationError logs) or rename actions and errors
(BulkRename logs).
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3.2.3  Component View Mover

Admin > Bulk Operations > Component View Mover

The Component View Mover can be used to move parts in bulk to a different Component View of the same table.
Once you create a Component View, you can move selected parts from an originating table to the new component
view. 

Note: Users who are granted the role to perform Bulk Operations (Admin > User Roles & Permissions > Roles tab)
have permission to move components in bulk.

To begin, create a .CSV file that includes the parts that you want to move. You can do this by exporting search results.
 

1. Open the exported .CSV file. Add or modify a column to contain the name of the Component
View for the parts you want to move. Save your .CSV file.

2. Click Admin > Bulk Operations > Component View Mover to access the Component View
Mover tool.

3. Click Choose File, browse to the saved .CSV file you created, then click Upload.

Select .CSV List of Parts To Be Moved

4. Use the First Data Row field to select the first row of data below the heading row. The first
row to be included is highlighted in green as shown in the screen image below.
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Select the First Data Row

5. Select the columns that contain part number information and the Component View name, by
using the drop-down menus above the column headings.

Map PART_NUMBER Column

6. To verify that the information is properly selected, click the Check button.

If one or both of the required columns is improperly selected, the following error message opens:

Mapping Error Message

If all information is entered and selected properly, "Validation Succeeded" displays.
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Mapping Validation Message

7. Click Move to move the parts to the new Component View.

Move Button to Reconfigure Component View

Once the parts are successfully moved, the following message displays:  

Confirmation Message

Note: If you want to move a single part to an alternate view, see topic, Moving a Part to a Different View.

3.2.4  Import

The Import feature loads parts and properties from a Comma Separated Value (CSV) file to your CIP/CIS database.
Although usage of this feature is available when you open CIP from Capture, when you are importing a large number
of parts you may prefer to open CIP from your browser to more quickly process part information.  

Configure for Import explains how to:

§ Select and upload your CSV file 
§ Map fields from CSV to CIP

Add Import Data explains how to:

§ Preview and simulate the impact of a data import
§ Add parts and update your CIS/CIP database

After the import is complete, you are not able to undo database updates. If you are making numerous updates, be
sure to back up your database to ensure you are able to restore your pre-update state. Note: Backing up your
database may require assistance from your IT or your DBA (database administrator). 

As shown in the screen image that follows, access to Import is provided from Admin > Bulk Operations > Import.. 
Screens that display guide you as you configure, simulate, and import data.
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Admin > Bulk Operations > Import

3.2.4.1  Configure for Import

The import process begins with the selection of the Admin > Bulk Operations > Import menu. Each time you select
the Import menu, you are required to verify part configuration before you can simulate, add, and update parts. This
gives you the opportunity to review and update part mappings when part properties may have changed.  

To configure part data from CSV to CIP

1. Select the Admin > Bulk Operations > Import menu.   

2. Click the Configuration button. 

Configuration Button Opens CSV File Window

If for some reason the import was interrupted by unforeseen activity (e.g. database restart) or the import stalls
at the same state, the Configuration button will be disabled and will be enabled after 30 minutes.

3. Click the Choose File or Browse button (depending on your browser) to select the .CSV file
you want to import. 
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Selecting and Uploading CSV File

Note: The CSV file must be a valid CSV file without duplicate column headers. Extra columns of data without
headings are considered duplicate headings. Non-ANSI characters in a ANSI formatted CSV file will not import
correctly. CSV files containing UTF-8 characters and formatted as UTF-8 will import as the UTF-8 characters.
When using Excel to view or edit a CSV file, you will need to ensure that you import the data in the correct
format.

4. Verify that the delimiter selected by default matches the delimiter of your file. Enter another
delimiter if needed.

5. Click the Upload button. When the upload process is complete, the word "Success" displays
to the right of the Upload button. 

6. Click the Next button to open the Key Field Configuration screen. This screen shows the CIP
fields and the .CSV fields of your uploaded file side-by-side to help you map the key fields.

a. Click the Auto Map button to automatically map CIP field names that are an exact match
to the fields of your uploaded CSV file.

b. Click the selection arrow of each Import Field to map CIP fields to the field of your
uploaded .CSV file. 

The following example shows the key field mappings after clicking the Auto Map button, then manually
mapping the CSV's Table to CIP's Component View. Since the CSV file headers matched the PART_NUMBER,
Manufacturer, Manufacturer PN, Distributor, and Distributor PN, they were all auto mapped and only the
Component View needed to be mapped manually.

 
       Sample Key Field Configuration Screen 

Click Auto Map, then manually map the Component View
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· Part Number – This is the company part number field. This field is a required field and
must be filled in.

· Component View – This is the field in your CSV file that identifies the CIP Component
View for which the part is to be imported. This is a required field. 

· Manufacturer – This is the field in your CSV file that identifies the name of the
manufacturer. This is an optional field. To successfully import manufacturer parts, both the
"Manufacturer" field and "Manufacturer PN" field must be mapped.  

· Manufacturer PN – This is the field in your CSV file that identifies the manufacturer part
number. This is an optional field. To successfully import manufacturer parts, both the
"Manufacturer" field and "Manufacturer PN" field must be mapped.

· Distributor  – This is the field in your CSV file that identifies the name of the distributor.
This is an optional field. To successfully import a distributor part, both the "Distributor" field
and "Distributor PN" field need to be mapped. 

· Distributor PN – This is the field in your CSV file that identifies the distributor part number.
This is an optional field. To successfully import a distributor part, both the "Distributor" field
and "Distributor PN" field need to be mapped. 

7. Click Next to proceed to the Capacitors Fields Mappings page. 

Component Field Mappings Screen

Note: A separate "Field Mapping" page is provided for each component view. To successfully import parts into a
component view, you need to map one or more fields in the Field Mappings page for that component view. The
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series of gray dots below the Previous and Next buttons indicate the current or active page as you progress
through the pages. 

8. Click the Auto Map button to automatically map CIP field names that are an exact match to
the fields of your uploaded CSV file. Each field may optionally be mapped manually.

Be sure to verify all view configurations each time you go through this process. Changes to
the import file may impact parts imported. Review mapped fields and edit as appropriate. 

9. Continue through all configured component views. If the Manufacturer Name and Manufacturer
PN are configured in step #6, then Manufacturer Field Mappings screen opens. Map
manufacturer fields using the same instructions in step #8. 

 
                   Manufacturer Fields Mappings Screen

Only displays when Manufacturer field mapped in Key Field Configuration screen

10. If the Distributor Name and Distributor PN are configured in step #6, then the Distributor Field
Mappings screen opens. Map the distributor fields using the same instructions provided in step
#8. 
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Distributor Fields Mappings Screen

Only displays when Distributor field mapped in Key Field Configuration screen

11. Click the Save button that is included on the last configuration mapping page. A summary
screen displays that shows the number of component parts processed, updated, and
imported. Because you have only completed configuration mappings, each section of the
summary screen is zero. 

The last saved configuration that is applicable to the newly uploaded CSV file will pre-populate each time you
revisit the Field Mappings pages. 

3.2.4.2  Add Import Data

After you configure your file for import, you can review the log file to preview a description of changes before you
import your parts into the CIP database. The preview functionality is enabled when the Simulate check box is
selected. 

Whether you are previewing or performing an actual import, you have the following import options:
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o Add new parts without updating existing parts (Add Only button) - The Add Only button
adds new parts and new manufacturer parts. Parts that already exist in the database
remain unaltered. Field data for existing parts in the CSV will not be used in the import.

o Add new parts and update existing parts (Add and Update button) - The Add and Update
button adds new parts and updates attributes associated to parts already in the database.

Each time you click the Add Only or Add and Update button a log file is created.  The log file name corresponding to
the Simulate option contains a date-time code and the text "Simulate". The log file name without the Simulate option
contains a date-time code and the text "Import". Information presented in the log describes changes that correspond
to the Add Only or Add and Update action. 

The Simulate check box allows you to verify actions before they are performed on the database. A summary number
of new parts added, the number of existing parts updated, the number of new manufacturer parts added, the number
of existing manufacturer parts updated, the number of new distributor parts added, the number of existing distributor
parts updated and the total number of parts processed is included in the log file.  Summary information is provided
in the Import screen. 

Keep in mind that once an update to the database is performed, the only way to recover is to restore a previous
database backup.  Reviewing the log file simulation before updating your database helps minimize problems and
the unintentional import of wrong data. 

Import File Format

Ensure your .CSV file satisfies the following formatting conventions:

· The import file must be in CSV format. Excel can be used to generate CSV files. After
creating your file, you need to save the file as a .CSV file. 

· The first line of the file must contain the field names for each column. If a title is in the first few
lines of the file, you will need to remove those lines first. The field name for each column must
be unique.

· There must be a column for the part number and a column for the part category. Each part in
the file must have a part number and a part category. Parts without a part number or part
category are not imported. Manufacturer, Manufacturer PN, Distributor, and Distributor PN are
optional columns. 
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· The CSV file must not have any duplicate column headers. This includes duplicate blank
columns with blank headings.

· All rows within the CSV file should have the same number of columns.

· Characters in the CSV file must be UTF-8 encoded to avoiding encoding warnings.

Required Values 

The PART NUMBER may be in any format. However, values for the part category field must match the CIP view

names configured using Admin > Configuration > Component Views tab. The capitalization of the letter case must
also match. The following list shows the views from an out-of-the-box CIP installation.  

· Capacitors
· Connectors
· Crystals and Oscillators
· Diodes
· ICs
· Inductors
· Mechanical
· Misc
· Relays
· Resistors
· Switches
· Transformers
· Transistors

Duplicate Parts 

When a part is duplicated in the import file but contains different values, only one set of the data is imported. If the
duplicate part has different manufacture or manufacturer part number, each of the manufacturer parts is added. In
the following example, part PN0001 will be added once, but with only one of the two descriptions shown. Both
manufacturer parts will be added and will be associated to PN0001.

Part Number Category Manufacturer Manufacturer PN Description

PN0001 Capacitors VISHAY 293D336X9016B2TE
3

CAP, 33 uF 10% 16 V
3528 SMD Tantalum

PN0001 Capacitors AVX Corporation TAJA336K006RNJ
CAP, 33 UF 10% 6.3V
3216-18 SMD
Tantalum

When a part in the .CSV file is already in the database but has a Part Category mismatch from the part in the
database, the part will not be update and a warning will be in the log file.

Different manufacturer Name or part Number from database
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Manufacturer parts that have any differences in the manufacturer name or part number will be added. Manufacturer
part data will only be updated when both manufacturer name and part number are an exact match.  For example,
when AVX is compared to AVX Corporation, it will be considered as a different part and will be added.

Warning about using Excel

Older versions of Excel, when used to create or edit .CSV, have caused problems with creating files that are not well-
formed. When this occurs, you will either need to manually fix the file or use a later version of Excel.

Log files 

Log files are accessible from the Admin > Bulk Operations > Import > Log tab.  Two types of log files may be
generated, (Simulate and Import). The filename of each log file consists of the date, separated by a "T" and the time,
 followed by "Simulate" or "Import." For example, the file name of the log is based on one of the two naming
conventions:

YYYYMMDDTHHMMSS_Simulate.txt – generated each time you run either Add Only or Add and Update import
options with the Simulate check box selected. 

YYYYMMDDTHHMMSS_Import.txt – generated  each time you run without the Simulate check box selected where: 

YYYY =  year 
MM = month
DD = day
T -  separates the date and time of log generation. 
HH = hour 
MM = minutes 
SS = seconds

The log files record information for potential or actual changes and list warnings and errors. Warnings are generated
for parts that are not processed. This is often caused by improperly configured field mappings. Information is not
logged when a part is missing a Part Number.   
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Sample Log File

A "Summary" of actions is located at the end of the log. The image that follows provides an example of the log
summary.

Sample Log Summary

Sample Warning



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 45

September 2025

The number of warnings recorded in the log is stated in the Summary located at the bottom of the log. For example,
the following log file shows two warnings. Categories must be named the same as your CIP views.

When the .CSV file you are importing contains ANSI encoded characters, an encoding warning is recorded in the log.
Parts that have a Part Number containing ANSI characters cannot be processed. Parts that have attribute values that
contain ANSI characters will be imported with the character shown in the log.   

The image below provides an example of a part that has an encoding error in its part number--this part cannot be
processed. The other part will be imported but data imported is changed as stated in the log file. 
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Log warnings indicating use of ANSI Encoded characters 

3.2.5  TMPPRTS Import

When parts are migrated from an existing CIS database to a new CIP database, your parts may also include TMP
parts that have been converted to formal parts as well as TMP parts that are not ready to be converted. You will need
to import the TMP part associations to ensure existing designs that use TMP parts will continue to get updated with
the CIS Part Manager. The TMPPRTS Import feature enables you to migrate TMP parts to the new CIP database. 

Select Admin > Bulk Operations > TMPPRTS Import to access the TMP parts import functionality.

Admin > Bulk Operations > TMPPRTS Import

A warning shows immediately. The TMPPRTS Import functionality will only import the association data. Parts that
have TMP part numbers will need to be first imported using the Import Instructions.



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 47

September 2025

 

Export the TMPPRTNO association from your existing TMPPRTS Table to a CSV format before starting. An example
is shown in the following figure.

The following steps describe how to import the TMPPRTNO association:

1. Select Choose File button and select the file you exported from your CIS database.

2. Change the delimiter, if not using a comma and select the Upload button. 

3. Select the Next button and verify that mapping is correct as shown in the figure below.
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4. Select the Next button again to complete the mapping.

5. Select the Import button to import the association. A Success pop up shows when done. 

6. Click on the Temp. Parts tab to review the TMP parts.
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3.2.6  Import Starter Library

The Starter Library includes over 5,000 manufacturer parts, datasheets, PCB footprints, and
schematic symbols. The part numbers with parametric data are installed as a CSV file with the
CIP client installation. The datasheets, PCB footprints, and schematic symbols are installed with
the web application. You have access to Starter Library symbol and footprint libraries after your company IT
configures Starter Library file sharing. 

The Starter Library is imported into CIP as an Admin > Bulk Operation as described in the steps that follow. After you
complete the import, you need to update the default path to datasheet parts. 

To import the CIP Starter Library 

1. Select the Admin > Bulk Operations > Import menu.

Menu selection to import Starter Library

2. Click the Configuration button. 

Configuration button of Import w indow       

3. Select Choose File and browse to select the Starter Library file: Starter_Lib.csv. The
Starter_Lib.csv is installed with the CIP client installation.

The default path for each of version of the CIP Client plugin is: 
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C:
\Cadence\SPB_<25.1/24.1/23.1>\tools\capture\tclscripts\capAutoLoad\CIPClient\CIP\Sta
rterLibraryParts\Starter_Lib.csv

If you have the System Capture Plugin installed, the starter library file is in

%CDS_SITE%\syscap\Libraries\Starter_Lib.csv

4.  Click the Upload button. When the file successfully uploads the word "Success" displays. 

Upload Starter Library CSV File

5. Click the Next button to continue. 

6. Configure field mappings in the Key Field Configuration screen.  The figure that follows
provides an example of recommended field mappings. 

Map Key Field Configuration     
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7. Click Next and Automap to map the Component Field Mappings for each Component View
(e.g. Capacitors, Connectors, etc.). Also map the Manufacturer and Distributor fields as well. 

Capacitors Field Mappings

8. Click the Save button that is located in the last Import screen to redisplay the main Import
screen.  

9. Click the Add Only button to start processing on your selected file in Simulate mode.

Click Add Only

As Starter Library parts are processed, the green status bar indicates the percent complete. When the status
bar reaches 100% the Stater Library is fully processed.

Note: The Simulate check box allows you to verify actions before they are performed on the database.
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 100% Indicates Processing is Complete

10.Select the Logs tab to review the log for the simulated processing of the Starter Library. 

11. Deselect the Simulate check box and select the Add Only button to start importing the
Starter Library data into CIP.

Deselect Simulate Check box and Click Add Only

12. When the status bar reaches 100%, the Starter Library is fully imported into CIP. 

The datasheet paths in the Starter Library are configured with a generic path. After you successfully import the
CIP Starter Library you need to update datasheet paths as described in the next section topic.

3.2.7  Update Datasheet Paths

The path of the technical datasheet links may be configured for access from the CIP web interface or Capture CIS
Explorer. The datasheet paths in CIP will need to be updated according to the method configured by your IT
administrator.

Your IT administrator may define datasheet paths using any of the following methods: 
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§ URL to datasheets (e.g. http://server/datasheetpath/datasheet.pdf) - Your IT administrator
creates a virtual directory in IIS that is linked to your datasheet directory. If you choose to
install the Starter Library, the virtual directory will link to the Starter Library datasheet directory
on the web server. Your IT administrator needs to share this directory to allow users to add
new datasheets. The virtual directory may be added as a path within CIP-E or as separate
URL. Instructions that explain how to create a virtual directory are provided by Microsoft: 
https://docs.microsoft.com/en-us/dotnet/framework/wcf/samples/virtual-directory-setup-
instructions. 

§ UNC path to datasheets (e.g. \\server\datasheetdirectory\datasheet.pdf) - Datasheets can
only be accessed by users using the CIS Explorer. Users opening CIP will need to copy and
paste the path into the address bar of a File Manager window. This method may be slower the
first time a datasheet is accessed.  

§ Mapped drive to datasheets - Datasheets can only be accessed by users using the CIS
Explorer. Users opening CIP will need to copy the path and paste it into a Windows file
manager navigation address bar. If this configuration is set up, all users requiring access
must have the same mapped drive letter. 

Before updating the datasheet paths, determine which of the above options is configured. You need to update the
Datasheet field to part datasheets whenever the location of the datasheets changes. 

Updating the datasheet paths in CIP is a 3-step process:

1. Create a CSV export file that includes the CIP datasheet field.

2. Modify the datasheet field to the new datasheet path in the exported CSV file.

3. Import the modified CSV file to update CIP.

Step 1 - Create CSV export file

1. Open the CIS DB Search window and specify search options. 

https://docs.microsoft.com/en-us/dotnet/framework/wcf/samples/virtual-directory-setup-instructions
https://docs.microsoft.com/en-us/dotnet/framework/wcf/samples/virtual-directory-setup-instructions
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a) Select PART_NUMBER as the Parametric Field.

b) Select Contains Data as the Operator.

c) Check the Include Additional fields in Search Results check box and select
Manufacturer, Manufacturer PN, and DataSheet. 

d) Click Search.

2. Click the Export button. (Do not check the For Excel checkbox). 

Note: Export functionality is not available when using the System Capture plugin.

Step 2 - Modify the datasheet field

1. Open the exported file using Excel.

2. Conduct a search in Excel for the path you want to replace. The generic path to the Starter
Library that needs to be replaced is "DatasheetPath/". 

The next screen image that follows, for example, shows a search entry for DatasheetPath/.   

3. Enter replacement text that matches the path your IT administrator configured, (URL, UNC, or
network drive). 

The example in the figure below shows replacement text for a URL. 



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 55

September 2025

Entry of Search and Replace Text

4. Click the Replace All button.

5. Save the .CSV file and close Excel.

6. Return to CIP. 

Step 3 - Import the modified CSV file

1.  Select the Admin > Bulk Operations > Import menu to open the main Import window.

2.  Click Configuration and browse to select the updated CSV file you saved in step 2. Then
Upload the selected file. 
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3.  Map the Component View to Category. Page through the component configuration pages
and save the configuration mappings.

4. From the Manufacturing Field Mappings page map the Datasheets field as shown in the
screen capture below.

5.  Save the configuration mappings.

6. You may proceed by either simulating the import and review the log of potential changes first
or making real changes to the database without simulate.
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a. If you'd like to simulate the import before making any real changes to your CIP database,
check the Simulate check box before clicking Add and Update. 

b. To make real changes to your CIP database, deselect the Simulate check box and click
Add and Update.

The green status bar informs you of the update progress which may take a few minutes. 

7. View the Manufacturer Data from the Part Details page of a component and confirm the path
to the part datasheet successfully displays the part datasheet when selected. 

3.3  Configuration

Admin > Configuration

The Configuration menu under the Admin menu item allows you to do the following: 
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Admin > Configuration

o Create Component Views utilizing subsets of data from default tables.

o Customize Fields to add/remove/rename fields, display pick lists, default field values, include
fields for history tracking, and control required fields for TMP and Formal parts. Configure
fields to be transferred to design when placing parts from CIP and enable System Capture
Configuration.

o Reorder View Fields - to change order and grouping of fields in each component view.

o BOM/Design Options - to configure BOM Format and Design Parts Sync

o Set up Email Notifications to inform a team or work group when changes to the CIP database
occur.

o Incrementally auto-number new parts by configuring a auto-increment part numbering
scheme.

o Color code Manufacturer Part Status field by matching a part status with a color coded
configuration .

o System Capture Configuration to configure substitution rules and create PTF file. Note: This
option is hidden when configure fields to be transferred to design is not set to a System
Capture option.

Other items you can configure:

o New Part Default – Configure the New Part Form to default as a Temporary or Formal part.

o Import/Export Separator – Configures the separator to be used for CSV file import and
export.

o Schematic Part/PCB Footprint Delimiter – Configures the delimiter for symbols when
multiple symbols are specified for a part.

o CIP Base URL – Configure the URL for CIP to enable CIS users to open CIP parts from
the CIS Explorer Window within Cadence OrCAD Capture.

o Component Company Action Link – Enable a global link enabled on all components pages.

o Reuse Module Directory – Configure the location where reuse module .DSN files are
stored.

o Show CIP Client Download Link – This allows users in a company to download the CIP
client directly from the CIP page.

o Temp Part Prefix – Configure the part number prefix used for temporary parts.

o Full Text Search Enabled - This enables/disables full text search functionality.
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o Enable Download of Ultra Librarian Models - Enable Ultra Librarian model download and
configure common download location.

o Enable Virtual Librarian Service - Enable Virtual Librarian Service (VLS) menu item and
Manufacturer PN request button for viewing and submitting VLS requests.

3.3.1  Component Views

Component Views can be created to show more specific categories and fields for parts than the default views. All
tables that can be used to derived new views are shown in the Table Name column under Admin > Configuration >
Component Views, but tables are only shown in this section. Component Views are seen by the CIP users and CIS
users. Views can be renamed or removed. Any changes to a component view will likely require an update to the CIS
.DBC file used by Capture CIS. Review the Appendix for instructions to create or update the CIP/CIS .DBC file.

Default CIP Tables and Component Views

To create a new Component View

1. Click the Edit  button next to the table name from which to create the new view.

 



Product Version 25.1.22 for 25.1, 24.1, 23.1September 2025

CIP User Guide60

2. Enter a name for the view in the Add View field and click the  button to create the
Component View.  The example below shows the view name, LEDs, is entered into the Add
View field of the CIP_Diodes table.

Creating Component View

3. Click the Save  button when you have finished adding your views to the selected table. 

Once you've created a new component view, you can optionally begin to add, import, or move parts into it.

To rename a Component View 

1. Click the Edit  button next to the table name with the view that you want to remove. 

2. Click the Rename  button next to the view you want to rename. 
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3. Click the Save  button to complete the rename.

To remove Component Views - Remove a single view

1. Click the Edit  button next to the table name with the view that you want to remove. 

 

2. Click the Delete  button next to the view you want to remove. You will need to select a
new view to move all parts into before deleting the view, as shown in the following figure, then
click OK.

3. You may still cancel and restore the view by clicking the Restore View  button.

4. Click the Save  button to complete the deletion and part reassignment.

To remove Component Views - Disable a table

If you have a table you do not want to use in CIP, you can disable it. Any views and parts derived
from the disabled table will be disabled and hidden, but not be deleted.
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1. Click the Edit  button next to the table name that you want to disable.

2. Deselect the Enable checkbox and click the Save  button. Any parts in the table remain
but the table is disabled.

3.3.2  Customizable Fields

Privileged users may configure up to 75 customizable fields (UserFieldXX) and 5 numerical fields (NUserFieldXX)
per component view, 5 customizable component manufacturer fields, and 30 customizable manufacturer part fields.
Unused customizable fields will not display on Part Information pages. 

In addition to customizing fields, fields to be transferred for design are configured in this tab of the Admin >
Configuration menu item. 

Note: You need to enable a field in this section to make it visible to a CIP user. Enabling, disabling, or renaming a
display field in component views, component manufacturer parts, or manufacturer parts will require a new or
updated CIS .DBC file for use with Capture CIS. Review the Appendix for instructions to create or update the CIP/CIS
.DBC file.

The following Views can be customized:

§ Customize Component Fields – Each of the enabled Component Views are listed. Selecting
a specific view shows parametric data fields available for each company part number. Fields
may be saved per view or across all views. Fields include many parametric fields and user
fields (UserFieldXX). 

§ Component to Manufacturer Parts – The Component Manufacturer Parts allows unique
relationships between the company part number and associated manufacturer part. For
example, you may want to identify a manufacturer part as a preferred part for one company
part number and an alternate source for a different company part number.

§ Manufacturer Part Info – The Manufacturer Part Info identifies all fields for manufacturer
parts. Configurable fields include Manufacturer PN Status, Datasheet, and various
compliance fields. User fields (M_UserFieldXX) are also available.

§ Distributor Part Info – The Distributor Part Info identifies fields for distributor parts.
Configurable fields include Distributor, Distributor PN, Quantity, Cost, Unit Price, and Data
Last Updated. User fields (D_UserFieldXX) are also available.

§ BOMs – The BOMs section identifies fields for BOM part numbers. Configurable fields
include Description, Revision, Build/Buy, Variant, Cost, Part Type, and Company Part Status.
User fields (B_UserFieldXX) are also available. 

§ BOMItems – BOM Items section identifies fields used for items that are associated to BOM
part numbers. Configurable fields include RefDes, Unit, Cost, Build/Buy, Reuse Module,
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Reuse Module Revision, and Reuse Module RefDes. User fields (BI_UserFieldXX) are also
available. Note: You may disable the reuse module fields for BOM Items if disabling the reuse
module view.

§ Reuse Modules – The Reuse Modules section identifies fields for Reuse Modules part
numbers. Configurable fields include Description, Revision, Variant, Schematic Part, Part
Type, Design File, and REUSE_MODULE. User fields (UserFieldXX) are also available.

Navigate to the Admin > Configuration > Customizable Fields tab. From there, select an item from the Views drop-
down list that provides access to the configured component views (Capacitors, Connectors, etc.), component
manufacturer parts, manufacturer part, distributor part, BOMs, and BOMItems.

Select Table For Customizable Fields 

In addition to selecting a View, you can optionally select the Field Filter Options to more easily
review and update the list of configured fields. The Field Filter drop-down list allows you to filter
on All Fields, User Fields, Non-User Fields, and Aliased Fields. The Enabled Fields Only check
box allows you to show enabled and disabled fields or hide disabled fields.

All Fields for Capacitors
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· Field Filter drop-down list

o All Fields – displays all fields for the selected View. This is the default.

§ User Fields – displays User Fields (UserFieldXX), whether aliased or not.

§ Non-User Fields – displays Non-User Fields (e.g. Description, Value, etc.).

§ Aliased Fields – displays all Aliased Fields, both User Fields and Non-User Fields.

· Enabled Fields Only check box – Select this option to show only Enabled fields. Deselect it
to show Enabled and Disabled fields.

Below are examples showing some combinations of the Field Filter Options.

All User Fields for Capacitors     

Enabled User Fields for Capacitors
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All Aliased Fields for Capacitors     

Enabled Aliased Fields for Capacitors

Once a desired View and Field Field Options are selected, you may begin to enable custom User Fields or change
the Display Name of pre-configured fields. Most view fields are configured the same way, though some core fields
such as PART_NUMBER have specific options that cannot be changed.

You can configure the following characteristics of a customized field: 

· Enabled – Checking or unchecking the checkbox changes whether you can select the field in
Component Views. There are 50 user fields that may be added to the components or
manufacturer table. There are 5 numerical user fields that may also be added to the
components tables. Only numbers may be entered to the numerical user fields. When you
use CIS Explorer, the numerical user fields sort numerically.

· Display Name – Changing the display name will change the appearance of the field name
inside CIP.

· Display Type – The display type changes the appearance of the data associated with the
field. The options allowed are Text or Link. This controls whether the data is to be shown as
hyperlink or plain text.

· Edit Type – The edit type controls whether the user is to manually enter the data or choose
data from a pick list.  

· Pick List Values – The values that are available for a user to choose from must be
configured. Users will only be able to select options in the pick list values when they create
parts.

· Default – The default value is the initial value of the data when a new part is created. Default
values can be specified for Edit Types of Text or Pick List.  Numeric user defined fields can
be assigned a default numeric value. 
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· Track History – The default for each field is enabled for tracking of history. However, for a
configured field that may be updated often, e.g. quantity, you may want to exclude from
history. 

· TMP Required Field – The TMP Required Field controls whether the field is mandatory when
creating or modifying a TMP part. This control is only available for the component fields. The
Part Number and Implementation Type fields are always mandatory and may not be changed,
though you can disable the Implementation Type field if it will not be used.

· Formal Required Field – The Formal Required Field controls whether the field is mandatory
when creating or modifying a Formal (i.e. non-TMP) part. This control is only available for the
component and BOMs fields. The Part Number and Implementation Type fields are always
mandatory and may not be changed, though you can disable the Implementation Type field if it
will not be used.

Note: TMP and Formal required fields are only enforced using the new, edit, and copy part
forms. They are not enforced when using Compliance Search, Distributor Search, Import,
or external integrations.

3.3.2.1  Customize Component Fields

Each field of a component view may be changed individually or across all views that share the same Field ID. To

customize a field, select the Edit button  and modify the desired fields. After making updates, click the Save

button  to save your changes or the Cancel button  to discard them. To save the field across all part views,

click the Save All button . When using the save all option, a pop-up window will appear to confirm the change.

The following figure is a sample view named Capacitors, derived from the CIP_Capacitors table, that shows fields
that can be modified.

Sample Capacitors Customizable Field Options
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Save Field Across All Component/Part Views

Select or deselect the Enabled checkbox to add or remove a field from a view. You may alter the Display Name
column to change the way the field name appears in CIP. After choosing the Display Name, select the Display Type,
which can be Text (standard) or Link (recognized as active hyperlinks). You may define a field's Edit Type as user
editable Text or Pick List. If you select Pick List, you need to enter the Pick List values. To add values to your pick list,

type in the text box, then hit Enter key or click the Add button . Click and drag a pick list value to change the
sequence of the pick list. To remove a value from the list, hover over the item on the list and click the Remove button,

. If you want the pick list to have an initial default value when new parts are created, you can select from the list
after you have added all your pick list values. 

Sample Pick List Configuration

If you want to exclude field modifications from the Part History, you can disable Track History by de-selecting the
check mark. This removes the field from the Part History. Repeat this process for each field you want to customize.
Fields that change frequently should has history tracking disabled to keep history to a manageable size.

If you want to make a field mandatory when a TMP part is created or modified, you can enable the TMP Required
Field by selecting the checkbox. Users will not be able to create or change a TMP part without populating the field.

If you want to make a field mandatory when a formal part is created, modified or converted from a TMP part, you can
enable the Formal Required Field by selecting the checkbox. Users will not be able to create or change a formal part
without populating the field.

Note: TMP and Formal required fields are only enforced using the new, edit, and copy part
forms. They are not enforced when using Compliance Search, Distributor Search, Import,
or external integrations.
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The following figure shows a sample configuration for the Capacitors view. UserField01 and UserField02 are
highlighted in green to provide an example of user-defined fields. 

Capacitors View Customization Sample

After you configure the Customizable Fields, navigate to the appropriate Component View.  From there, you may View
or Edit any field included in that View. The custom fields will also appear in the CIS DB Search, under the
Parametric Field drop-down list.
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Custom Fields Shown in a Capacitor Part Data

Custom Fields In CIS DB Search

Note: When you modify or enable the display name of a field and update the field in the Component View, CIS users
who use CIS Explorer or Part Manager are affected. The CIS .DBC file will also need to be updated as explained in
the Appendix.
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3.3.2.2  Customize Component Manufacturer Part Fields

Configuring component manufacture part information is completed the same way the fields for manufacturer parts
are configured and customized. History tracking may be disabled to reduce the size of database growth. Required
field settings are not available for Component Manufacturer Part fields.

The Component Manufacturer Parts fields can be used for various purposes. The bullet list below provides some
examples. 

§ The "In PLM" field can be used to indicate whether a manufacturer part is associated with the
specific company part in your PLM or ERP system.  

§ If you have manufacturer parts that need to be associated with multiple company part
numbers and you need to set different property values (e.g. Preferred Status) for each, you
may configure a field for this purpose.

The following figure shows the default settings for the Component Manufacturer Parts fields.

Customize Fields for Component Manufacturer Parts

To customize a field, click the Edit button . After making your updates, select the Save button  to save your

changes or the Cancel button  to discard them. 

3.3.2.3  Customize Manufacturer Part Fields

Manufacturer Part Info fields can be modified individually. To customize a field, click the Edit button  next to the

desired Field ID.  After you complete your updates, select the Save button  to save your changes or the Cancel

button  to discard them. History tracking may be disabled to reduce the size of database growth. Required field
settings are not available for Manufacturer Part fields.
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Customize Fields for Manufacturer Parts - Editing a Field

To show the list of manufacturer fields that are specific to Silicon Expert in the Compliance Module, select the
SiliconExpert Fields filter.

Note: Enabling, disabling, or renaming a display field from Manufacturer Part Info or Distributor Part Info will also
affect the way the manufacturer/relational view appears for Capture CIS users. This will require a new CIS .DBC file
to display correctly. Review the Appendix for instructions to create a new CIP/CIS .DBC file. Consult your OrCAD
Capture CIS User Guide for additional information regarding the CIS .DBC file.

3.3.2.4  Customize Distributor Part Fields

User configuration of distributor part information is similar to the configuration and customization of manufacturer
part fields. History tracking and required fields settings are not available for Distributor Part fields.

Distributor part fields are automatically populated when temp parts are added from either the distributor search or
distributor sync.

You can modify a field display name without changing the purpose of the field. For example, you can change the
name of the "Cost" field to "Quantity" and vice versa, while the type of data that automatically populates the fields
remains the same.
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Customize Fields for Distributor Parts

To customize a field, click the Edit button . After making your updates, select the Save button  to save your

changes or the Cancel button  to discard them. 

3.3.2.5  Customize BOMs Fields

The BOMs table identifies fields for BOM part numbers. There are 30 customizable fields you may use for BOM parts.
BOM fields are configured the same way component part fields are configured. You may configure fields to be
mandatory when creating and editing BOMs. 

Default fields for BOMs include Description, Revision, Build/Buy, Variant, Cost, and Company Part Status. Although
the Revision and Variant field names may be modified, the purpose of these fields remains unchanged. When you
conduct a search for BOMs, the search results include the BOM part number, revision, and variant name.

Note: The Last Modified and Last Modified By fields are not shown in the Customizable Fields configuration, but are
always shown when viewing BOMs and are updated each time a BOM is saved.
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Customize Fields for BOMs

To customize a field, click the Edit button . After making your updates, select the Save button  to save your

changes or the Cancel button  to discard them. 

3.3.2.6  Customize BOM Item Fields

BOM Items identify fields associated to BOM part numbers. BOM Item fields are configured and updated the same
way the fields for manufacturer parts are configured and updated. History tracking and required fields settings are
unavailable for BOM Item fields.

Default fields include RefDes, Unit, Build/Buy, Cost, Reuse Module, Reuse Module Revision, and Reuse Module
RefDes. Although the RefDes field names can be modified, the field must be used for reference designators of your
parts list. The following figure shows the default settings for the BOMItems table.

Note: The Last Modified and Last Modified By fields are not shown in the Customizable Fields configuration, but are
always shown when viewing BOM Items and are updated each time BOM Items are saved.
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Customize Fields for BOM Items

To customize a field, click the Edit button . After making your updates, select the Save button  to save your

changes or the Cancel button  to discard them. 

3.3.2.7  Customize Reuse Modules Fields

The Reuse Modules view identifies fields for Reuse Modules part numbers. There are 75 customizable fields
available for Reuse Modules parts. Reuse Modules fields are configured the same way component part fields are
configured. You may configure fields to be mandatory when creating and editing Reuse Modules. 

Default fields for Reuse Modules include Revision, Description, Value, Schematic Part, Part Type, Design
File, and REUSE_MODULE.

Customize Fields for Reuse Modules
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To customize a field, click the Edit button . After making your updates, select the Save button  to save your

changes or the Cancel button  to discard them.

3.3.2.8  Configure Transfer Fields to Design

There are four settings available for Transfer Fields to Design Using.

· OrCAD CIS DBC - This is the default out of the box configuration. When placing parts from
CIP, the CIP OrCAD client plug-in will use the DBC file configured is CIS Configuration to
determine the fields that will be transferred to the design. With this setting, your Capture.ini
file must contain the Configuration File path and name. The CIP Client Installation Guide includes
information to help you set up your Capture.ini file. With this configuration, the Schematic Part (OrCAD
Symbol name) field is enabled for use with Capture CIS. The System Capture Part field is disabled as well
as the System Capture Tab.

· OrCAD Using CIP - When placing parts from CIP, the CIP OrCAD client plug-in will transfer fields configured in
the Customizable Fields tab. The DBC file will not be used by the OrCAD Client plug-in. With this
configuration, the Schematic Part (OrCAD Symbol name) field is enabled for use with Capture CIS. Transfer
to Design and Property Visibility columns are enabled for configuration.  The System Capture Part field is
disabled as well as the System Capture Tab.

· System Capture - When placing parts from CIP, the CIP System Capture client plug-in will transfer fields
configured in the Customizable Fields tab. With this configuration, the System Capture Part field is enabled
for use with System Capture. The System Capture tab is enabled.Transfer to Design, Property Visibility and
System Capture Key Property columns are enabled for configuration. The Schematic Part (OrCAD Symbol
name) field is disabled. Configured fields will be added to the PTF file during generation.

· CIP and System Capture - When placing parts from CIP, both CIP System Capture and OrCAD client plug-ins
will transfer fields configured in the Customizable Fields tab. With this configuration, the System Capture Part
Field is enabled for use with System Capture. The System Capture tab is enabled. Transfer to Design,
Property Visibility and System Capture Key Property columns are enabled for configuration. Configured
fields will be added to the PTF file during generation. Both Schematic Part and System Capture Part fields
are enabled. 

To change the Transfer Fields to Design Using settings, click on the Edit  button. When the System Capture or
the CIP and System Capture options are selected, the System Capture tab will appear. 
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Click the Save  button to start configuring Transfer to Design, Property Visibility and System Capture Key
Property settings.

To customize a field, select the Edit button  and modify the desired fields. 

If you want to transfer the value of a field to the symbol when placing a part, you can enable the Transfer to Design by
selecting the checkbox. 

If you want the value of a field to be visible after being placed onto a design, you can enable the Property Visibility by
selecting the checkbox. 

For System Capture Parts, if you want make a field a key property, you can enable the System Capture Key Property 
by selecting the checkbox. CIP will generate the PTF file with fields with this designation as key properties. 

3.3.3  Reorder View Fields

The appearance of fields in the Component Views within the CIP Web interface may be arranged using Admin >
Configuration > Reorder View Fields. Each of the views are configurable separately. The fields in the Component
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Manufacturer Part Info and Manufacturer Part Info can also be reordered. Groups can be created and named for for
each individual component view. When multiple groups exist, you can drag and drop the fields to arrange the
position of the fields. You can also drag and drop the groups to change their order. Click anywhere on the non-text
portion of the header to collapse/expand a group's field list.

Default Field Order for Capacitors View

To Create a Field Group:

1. Enter a new group name next to Add Group and click on the Add button.
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Add Group Example

2. Continue to add groups as desired. Group names may be changed by clicking on the
name and updating it, as shown in the following sample figure.

Change Group Name Example

3. To adjust the group order, click the Move  icon, then drag and drop to the desire
location as shown in the following example.
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Move Group Example

To Change field order:

1. To adjust the field order, click the Move  icon, then drag and drop to the desire location
as shown in the following sample figure.
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Move Field Example

2. Click the Update View Field Order button to save all changes.
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Sample of New Order for Capacitors

Select a component in the newly configured component view to see the updated order. The following figure shows
the example of the updated Capacitors View.
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Capacitors View With New Field Order

3.3.4  BOM/Design Options

The BOM/Design Options configuration tab allows you to:

· Set BOM Format for Do Not Stuff and Same as Core parts between core design and
variants.

o Enter a text label to indicate a BOM part is not present on the core design or a variant -
Default: Do Not Stuff

o Enter a text label to indicate a BOM Variant part is the same as the core design -
Default: Same As Core

· Configure Design Parts Sync Part Replacement Filter Rules to determine whether
replacement part fields are required to match the original part. Each of the field filters
below can be set to Optional (Warn) or Required. This will control the field filters and
related warnings when using Design Parts Sync to Replace Parts on a design with
selected replacement part.

§ Component View

§ Value

§ Schematic Part (Source Part and Source Library)

§ PCB Footprint
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BOM/Design Options

Update the BOM Format labels for BOM Variants:

1.  Click on the Edit  button.

Edit BOM Format Labels

2. Enter the desired text or clear the field to use blank/empty as the label.

a. Do Not Stuff - This will apply when viewing a BOM Revision and selecting (1) the core
or single variant, or (2) All Variant. The label entered will be dynamically shown on a
BOM-Rev-Variant when at least one variant or core design has a RefDes that does not
exist on another variant or core design of the same BOM revision.

b. Same As Core - This will apply when viewing a BOM Revision and selecting the All
Variant option. 

3. Click the Save  button to apply the setting.

Change from Do Not Stuff to DNS   

Change from --- Same as Core --- to blank
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Update the Part Replacement Filter Rules for Design Parts Sync:

1. Click on the Edit  button.

Edit Part Replacement Filter Rules

2. Select the desired field drop-down list and choose Optional (Warn) or Required. This
will apply when invoking Part Replacement and filtering and selecting the replacement
part.

Updated Part Replacement Filter Rules

3. Click the Save  button to apply the setting.

3.3.5  Email Notifications

You can set up CIP Email Notifications so that users are notified when company or manufacturer parts are added,
modified, or deleted from the CIS database. This feature also allows users who create Temp Parts (either through
CIS or CIP) to receive emails when their Temp Parts are assigned formal part numbers.

Note:  The SQL Server Administrator must enable and configure Database Mail on the SQL server before email
notifications can be successfully enabled. This setup occurs outside of CIP.  See the figure  Email Configuration
Required to see the error message you may see when you attempt to set up email notifications before Database
Mail is set up on the CIP server.  

A CIP Admin can enable Email Notifications for individual CIP Users or for Email Aliases (which may or may not
contain CIP Users). To enable Email Notifications within CIP, select Admin > Configuration > Email Notifications.
Select the Email Notification checkbox to start configuring email notifications. 
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Email Notification

Once the email notifications are enabled (checked), options to enter notification aliases becomes available. Enter an
email alias where desired so that all users belonging to an alias are notified when a database Insert, Update, or
Delete occurs. 

Email Notification Aliases Enabled

Optionally, you can enable the Temp Part Assigned Notification if users who create Temp Parts want to be notified
when their Temp Parts are assigned Formal Part Numbers. After email notifications are configured as desired, click

the Save button .  When the settings are saved, the Save and Cancel buttons de-activate. The buttons become
enabled again when changes are made.
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Email Notifications Updated

The Temp Part Assigned Notification works smoothly when a Temp Part is created from CIS and the user’s
Windows Authenticated username matches the CIP username. CIS and CIP record the users who are logged in
when a Temp Part is created. 

Note: Email Notifications can be configured for individual CIP Users via the Admin > Users, Roles & Permissions
page.  Although email aliases are not required, an alias address can be set up to notify groups of people or people
that are not CIP Users. Email alerts can not be sent until the Email Notification option is enabled. 

The image below shows the email error message that displays when DatabaseMail is not yet set up on the SQL
server. 

Email Configuration Required

3.3.5.1  Email Notification for Individual Users

After Email Notifications are enabled, you can assign them to specific CIP Users. Navigate to the Admin > User,

Roles & Permissions Administration tab. Click Edit  for a particular CIP User, and then click the desired

checkboxes under the Notifications column. When a user is configured, click Update  to save the settings.
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Email Notification for Individual Users

3.3.6  Incremental Part Number

Each part entered into CIP requires a unique part number.  The part number can be assigned either manually or
automatically by CIP. Part numbers entered manually can have any format. Part numbers automatically assigned by
CIP are incrementally numbered with the next available sequential number. 

To configure CIP to auto-increment part numbers 

1. Select the Admin > Configuration menu, then click the Incremental Part Number tab.  

2. Select the Enable Incremental Part Number checkbox. 

Note: Options to configure auto-number only display for users assigned to roles that include Incremental PN
Format.  

Once enabled, CIP can automatically assign the next incremental part number when a formal part is created.
The part numbering scheme can be configured differently for each table. A set of default pre-fixes are pre-
populated during CIP installation. Once enabled, you may edit the scheme for each table. 

To edit the numbering scheme of a part table 

1. Select the Edit button   that precedes the table of the component numbering scheme you
want to edit. 
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Enable Part Number Auto-Numbering

2. Edit the prefix and number of characters in each part number as desired. 

The prefix may be in any format while the numbers for each part number can range from 0 to 15 digits. For
example, if the value 8 is entered, there will be 8 placeholder digits for the part number. 

The following figure provides an example where the prefix is CAP and the number 4 is the Digit Width for the
CIP_Capacitor table.

Edit Capacitors Auto Part Numbering Scheme 

To create a new formal part 

1. Open a Part Information page (Components > Component View). 

2. Click the Add button   to open a new part form.  
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Make Selection to Add a New Part

2. Click the Next PN button  to retrieve next available number. As shown in the sample
image below, the first part number for this new part format is CAP-0001. 

Obtain An Auto-Increment Part Number

3. Enter parametric data and click the Add   button. 

To convert a TMP part to the next available auto-increment part number, click Edit  button when viewing a TMP
part as shown below. While in Edit mode, click Next PN and Save to complete the conversion of the TMP part to a
formal auto-increment part number.
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Convert From TMP Part Number To Auto-Increment Number

3.3.7  Manufacturer Part Status Indicator

Privileged users can set up a field to be used as the manufacturer part status indicator. The Manufacturer Part
Status Indicator reports the status of a part by color code assignment associated to options available in the Part
Status field.  Four colors are available: red, green, blue, and yellow.

Note: The CIP Admin must grant the user permission to configure Customizable Fields before the user can make
changes to the Manufacturer Part Status Indicator. Users who lack this permission will be unable to set up this
feature. 

Manufacturer Parts With Color Coding Based on PN

To enable the Manufacturer Part Status Indicator 

1. Select the Admin > Configuration menu, then click the Manufacturer Part Status
Indicator tab.

2. Click the Edit button  and check the Enable checkbox to begin defining the status
indicators. 
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Configuring Manufacturer Part Status Indicator

4. Click the Status Field drop-down list and select the field for which you want to set up a
status indicator.   

5. Type a string (New Value) into each color field to indicates the status value you want to
associate to each color.  

Note: You can assign more than one status string to each color. 

6. To save the strings you added, either press your keyboard Enter key or click the Add button

. When done, click the Save button . 

Defining Color Code of Status Indicators

If you want to discard all changes, click the Cancel button.   If you wish to remove a string from the list, hover over

the string and select the red X button, .

Discarding Editing Changes to Status Indicators
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3.3.8  System Capture Configuration

The System Capture configuration tab allows you to:

· Configure the location in which to create your PTF file.

· Define field and value name substitution rules to apply during PTF file creation.

· Generate the PTF file of formal parts with a report logging substitutions applied and
number of parts for each System Capture Part.

You will need to have permissions to configure these settings or create a PTF file. To enable CIP to provide full
functionality with CIP System Capture client plug-in, you must enable the Transfer Fields to Design settings to either
System Capture or CIP and System Capture as shown in the following figure. 

Characters allowed for field names in System Capture include only the following character set: 0-9, a-z, and _.
Additionally, length of field names cannot exceed 30 characters. For example, field names such as Rated Voltage or
Rated Power will not be allowed in System Capture. To avoid manually changing all your field names and potentially
affecting OrCAD Capture designs, you can define substitution rule using the System Capture tab in Admin >
Configuration. 

Configure Location of PTF file:

The PTF file is not required by CIP to place parts onto a schematic page. The PTF file is used by System Capture to
display parts in Unified Search as well as other System Capture functions. 

1. Make sure you open CIP while inside System Capture if you plan on generating the PTF file.
The location, subtitution rules, and PTF report functions can be used inside or outside of
System Capture.

2. Select Admin > Configuration > System Capture.

3. Select the Edit  button to enter/edit the PTF File location.

4. Enter the path of the PTF file. The PTF file should be placed in the same location as your
library. CIP will add this path to the site.cpm file during PTF generation.  A path name that
includes CDS_SITE will ensure consistent access by all users. Prepend a "$" to specify a
directory relative to a predefined environment variable. If using the System Capture starter
library as your guide, enter $CDS_SITE/Libraries/SysCapModel. 
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Note: If the CDS_SITE environment variable was not set up during installation of the CIP System
Capture Client plugin, you will need to set it up manually and restart System Capture.

5. Click the Save  button.

Define Substitution Rules for PTF Generation:

The format of the PTF file must conform to specifications for DE-HDL. Additional information may be found in
Cadence documentation Working with Part Table Files (PTF) in Design Entry HDL. 

PTF files for System Capture and indexer have restriction on fields and values. Supported characters for field names

consists of a-z, 0-9, and _. Field name lengths are limited to 31. Truncation of fields to meet the length
requirement may lead to duplicate field names. To ensure a validate PTF is generated, by default,
a sequential number will be added. You have the option to change this to a letter. Options available
for field name substitution of unsupported characters are removal or replacement with an
underscore. Options available for value substitution of unsupported characters are provided in the
UI. Alternately, you may modify the display name of the field. 

1. Select Admin > Configuration > System Capture

2. Click the Edit  button to change Data Validation and Substitution Rules for PTF
Generation. This option ensures that truncation of fields do not to duplicate field names. 

3. Use the pull down list to change the rules you want to apply. Click the Save  button when
complete. 
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Generate PTF file:

The PTF generation process performed by CIP performs the following:

· Generate PTF Report with defined (substitution) rules  and the number of parts, before the PTF file is
actually created.

· Generate PTF File (global.ptf) using the same Defined (Substitution) Rules as the report. A backup of the
prior global.ptf is save each time the Generate button is clicked. 

· Indexing of the System Capture Library and PTF file to show models and parts in the System Capture
Unified Search.

Steps for PTF file generation are:

1. Review the substitution rules to ensure they contains the rules you want to apply during PTF
generation.

2. Click the Report button to see a report of the parts before generating the PTF file.  If running
Report while in System Capture, it may take more time for System Capture to display the
entirety of results. You may run the report in a standard browser (such as Chrome or Edge)
for faster response time. 

3. Review the PTF Report on the right side of the page, which was created using your defined
substitution rules. Look for reported PTF Errors and fix any issues before proceeding to
Generate. You may save a copy of the Report when using a standard browser.
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4. Click the Generate button, which is enabled inside System Capture in order to run the
indexing process. This will Generate the PTF Report and PTF File, and perform indexing of the

System Capture Library and PTF file. These processes run in parallel and performance will depend
on the configuration, hardware, and security rules set on your web, database, and file
servers. The activity busy screen shows during Report generation. This process can take
several minutes for a large library or number of parts. Once the PTF file is created, a
command window opens to index the contents of your library and PTF file. DO NOT close
this window until you see the message to "Press any key to continue..." that indicates
completion. Review the command window screen for any errors before pressing any key to
continue, since the window will dismiss immediately after you press any key. The index
process enables System Capture to display parts and library models in Unified Search.

5. A completion pop-up window appears when the PTF report and PTF file have been created.
The indexing of the PTF file occurs in parallel. You may click OK to dismiss the Generate
PTF window and continue using CIP. Press any key in the command window screen to
dismiss the indexing window. Both of these processes need to finish before you can use the
parts in System Capture's Unified Search.
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3.3.8.1  PTF Generation Report Format

CIP creates a report consisting of number of parts per System Capture Part along with the substitution rules applied.
When running Report from a standard browser, you can save the report to review using notepad or another text
editor.

There are three sections in the Report.

1. Header 

a. PTF Log - Consists of the date and time that this report is run.

b. Output: Contains the location of the PTF file when the Generate is used.

2. Part Information - This section is repeated for each System Capture Part Name

a. Part Name - This is the symbol name in the System Capture Part field. All parts with
the same part name are grouped together per PTF format specification for DE-HDL.

b. # of Parts - Shows the number of parts found using this part name. TMP parts are
excluded.
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c. Warnings -  Identifies any substitution rules applied for the Part Name.

3. Summary

a. Total Number of Parts - This is the number of parts that will be in the PTF file. TMP
parts are excluded from the PTF file.

b. Number of Fields Changed - Total number of fields where substitution rules were
applied.
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Finding and Fixing Errors in Report

An error message displays when errors are found during report generation.

You will need to locate the source of the problem and fix before PTF Generation. 

1. Click OK to dismiss error message.

2. Type Control F to locate "error" in the report. 

3. Review the Part Names showing error.

Sample Error in Report

4. In this example, the Part Name, "BJT_NPN_BEC" is found in both ICs and Transistors views.
However, there is a conflict (highlighted in pink) with fields defined for transfer to design
between each of these views. To fix this problem, you can change the fields for transfer to
design to match or change the Part Name for one of these parts.

3.3.8.2  Indexer Command Window

The Indexer generates an index for parts in the PTF as well as symbols in the library. Parts added to CIP or the PTF
file manually will not be visible in Unified Search in with being indexed first. 

The command window that runs the Indexer will look like the following example when run the first time to create the
index. 
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Subsequent runs will look as follows to update the index.

Errors can occur when PTF files are manually created or edited. Another possible error can occur
if you have multiple PTF files that have the same Part Name with different fields for Transfer to
Design. To fix errors in the command window, review the errors identified. Then review the PTF
files for part name with the errors and make the correction as identified in the errors. As a
generally rule, make sure that you have only one source generating the PTF file.
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3.3.9  Other Configuration

There are several options that do not have their own configuration tab. These options are grouped
under the Other tab.

Admin > Configuration > Other

o New Part Default – Configure the New Part Form to default as a Temporary or Formal part.

o Import/Export Separator – Configures the separator to be used for CSV file import and export.

o Schematic Part/PCB Footprint Delimiter – Configures the delimiter for symbols when multiple
symbols are specified for a part.

o CIP Base URL – Configure the URL for CIP to enable CIS users to open CIP parts from the
CIS Explorer Window within Cadence OrCAD Capture.

o Component Company Action Link – Enable a global link enabled on all components pages.

o Reuse Module Directory – Configure the location where reuse module .DSN files are stored.

o Show CIP Client Download Link – This allows users in a company to download the CIP client
directly from the CIP page.

o Temp Part Prefix – Configure the part number prefix used for temporary parts.

o Full Text Search Enabled - This enables/disables full text search functionality.

o Enable Download of Ultra Librarian Models - Enable Ultra Librarian model download and
configure common download location.
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o Enable Virtual Librarian Service - Enable Virtual Librarian Service (VLS) menu item and
Manufacturer PN request button for viewing and submitting VLS requests.

3.3.9.1  New Part Default

The New Part Default setting controls whether the New Part Form will default to a Temporary or
Formal part. It can still be changed on-the-fly as desired.

Note: Users who are granted permission to configure customizable fields are also granted permission to change
the New Part Default.

To change the New Part Default

1. Select the Admin > Configuration menu, then click the Other tab.

View the Current New Part Default

2. Select the Edit button  that is located next to the New Part Default option. 

3. Select the radio button next to Temporary or Formal and click the Save button , or click

Cancel   to discard changes. The next time the New Part Form is used, it will default to the
setting you saved.

Configuring New Part Default

3.3.9.2  Import/Export Separator

Privileged users can define the separators used for importing and exporting CSV files. CIP uses the comma (,)
symbol as its default delimiter/separator for handling BOMs and other data lists.  However, there are some
occasions when you may prefer to use a semicolon (;) symbol instead.  

Note: Users who are granted permission to configure customizable fields are also granted permission to change
the Import/Export Separators.

To change the default Import/Export Separator

1. Select the Admin > Configuration menu, then click the Other tab.
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Edit Import and Export Separator

2. Select the Edit button  that is located next to the Import/Export Separator option. 

3. Select the (;) semicolon from the drop list and click the Save button , or click Cancel   to
discard changes.

Configuring Import And Export Separator

3.3.9.3  Schematic Part/PCB Footprint Delimiter

The Schematic Part/PCB Footprint Delimiter is used by CIP and Capture CIS when a part has more than one
symbol in the Schematic Part or PCB Footprint fields. By default, a comma (,) is the delimiter used. 

Note: Users with permission to configure Other options in Admin > Configuration can change the Schematic
Part/PCB Footprint Delimiter.

To configure the Schematic Part/PCB Footprint Delimiter, select the Admin > Configuration menu, then
click the Other tab.

Editing the Schematic Part/PCB Footprint Delimiter
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Select the Edit button  for the Schematic Part/PCB Footprint Delimiter. Allowable delimiters are shown in the
following figure. If Capture CIS is configured to use a different limiter, you need to set CIP to use the same delimiter.

This enables CIP to treat each symbol separately.  After changing your selection, select the Save button  to

accept changes, or click Cancel   to discard changes..

Configuring Schematic Part/PCB Footprint Delimiter

3.3.9.4  CIP Base URL

The CIP base URL allows easy access to the CIP part directly when you view a part in CIS. 

Note: Users who are granted permission to configure customizable fields are also granted permission to change
the CIP Base URL.

To configure the Link for all parts, select the Admin > Configuration menu, then click the Other tab. Select the

Edit button  that is located next to the CIP Base URL option.

Editing the CIP Base URL

Type in the URL for CIP and click the Save button , or click Cancel   to discard changes.
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Entering the CIP URL

After you save the link, all parts in the database that correspond to this link update. Depending upon the number of
parts in your CIP database, the update process may take serveral minutes. The next time you open CIS, the CIP link
will be active.

CIP Link Updated 

3.3.9.5  Enable Link on Component Pages

A link may be shown on all components pages to enable easy access from CIP to another system, i.e. PLM. 

Note: Users who are granted permission to configure customizable fields are also granted permission to configure
Component Company Action Link.

To configure the Component Company Action Link

1. Select the Admin > Configuration menu, then click the Other tab. 

2. Select the Edit button  for Component Company Action Link. 
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Configure Component Company Action Link

3. Select the checkbox for Enabled. Enable the Name in which to show in the component page

for the link and enter the URL for the link and click the Save button , or click Cancel   to
discard changes.  

Enable and Save Component Company Action Link

After configuring this setting, the component pages contains the added link as shown in the example below.

Example of Component Page with Added Company Link
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3.3.9.6  Reuse Module Directory

Reuse Modules enable users to save designs and part information to the CIP database where it can easily be
retrieved for use in a subsequent design. To enable use of the this feature, you must first configure the directory
where you want Reuse Module .DSN files to be stored.

Note: Users who are granted permission to configure customizable fields are also granted permission to configure
Reuse Module Directory.

To configure the Reuse Module Directory

1. Select the Admin > Configuration menu, then click the Other tab. 

2. Select the Edit button  for Reuse Module Directory. 

Configure Reuse Module Directory

3. Enter the directory where you want to store your Reuse Module .DSN files. Then click the

Save button , or click Cancel   to discard changes.

The directory should be a network directory that CIS users may access.
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Save Configuration for Reuse Module Directory

3.3.9.7  Show CIPClient Download Link

The CIP Client is a separate installation that adds features for OrCAD Capture CIS or System Capture users when
the corresponding plugin is installed. Client plugins for all supported SPB versions are included in the download.
For SPB 23.1 or 24.1, the System Capture client plugin is included. 

The CIP Client enables a user to open CIP from OrCAD or System Capture and use all the standard features of CIP
as well as preview/place symbols, preview footprints, compare symbols to footprints, create/import reuse modules,
and import BOMs directly into CIP. *Some client features required OrCAD Capture and are not supported in
System Capture.

Users who also have Library Builder installed on their system, can launch Library Builder from CIP to build symbols
and footprints. 

Note: Users who are granted permission to configure customizable fields are also granted permission to enable the
Show CIPClient Download Link.

To enable the CIPClient Download Link 

1. Select the Admin > Configuration menu, then click the Other tab. 

2. Select the Edit button  for Show CIPClient Download Link. 
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Edit Show CIP Client Download Link

3. Select the checkbox for Show CIPClient Download Link and click the Save button , or

click Cancel   to discard changes.

Save Configuration Setting for Show CIP Download Link

After making this change, the Download CIPClient link appears when you refresh the page. The download link will be
available from the landing/home page before logging in, and from any CIP page when logged in.

CIPClient Link on CIP Landing/Login Page     

CIPClient Link on any CIP Page when Logged In

To download the CIP client, open CIP from a standard browser and click the Download CIPClient link.
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3.3.9.8  Temp Part Prefix

TMP parts are created with a prefix and incremented by one from the previous entry. The default temp part prefix for a
CIP that doesn't have any temp part is TMP-. 

When CIS is used to create TMP parts, the prefix will be based on user CIS settings. For a system that has
numerous prefixes already in use, you will need to configure a prefix for CIP. Once configured, new TMP parts will
use the configured prefix.

To configure the Temp Part Prefix

1. Select the Admin > Configuration menu, then click the Other tab. 

2. Select the Edit button  for Temp Part Prefix. 

Configure Temp Part Prefix

3. Enter the prefix you want to use. Then click the Save button , or click Cancel   to discard
changes.

Save Configuration for Temp Part Prefix

3.3.9.9  Enable/Disable Full Text Search

Full text search enables you to enter a text string into Keyword search that may not have an exact
match to strings.

Full text search may run slower if you have not allocated sufficient resources to your SQL server.
You may disable to switch to original search functionality. 
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To enable or disable full text search, 

1. Select the Admin > Configuration menu, then click the Other tab. 

2. Select the Edit button  for Full Text Search Enabled. 

3. By default, the full text search is disabled after a fresh install. Select the checkbox to change

the setting for Full Text Search Enabled and click the Save button , or click Cancel   to
discard changes. Note that this may take several minutes to update the database. 

When enabled or disabled, this setting applies to the keyword search functionality within CIP for all
users. This is not a user configurable option. 

3.3.9.10  Enable Download of Ultra Librarian Models

Ultra Librarian® functionality enables users with appropriate permissions to download symbols and/or footprints
and update corresponding part information. With the use of the CIP client, symbols and footprints may be
downloaded when a TMP part created or can be added to existing parts. 

Ultra Librarian can be configured to download symbols and footprints to a common configured location or
individually as each user downloads from Ultra Librarian. Defining a common location enables easy access to
symbols and footprints to everyone after download. Individual download locations provide a layer of control to prevent
duplicate symbols and footprints from being added to the common corporate library. When no common directory has
been configured, each user will be presented with a dialog to select download locations each time a user performs
a model export or TMP part creation with Ultra Librarian option selected. 

The Ultra Librarian Model Download is enabled by default and may be disabled using configuration options in the
Admin > Configuration > Other. 



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 111

September 2025

Note: When configured to work with System Capture plugin and Ultra Librarian is enabled, common directory must
be also be configured.

To configure a common directory for Ultra Librarian downloaded models

1. Select the Admin > Configuration menu, then click the Other tab. 

2. Select the Edit button  for Ultra Librarian Common Directory Settings. 

3. Select the checkbox to Enable Common Directory. The settings for each type of models
appear. 
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4. Enter the directory path for OrCAD Capture models that will be downloaded to the Common
Symbol Directory. Make sure that users performing downloads have Read/Write/Modify
permissions to these directory locations.  In order to save Enable Common Directory
setting, this directory path field must be configured when the Transfer Fields to Design
settings is configured for OrCAD CIS DBC, OrCAD using CIP, or CIP and System
Capture.

5. If you want to have all OrCAD symbols downloaded to a single OLB file, select the checkbox
to Save Schematic Symbols to Single OLB and enter the name of the OLB you want to
have all symbols saved to.

6. Configure options for the handling of models that have the same name. Symbols are
generally named with the Manufacturer Part Number. When a part is downloaded from 2
different manufacturers, the symbol name may be the same. When multiple users download
models that have the same part number or downloaded footprint, padstack or step files name
are the same. The configured rule will be applied to both OrCAD Symbol names as well as
footprint, padstack and step file naming.

a. Skip - Schematic symbol names, footprint, pad or step filenames found in the configured
location will be preserved.

b. Overwrite - Schematic symbol names, footprint, pad or step filenames found in the
configured location will be overwritten with the same name.

c. Append Number - Schematic symbol names, footprint, pad or step filenames found in the
configured location will be saved to a new name with _1, _2, etc appended.

7. Enter the directory path for Common Footprint, Pad and STEP directory. Make sure that
users performing downloads have Read/Write/Modify permissions to these directory
locations. This field must be configured before saving the Enable Common Directory
setting.

8. Enter the directory path for System Capture models that will be downloaded to the Common
Symbol Directory for System Capture. Make sure that users performing downloads have
Read/Write/Modify permissions to these directory locations. Configure options for the
handling of models that have the same name. In order to save Enable Common Directory
setting, this directory path field must be configured when the Transfer Fields to Design
settings is configured for System Capture or CIP and System Capture.

To enable or disable Ultra Librarian downloads

1. Select Admin > Configuration. Then open the Other tab. 
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2. Select the Edit button  for Enable Download of Ultra Librarian Models

3. By default, the Enable Download of Ultra Librarian Models option is enabled. Select the
checkbox to change the setting for Enable Download of Ultra Librarian Models and click

the Save button , or click Cancel   to discard changes. When disabled, the settings for Ultra

Librarian Common Directory Settings are not shown.

3.3.9.11  Enable/Disable Virtual Librarian Service (VLS)

Virtual Librarian Service (VLS) helps engineering teams create their own exclusive part libraries

fast and accurately, allowing engineers to focus on innovation. To access VLS, click  from

the CIP menu bar or click the  button shown on a Manufacturer PN. If you do not have a VLS
account or do not want to see its options, you may disable it.
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To enable or disable Virtual Librarian Service (VLS),

1. Select the Admin > Configuration menu, then click the Other tab.

2. Select the Edit button  for Enable Virtual Librarian Service Access. 

3. By default, the Virtual Librarian Service is enabled. Select the checkbox to change the setting

for Enable Virtual Librarian Service Access and click the Save button , or click Cancel 

 to discard changes. 

When enabled or disabled, this setting applies to VLS menu item and the VLS button shown on a
Manufacturer PN within CIP for all users. It will only be shown when it is enabled in the
configuration (shown below) and when you are logged into an Ultra Librarian account that has VLS
access.. 

3.3.9.12  Show Online Users

To check which users are logged in and using a CIP license, you can navigate to http://[Base CIP
URL]/Account/onlineusers directly or enable the link to show on the login page. Contact one of the users in the list to
free a CIP license.
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To enable the online users link to show on the login page

1. Select the Admin > Configuration menu, then click the Other tab.

2. Select the Edit button  for Show online users link on login page. 

3. By default, the link is not shown. Select the checkbox to change the setting to show the link

and click the Save button , or click Cancel   to discard changes. 

4. Log off CIP to see the link on the login page.
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To Free a license

1. Check for online users.

2. Have an online user open CIP web page and log in. 

3. Then have the user click the log off link in the upper right hand corner of CIP web page.

3.4  Distributors Administration

You can select the  Admin > Distributors menu to synchronize dynamic distributor data, such as cost and quantity.
You can also select this menu to configure distributors' regional and customer settings. 

Admin > Distributors

3.4.1  Distributor Sync

Project part data from a distributor is added to your CIP database after you conduct a Distributor Search and save the
part information. When you need updated part information from a distributor, you can use the Distributor Sync feature
that retrieves up-to-date distributor cost and quantity information for the Distributor Part Number.  You can run
Distributor Sync as needed or schedule the sync to run periodically.

Distributor Sync only updates the distributor cost and quantity information. All valid part numbers from configured
manufactures will be synchronized. Data from distributors for component and manufacturer part fields may differ
between distributors and are not updated during Distributor Sync to avoid overwriting manually edited data with
potential blank manufacturer data. 
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Navigate to the Admin > Distributors page to open the Distributor Sync options. 

Run Distributor Sync On Demand

To start the Distributor Sync immediately, check the distributor(s) you want to sync: Arrow, DigiKey®, Future,
Mouser®, or Newark. Click the Sync button. Notice how the Last Start timestamp changes to the current
time/date. The synchronization process may take several minutes or more, based on the amount of distributor
parts in your database, as well as the Internet connection to the distributors. While the Sync is running, you may
continue normal activities within CIP. 

When multiple distributors are selected, the order of processing is alphabetical. When you sync parts that have
multiple distributors, the value of common manufacturer fields (e.g. Datasheet and RoHS compliant status)
update when the last distributor is processed. 

Synchronize Distributor Data

During synchronization, the Progress column displays the current distributor being updated, as well as the
current and total distributor part counts.  An activity throbber, specifically a circular trail, remains in motion until the
process is complete.

Note: When a Distributor Sync is in progress, the Sync button changes to a Cancel button.  Clicking Cancel
terminates the current Distributor Sync operation. 

Distributor Sync Progressing

Once complete the Data Last Updated field for each distributor updates with a new date and time. If an error
occurs, the Last Message column displays an error message.

Note: The Distributor Sync is unable to synchronize Arrow part numbers that are manually added or modified.

Schedule Distributor Sync

To schedule the Distributor Sync to run periodically: 

1) Make the following selections in the Schedule Sync section.

o Select the Enable checkbox to add a check mark. 
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o Check the distributor(s) you want to schedule for the sync: Arrow, DigiKey®, Future,
Mouser®, or Newark.

o Select the number of days between each sync period.

o Select the start time for the sync.

Schedule Distributor Sync

2) Select Save to retain your settings.

Once syncing starts, the progress information is the same as starting Distributor Sync on demand.  

Note: The Next Run time may show a date in the past. The sync will start within 15 minutes after you schedule the
sync for this case.

If you suspect scheduled sync or reports are not running for some reason, review the information in the section
CIP Scheduler Service not running to determine how to get this process started again.

Scheduled Distributor Sync not finishing:

When you can run a sync manually and see it finish but the schedule sync runs without finishing, it is most like
that the CIP web application timed out and shut down before your entire set of parts has completed processing.
Web server user activity time out is configured for 20 minutes by default. The schedule sync task runs without
user activity and requires a longer time out period. Contact your IT administrator to extend the time out for the
CIP_AppPool. The CIP_AppPool setting can be changed in the Advanced Settings for the Application Pool in
the Internet Information Services (IIS) Manager that hosts the CIP Web application. The time out setting is
shown in the following figure.
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3.4.2  Configure Distributors

Distributors that allow regional settings in their API include Digikey, Mouser and Premier/Farnell/Newark. Users with
configure distributors permissions will be able to change regional settings. Premier/Farnell/Newark distributor also
provides settings for Customer ID and Customer Key and user credentials. Distributors that do not support regional
settings in the API are not configurable.

DigiKey Configuration

The DigiKey Configuration option allows privileged users to change the applicable Country and Language for
DigiKey searches as provided by DigiKey.  Prices and currency will vary with different combinations of these fields. 
Select the desired options from the list, then click Save.  Click Cancel to discard changes.

Digikey Configuration

Mouser Configuration
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The Mouser Configuration option allows privileged users to change the applicable Country, Language, and Currency
for Mouser searches as provided by Mouser.  Prices and currency will vary with different combinations of these fields.
 Select the desired options from the list, then click Save.  Click Cancel to discard changes.

Mouser Configuration

Premier/Farnell/Newark Configuration

The Premier/Farnell/Newark Configuration option allows privileged users to change the applicable Customer ID,
Customer Key, and Country for Premier/Farnell/Newark searches.  Customers can view customer-specific part
pricing, based on their Customer ID and Customer Key.  Select/enter the desired options, then click Save.  Click
Cancel to discard changes.

Note: The Customer ID and Customer Key fields are not required. These fields must be left blank if you do not have
a valid customer ID and Customer Key.  Customer-specific pricing may vary from Newark’s website
(www.newark.com).

Premier/Farnell/Newark Configuration

3.5  Scheduled Reports

Scheduled Reports may be created from any saved Global Search. You can create multiple
reports to run at different schedules. 

To create a report task for a scheduled report 

1. Select the Admin > Scheduled Reports menu.

http://www.newark.com


Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 121

September 2025

Admin > Scheduled Reports

2. Click the Add a Scheduled Report button. 

3. Enter the following configuration settings for your report task. The Example File Name
toward the bottom will update as you enter values that affect the file name, showing how the
report file name will look with your settings.

a. Report Name - Specify a file name for your report. The file name may have a date and
time stamp pre- or appended. 

b. Run Every x Days - Specify the periodicity of your report. Shortest period of automated
reports is daily. 

c. Start Time - Specify a start time to run the report, whether it be off-hours or any other
time. After specifying the time, a report may be generated immediately if the report has not
run within 24 hours.

d. Search Name - Any saved global searches will be available to use for your schedule
report task. Select a saved global search.
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e. Report Type - Specify the report format generated in Excel or CSV format.

f. Affix Datetime - Configure to include the date and time stamp as part of the output report
name.

g. Custom Save Path - Select this to save the report to a location other than the default. As
shown, this path is relative to the server (e.g. C:\TEMP would refer to the location on the
CIP web server, not a user's machine).

Custom Save Path

4. Click the Add button to save your configuration. Your report task shows in the list of all
configured report.

Scheduled Reports

Output of Scheduled Reports

To view, download or delete generated reports, 

1. Click on the row with your report name. The output of a report task shows in the bottom.
When you have more than 1 task configured, report for each shows as you click on each row.

2. Click the download button to download a report within a schedule task.
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3. Click the delete button to remove a specific report. You are required to confirm before the
report is deleted. 

To Edit a scheduled task

1. Click the Edit,  button to open the Edit Report Task form. You may change any of the information

configured, including report names.

2. You may change any of the information configured during add report task. Make your changes
and click Save. Note that a new report will not be generated if already created within the
period specified.
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3. When date time is include in the report name of a report task, reports prior to the
configuration change also shows when you click on the row of your report. 

To Delete a scheduled task

1. Click the Delete,  button for the report task you no longer need.

2. You are asked to confirm deletion by typing "DELETE". Once confirmed, the configuration
and all reports associated to the task are removed. You will no longer have access to deleted
reported.



Product Version 25.1.22 for 25.1, 24.1, 23.1

CIP Administration 125

September 2025

Physical location of reports

· The default report location is on the CIP web server, under
<CIP_Install_Location>\Web\Reports\ID#. The ID# can be found in the ID column in the list of
Scheduled Reports. If you've configured a Custom Save Path for a report, it will be saved
there.

· If access to physical files is needed to work with scripts, request that IT (or someone with
permission) shares the appropriate report folder(s).

· A new ID will be create when tasks with the same report name are deleted and recreated.

3.6  Users, Roles & Permissions Administration

CIP can be utilized by a wide variety of users. The range of tasks each type of user can perform is controlled through
the assignment of roles and permissions. Operations each user type (determined by role) can perform on the CIS
database may include such tasks as creating, editing, searching, updating, and deleting parts, etc. Other users, for
example, may only require CIP view and search capabilities and have a role where it is unnecessary to modify
anything in the CIS/CIP database. 

By default, there are four default roles that can be assigned to a CIP user: 

· Read Only
· UpdateWithoutDelete
· UpdateWithDelete
· Admin

Additionally, users with permission to define roles can create additional roles or modify the default roles. 

The User, Roles & Permissions menu item is only visible to users who are granted permission to modify Users,
Roles or Permissions. 

Admin > Users, Roles & Permissions



Product Version 25.1.22 for 25.1, 24.1, 23.1September 2025

CIP User Guide126

3.6.1  Manage User Accounts

Users granted the User Admin role permission may create a user account, edit an existing user account, delete an
existing user account, as well as manage user roles and permissions through the Admin tab and Users, Roles and
& Permissions menu option. 

A User Admin can enable the Automatic Windows User Registration option and set the Default Role for new users
added in this fashion. This allows Windows domain users to automatically add themselves to CIP by clicking the
Windows authentication button at the CIP log in screen. The first time they do so their Windows domain user will be
added to the CIP Users list and their role will be auto-assigned based on the configured default role.

User Administration

To enable this option, select the Edit  button next to Automatic Windows User Registration. Select the check box

next to the Default Role option and select role from the drop-down list. Click the Save  button to save the settings.

Enable Auto User Account Option

3.6.1.1  Creating User Accounts

A user can be added as a Windows user or local CIP user. When adding a user as a Windows user, a password is
not required. The username of the Windows user must be valid.

To add a new Windows user account into CIP, enter the Windows username, first and last name, email address,
and select the Windows checkbox. The optional fields for adding a new Windows user include the email, first and
last names. By default, the CIP server will search the Active Directory domain it belongs to when checking the validity
of Windows logins. If there are multiple domains in your company’s environment and CIP has not been configured
for this environment, you may not find Windows usernames for users belonging to different domains. Contact your
CIP Admin or your IT team to make changes to support multiple domains for your CIP installation. Information on
setup can be found in the appendix of the CIP installation guide.

Email notifications can only function properly when a correct email address is provided. The figure that follows
shows a warning alert that displays when CIP is unable to identify a valid username in the Active Directory.
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Creating User Account:  Windows or CIP Local User

To add a new local CIP user account, enter a username, first and last name, email address, and password.  You are
not allowed to save a user account if the password entered fails to conform to the following standards. 

Passwords must be at least 6 characters AND include the following: 

§ Passwords must have at least one lowercase ('a'-'z')

§ Passwords must have at least one uppercase ('A'-'Z')

§ Passwords must have at least one digit ('0'-'9')

§ Passwords must have at least one non-letter/non-digit character.

Note: When adding a new Windows user, the Username field populates with available users as the name is typed
into the field. This list may take a moment to populate.

Creating New CIP User Account: Alert Message With Entry of Invalid Password

Next, select a Role for the account. Four default roles have been pre-defined. If this user wishes to receive Email
Notifications, select the appropriate checkbox next to the desired Notifications for Insert, Update, and Delete. After

entering the new user information, click on the Add  button to create the new user account. Before a CIP User can
receive Email Notifications, Email Notifications must be enabled through the Admin > Configuration > Email
Notifications tab. The Email Notifications section of this document will guide an Admin through the email setup. You
should create a second Admin user account if you change the Admin User password. 

Define Role for New User

User permissions for the default user roles are provided in the section on default roles. The Role Administration
section will also guide you through defining new roles. 
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3.6.1.2  Editing an Existing Account

To edit an existing account click on the Edit  button on the User Administration screen for the account you need to
edit.

User Administration Edit

Editing an account allows the Administrator to change the email address, password, role type, or email notification

associated with the account. Once an acceptable change is made, click the Save  button to update and save the
account. 

Usernames are uneditable. If a user needs to change the name on the account, delete the account and generate a
new one.

User Administration Update

You can change a CIP user to a Windows user, when the Windows user name is the same, by clicking the Edit 

button. Select the checkbox for Windows and click the Save  button. 

If the CIP username is different from the Windows username, you will need to remove the CIP username and then
add the Windows username. 

3.6.1.3  Deleting an Existing Account

When a CIP account is deleted, it is completely removed. 

To delete an account select the Delete  button for the account that you want to remove.

User Administration Delete
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3.6.1.4  Check Licenses In Use

You may check the licenses that are currently being used at any time, by opening a web browser and visiting http://
[Base CIP URL]/Account/onlineusers. All logged in users are listed on the page. The link to OnlineUsers page may
be configured to show on the login page.

For example: if your Base CIP URL is http://ServerName/CIP-E, navigate to http://ServerName/CIP-
E/Account/onlineusers.  

Verify CIP Licenses Currently In Use

3.6.2  Manage Roles

Role administration can be performed from the Admin > Users, Roles and Permissions > Roles tab. Roles can be
added, modified or deleted from this tab. CIP consists of administrative and user permissions. Any of these types of
permissions can be assigned to any role. 

Role Administration

3.6.2.1  Default Roles

Four default roles are available: 

Read Only Role

The default Read Only role has similar permissions as that of the CIS user. The user can view, query, and
search, as well as complete other tasks. Users with the Read Only role can view and search for parts within the
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CIS Database using CIP. To enable the Read Only user to create Temp Parts from distributor search, update the
Read Only Role to include Add Manufacturer Parts. The Read Only user cannot modify parts within the database. 

UpdateWithoutDelete Role

The default UpdateWithoutDelete role can perform all functions of the default Read Only role, as well as add new
formal parts and edit existing parts. This role may be assigned to a Librarian or Component Engineer. 

UpdateWithDelete Role

The default UpdateWithDelete role can perform all functions of the default UpdateWithoutDelete role, and can
also delete both Temp and Formal parts from the database. This role may be assigned to a Librarian or
Component Engineer. 

Admin Role

The default Admin role has the superset of all administrative and user permissions. Users who have been
assigned the default Admin role can do everything that the UpdateWithDelete user can do, and they also have
access to the Admin tab. The Admin tab includes options for: User Administration, Role Administration, Rule
Administration, Email Notification setup, Customizable UserFieldXX setup, Bulk Operations and Distributor
Administration. An administrative role would most likely be assigned to an Engineering Manager, IT personnel or
potentially Librarians or Component Engineers. 

The Admin Role is the only role that cannot be modified or deleted. 

The predefined roles, Read Only, UpdateWithoutDelete, and UpdateWithDelete, can be modified by anyone who is
granted the Define Roles permission. To restore any of these roles to the default settings, click on the applicable
Restore button at the bottom of the Role Administration tab. The Admin role is a system role that cannot be changed
by anyone. 

Role Administration Restore

3.6.2.2  User Role Permissions

User permissions pertain to permissions that apply to parts and BOMs. User permissions can be assigned to any
named role including the following:
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User Permissions That Can Be Assigned to a Role

Create TMP Parts

A user with this permission is able to 

· Create TMP parts from the Distributor Search tab. 

· Create TMP parts from new part form. 

· Create TMP parts from copy part form.

· Add new manufacturer part and associated distributor part when creating TMP parts from
distributor search.

· Associate an existing manufacturer part when creating TMP parts from distributor search.

Edit TMP Parts

A user with this permission is able to 

· Edit TMP parts using the edit part form.  

· Edit TMP parts data from distributor search by selecting overwrite component data.

· Add new manufacturer part and associated distributor part to an existing TMP part from
distributor search.

· Associate an existing manufacturer part to an existing TMP part from distributor search.

Delete TMP Parts

A user with this permission is able to 

· Delete a TMP part and associated manufacturer and distributor parts.

Create Formal Parts

A user with this permission is able to 

· Create TMP and formal parts from the Distributor Search tab. 

· Create TMP and formal parts from new part form. 
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· Create TMP and formal parts from copy part form.

· Add new manufacturer part and associated distributor part when creating TMP and formal
parts from distributor search.

· Associate an existing manufacturer part when creating TMP and formal parts from
distributor search.

Edit Formal Parts

A user with this permission is able to 

· Edit TMP and formal parts using the edit part form.  

· Edit TMP and formal parts data from distributor search by selecting overwrite component
data.

· Add new manufacturer part and associated distributor part to an existing TMP and formal
part from distributor search.

· Associate an existing manufacturer part to an existing TMP and formal part from distributor
search.

Delete Formal Parts

A user with this permission is able to 

· Delete a TMP and formal part and associated manufacturer and distributor parts.

Add Manufacturer Parts

A user with this permission is able 

· Add manufacturer parts to existing TMP or formal parts. 

Edit Manufacturer Parts

A user with this permission is able to 

· Edit manufacturer parts using the edit manufacturer part form.

· Add distributor part to an existing manufacturer part when creating or updating a TMP or
formal part from distributor search.

· Add distributor part using add distributor part form.
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· Edit distributor part

· Delete distributor part

Delete Manufacturer Parts

A user with this permission is able to 

· Delete a manufacturer part and associated distributor parts from a TMP or formal part.

Use Compliance Search

A user with this permission is able to use the Compliance module's Search tab.

Create BOMs

A user with this permission is able to add parts into the BOMs table and import parts to the
BOM.

Delete BOMs

A user with this permission is able to delete BOM part numbers.

Create Reuse Modules

A user with this permission is able to create and edit reuse modules.

Delete Reuse Modules

A user with this permission is able to delete reuse modules.

3.6.2.3  Administrative Role Permissions

Administrative permissions that can be assigned to any named role include the following: 

Admin Permissions That Can Be Assigned to a Role
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§ Create Global Searches - A user with this permission is able to create, edit, and delete global
searches that can be used by all users. 

§ User Admin – A user with this permission is able to view the User Administration menu items
and manage users. This user can create, modify, and delete CIP users. Any users online
status as well as last activity status may be viewed. Email Notification for Individual Users
may also be managed by a user with this permission. 

§ Define Roles – A user with this permission can create new roles, modify or delete an existing
role as well as assign permissions to each new roles.

§ Set Rules – A user with this permission can modify or delete existing build rules. The Rule
Administration section provides detail description on how rules can be defined, modified or
deleted.

§ Email Notification – A user with this permission can enable Email Notification for Individual
emails and for Email Aliases. Email notification configuration may be found in the
Configuration menu item.

§ Incremental PN Format – A user with this permission can define the format for the part
number to be automatically incremented. The configuration of PN formats may be found in the
Configuration menu item.

§ Views, Custom Fields, Reorder Fields, BOM/Design Options, MFR PN Status, Other – A user
with this permission can access settings in these Admin > Configuration tabs: Component
Views, Customizable Fields, Reorder View Fields, BOM/Design Options, Manufacturer Part
Status Indicator, and Other.

§ System Capture – A user with this permission can use the System Capture tab under Admin
> Configuration.

§ Sync Distributor and Compliance Data – A user with this permission can run or schedule a
sync of Distributor data and Compliance data.

§ Configure Distributors – A user with this permission can change distributor locale and
language.  

§ Bulk Operations – A user with this permission can use the Bulk Delete, Bulk Rename,
Component View Mover, Import, and TMPPRTS Import features.

§ Scheduled Reports – A user with this permission can create Scheduled Reports from any
saved Global Search.

3.6.2.4  Creating Roles

Roles can be created with any name. The Admin can assign permissions to a role when the role is created or
modified at a later time. 

To create a role, select Admin > Roles & Permissions. Type the name of the role into a blank table row and click the

Add button.   
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Role Administration Create

3.6.2.5  Modifying Roles

Modifying a role is similar to adding a role.   

1. Click the Edit button that precedes the row of the role you want to modify. 

Modification of Role Administration

2. Click to place a check mark in each column you want to assign to the role you are updating.

3. Click the Save Role button  to save the changes. Or click the Cancel Edit Role button

  to cancel changes. 
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Role Administration:  Save Update Button

3.6.2.6  Deleting Roles

To delete a  role that was created, click the Delete button.   When you are prompted to confirm the deletion, click
the Delete button. 

Role Administration:  Delete Button

 

You cannot delete a role when a user is still assigned to the role. The image below shows the grayed-out Delete

button  for the Read Only role is disabled. You can hover your cursor over the disabled button to see the number
of users still assigned to the role.
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Role Administration: Delete Button Disabled

3.6.3  Field Permissions

The administration of field permissions is performed from the selection of Admin > Users, Roles & Permissions
menu > Field Permissions tab. 

Field Permission Administration

The users' permission to edit or view a field can be configured by role. By default, all roles include permission to
view and edit all configured fields. The permission for the Admin role are uneditable. The field permission for each
role and category are controlled individually. 

To make changes, select the role for each table you wish to change. Deselect fields that you do not want the user to
either see or edit. Once you make any changes, you will see a warning immediately notifying you that a change has

been made. The changed fields are highlighted as yellow. If you want to keep the changes, select Save button. 
 Once changes are accepted, the warning and highlighting disappears.



Product Version 25.1.22 for 25.1, 24.1, 23.1September 2025

CIP User Guide138

Edit Field Permissions

The changes takes effect the next time a user with the changed role opens a new page in CIP. The following
example shows a user show can edit a part but not the Part_Number or the Schematic part.

Note: Users who are not allowed to edit Part_Number will not be able to create formal parts.

Example Of User With Partial Field Edit Permissions

Fields that have not been configured as visible will be designated with an alert triangle,  next to the field name as
shown in the following figure.
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Fields Without Visibility Have Alert Triangles

3.6.4  Hide Rule

A rule can be defined to hide parts from users in a selected role. For example, if you do not want
electrical engineers to be able to find and use obsolete parts, you can create a rule from the Admin
> Users, Roles and Permissions > Hide Rule tab.

Configure Hide Rule

To Define a Rule to Hide Parts:

1. Click the Edit  button to edit the rule.
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2. Select the Enable checkbox to enable a rule.

3. Select a Field from the drop list that will be used to determine which parts to hide.

4. Add Values for the matching conditions for the part to be hidden. Multiple values may be

added as shown in the example. Click the Add  button to add the value to the list.

5. Select a role that you want to apply this rule. Multiple roles may be added.

6. Add a comment for the rule and click the Save  button to your configuration.

Once defined, users who are assigned the role will not be able to search or see parts that match this rule.
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4 Using CIP

CIP is a powerful web-based interface that connects directly to the CIP Database. It allows users to perform basic
tasks such as creating, editing, deleting, and searching for parts, as well as advanced tasks such as searching the
distributors’ databases, setting up email notifications and generating customizable fields, etc. CIP also enables
Admin users to assign and manage different user roles.

CIS users connect to component and manufactures views of the CIP database.

4.1  Logging into CIP

To start using CIP, you need a username and password. This will normally be provided by your CIP Administrator
along with the CIP URL. Your username can be set up as either a CIP user or a Windows user, depending on the
type of account your administrator created for you. 

CIP User Login

If your account is a CIP account, type your username and password before you click the Log In button. If your account
is a Windows account, you only need to click the Windows button to automatically log in. If you are unable to log in
with your Windows account and your company has multiple Windows domains, you will need to contact your CIP
Admin to confirm that CIP has been configured correctly. When using CIP in Capture and you see a blank screen
either when you open CIP or when using Windows log in, you may need additional settings as described in CIP
Client Installation guide section "CIP Shows Blank Screen in Capture".

All CIP user roles allow you to search and view parts within CIP.  The CIS DB Search and Distributor Search can be
used to perform searches. The ability to edit or delete a part is based on the role assigned to you by the
Administrator. 
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Search for Parts

4.2  Changing your password

You can change your CIP password by clicking the Manage Account link that is located in the upper right-hand
corner of the CIP page. When Ultra Librarian model download is enabled, you may enter your Ultra Librarian
Username and password.  Users logging in with a Windows account will be unable to change the password from
CIP, but may enter Username and password for Ultra Librarian. When Ultra Librarian model download is disabled,
Ultra Librarian log in is not shown.

Change Password Link
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Change Password

Enter your Ultra Librarian username and password to download ECAD models available through Ultra Librarian. If
you do not have a login, click on the Click here link next to New User or Forgot Password? to register for an account. A
new browser window opens to the Ultra Librarian site to register for a new account.

Enter Ultra Librarian Username and Password

If you are logged in and need to change your account settings or password, click the Click here link to Change Ultra
Librarian Password or Update Ultra Librarian Account Profile. A browser window opens to the Ultra Librarian site. If
you wish to log out, click on the Logout of Ultra Librarian button.
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4.3  Components

The Components pull-down menu is one of several method to search for parts. This method enables you to choose
a specific component view of parts, or All parts. For example, if the Capacitors view is chosen from the Components
list, the result will show the Part Information page for the first capacitor from the Capacitors view in the database.
Once a Components view is selected from the list, the parts pull down list will show only parts in the selected view
(in this case, capacitors). You will see the part information page consisting of part attribute data in the component
form as well as the manufacturer and distributor data.

Hover over Components to see the List of Part Tables, including All Tables

You can navigate through the part list by clicking the Previous  and Next  buttons that are located to the left

and right of the part number. You can also click  or  to select the First or Last part in the current list.  Click 

to toggle the sort order from ascending to descending, or  to go from descending to ascending order. 
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List of Parts in a Given Table

4.3.1  Creating/Modifying Parts

Before a part can be created or modified you must select the Components menu item to open the Part Information
page.
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Select Table To Add or Modify Parts

4.3.1.1  New Part Creation

New parts can be added by clicking the New button  from any Part Information page of a part detail. The New
button is only available to users who are granted permission to add a new part.

New Part Creation

A new part entry form opens when you click the New button . Part data can be added from this page as well as a

formal company Part Number. Click the Add button  (same graphic as the New button from previous figure) to
generate the new part with all entered information. If a default value has been configured for a field, the new part
entry form will show the default values for the configured fields. Refer to Customizable Fields section of this guide for
instructions on how to configure default values.

Note: The Add  button is only visible when you are granted permission to add a formal part number.



Product Version 25.1.22 for 25.1, 24.1, 23.1

Using CIP 147

September 2025

Add New Part

The New Part results will appear in the drop-down list of parts in the Components area. Additionally, the part also
becomes available to CIS users who are connected to the CIP database.

Drop Down List of Part Numbers

4.3.1.2  Creating New Part with Next Available TMP Part Number

If a formal part number is unavailable at the time you enter your part, you may create the part as a TMP part and
change the TMP part number to the formal number at a later time. 

Note: The  button is only visible when you are assigned permission to add a TMP part.  
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New Part Creation

Add New TMP Part

Added New TMP Part
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4.3.1.3  Creating New Part with Next Auto-Increment Part Number

To create a formal Part Number using the Auto-Increment Part Number feature, click on the New button to bring
up a blank new part form. 

 Note: The New button  is only visible when you are granted permission to add formal or TMP parts.

New Part Creation

Enter data into the new form and then select the Next PN button  to obtain the next part number in the sequence.

Select the Add button to add the part.

Note: The New button  in this screen is only visible when you are granted permission to add a formal part.

Add New Part w ith Next Available PN

The example below shows the first auto-increment part number with a prefix of CAP-, followed by eight digits for the
sequence number.
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Added New Part w ith Next Available PN

4.3.1.4  Modifying an Existing Part

Parts can be modified from the Part Information page by selecting the Edit button .  Part data can also be
modified using the Distributor Search to overwrite component data. The mapped distributor field data from the
distributor search results can update a part already in CIP.  

Note: The Edit button is only visible when you are granted permission to modify a part.

Modify an Existing Part

Once the Part Information opens, modify the desired data and click the Update button  to save the change. Temp
parts can be modified in the same way. Converting a TMP Part to a formal part can be done by modifying the
PART_NUMBER field.
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Save Changes to Existing Part

Note: When you modify part attributes or properties, all instances of that part update. If you do not want to update all
instances, you need to create and reference a new part or part number. 

Updating Schematic Part

There are two ways to update the schematic part with additional symbols. You may type your symbol name or select

the Add button . Type a comma to separate multiple symbols. The Add button is available when CIP is opened in
Capture CIS. 

To update a schematic symbol while in the edit form

§ When you start typing your symbol name, the list of all symbol used in the database will
show. You may select from the list or continue to type the symbol name. Each time you type
a comma, the list appears again for your selection.

 
Pick List for choosing from Multiple Symbols

§ If you want to select the symbol from one of the libraries configured in your Capture.ini file,

click the Add button   that is located to the right of the Schematic Part field. 
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Note: The Add button is only available when you open CIP from OrCAD Capture. When you click the Add
button, a preview window opens with a list of OLB libraries.

1. Select a OLB library from the list.

Selection List of OLB Library Symbols

The name of the first symbol in the library populates the Symbol field. However, if the symbol library you select
includes more than one symbol, a drop list becomes available so you can select an alternate symbol. 

Select an Alternate Symbol from OLB Library

2. Click the Add button to populate the field with the name of the symbol you selected. This
process may be repeated for multiple symbols.
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Updating PCB footprint 

When you start typing your PCB footprint name, the list of all footprints used by other parts in the same component
will show. You may select from the list or continue to type the footprint name. Each time you type a comma, the list
appears again for your selection.

Pick lists

If pick lists are configured for fields, you can choose the desired value from the list. For example, if the Dielectric Type
field is set up to offer a pick list of the values: Ceramic, Aluminum, Tantalum, or Unknown, then you can access the
list and choose one of those values. If a field is changed from text to a pick list and your data does not match one of
the items in the pick list, modifying the part will automatically change the field data to one of the values in the list. 
Only persons with administrative privileges can configure pick lists in customizable fields. Refer to Customizable
Fields section of this guide for instructions on how to configure pick lists.

Choosing a Value from a Pick List

4.3.1.5  Moving a Part to a Different View

When you want to move a single part from one component view to different view, you can open the part page in CIP,

click the Move  button and select the Component View from the drop-down menu. If you use the Move button to
move a part to another component view that is to the same table, the part history remains intact. However, if you use
the Move button to move a single part to the component view of a different table, the part history will be lost.

You can easily move a group of parts from one view to another by using the Component View Mover tool. However,
the originating and target views must be within the same table. The Move button is only visible when you are granted
permission to delete and create parts. 

Note: Fields can only be transferred to a new view when the field names of the two views match. The values of fields
that have a different field name are lost in the new view.

To move a part to an alternate view

1. Open the part. The name of the view associated to the part displays in the part header. 
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The example below shows PART_NUMBER 00002217V22 in the Capacitors view. 

2. Click the Move button.  

3. Select the alternate name of the view you want to associate to the part from the drop-list
menu. 

The example that follows shows the selection of the Ceramic view, which is a user-defined view as setup in
the Admin > Configuration > Component Views page. 

Note: When moving parts to a view that is associated to a different table, history records of all prior changes
will be lost. This information is also stated in the warning for this case.

4. Verify the view header to confirm the view you selected is associated to the part. 
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Part view displays in header

4.3.1.6  Copying an Existing Part

The Copy button allows users to create a copy of any existing Formal or Temp part.  The Copy feature also provides
an optional checkbox to copy the Manufacturer Parts associated with the Formal or Temp part.  Before completing
the copy, users are able to modify the field values as desired. 

To copy an existing part, find the part you want to copy. From the Part Information section, click the Copy button  
.

Copy Part

After clicking the Copy button, users are able to change field values and choose whether or not to copy the
associated Manufacturer Parts (using the checkbox).
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Copy Part Options

To copy a part as a temporary part, click the Copy as TMP button  .  This will copy the part and its field
values.  If Copy Manufacturer Parts is checked, associated Manufacturer Parts will be copied as well. CIP will
assign the next available TMP PN to the copied part.

Copy Part as TMP PN

To copy a part with the Given PN (i.e. the value in the PART_NUMBER field), populate the PART_NUMBER field

manually or click   to generate the next available number.  When ready to complete the copy, click   to Copy
with the Given PN.  If the  PART_NUMBER is left blank, an error message displays when you click the Copy button
that states a PART_NUMBER is a required field.

Copy Part as Given PN

4.3.1.7  Deleting a Part

If you have a part you wish to delete, click the Delete Part button    on the Part Information section for the
specific part. A confirmation window prompts you to confirm the Delete operation or Cancel. Exercise caution when
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deleting a part as it may be used in multiple legacy designs. Deleting the part can ultimately affect the usage of
those designs. 

Note: the Delete button is only visible if you are granted permission to delete parts.

Delete Part

Click Delete to confirm part deletion or Cancel to keep the part.

Delete Part Confirmation

4.3.1.8  Adding Mechanical Parts to a Component

Mechanical Parts can be associated to existing parts in CIP. The associated Mechanical Parts can be included in
Capture CIS BOMs or CIP BOMs without the need to have parts placed on designs. This includes parts such as
screws and washers. 

Note: To include mechanical parts when generating BOMs in Capture CIS, be sure to select the Output Mechanical
Part Data checkbox in the Reports > CIS Bill of Materials pop-up.

Mechanical parts are created the same way as any other New Part. To create a new mechanical part, select the
Components > Mechanical menu items as shown in the graphic figure below. 
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Select Mechanical

To add mechanical parts to an existing part, click the Mechanical Parts tab while viewing the intended part.

Select Mechanical Parts Tab

Enter the part number and quantity of the mechanical part to be added and click the Add button . The Description
appears when mechanical part is added. Repeat this process for any additional mechanical parts.
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Add Mechanical Part

If you are creating your own .DBC file, rather than using the default, be sure to configure the MechanicalMapping. Use
the CIS Configuration wizard in Capture CIS to create new .DBC file. While in Capture CIS, select menu item Options
> CIS Configuration. Review the Appendix for instructions that explain how to update the CIP/CIS .DBC file.

Configure .DBC file in Capture CIS

A table for MechanicalMapping must be enabled as shown in the graphic figures below. 
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Enable MechanicalMapping Table

When creating a CIS BOM, be sure to add Mechanical_partno and Mechpart_quantity to your BOM
output and select Output Mechanical Part Data, so that Mechanical Parts is included when
BOMs are generated. 
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Add Mechanical_partno and Mechpart_quantity to BOM Output

4.3.1.9  Adding a Manufacturer Part Number

Multiple manufacturers can be attached to a part and viewed in the Manufacturing Part Data area of the Part
Information page.  You can also add new manufacturer part data by selecting the Add Manufacturer Part tab. 

Note: The Add button  is only visible if you are granted permission to add a Manufacturer Part.  
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Add Manufacturer PN

When the Manufacturer Part Data page opens, enter the appropriate data into the fields and click the Add button to
implement the change.

Add Additional Manufacturer PN

4.3.1.10  Modifying an Existing Manufacturer Part Number

You can edit Manufacturer Part information that is associated to a company by clicking the Edit button   located
in the Manufacturer Part Data section below the Part Information page of a given company part.

Note:  The Edit button is only visible when you are granted permission to modify the Manufacturer Part Data.



Product Version 25.1.22 for 25.1, 24.1, 23.1

Using CIP 163

September 2025

Modify an Existing Manufacturer Part

Once the Manufacturer Data edit page opens, modify the desired information and click the Update button  to
save your changes.

Save Changes to Existing Manufacturer Part

When a manufacturer part is used in multiple company part numbers, any update to attributes such as the
manufacture name, part number, status etc. is reflected in each instance of the manufacturer part. For example, if a
manufacturer part is used in two company parts, changing the manufacturer part number can be seen in both
company parts. You can verify where each instance is updated through the Where Used tab shown in the image
below.
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4.3.1.11  Deleting a Manufacturer Part Number

To delete a specified manufacturer part from a specific company part, select the desired manufacturer tab from the

Manufacturer Part Data page and click the Delete button . 

Note: The Delete button only displays when the user is assigned permission to delete the Manufacturer Part. 

Delete Manufacturer Part

Click Delete to confirm manufacturer part deletion or Cancel to keep the part.
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Delete Manufacturer Part Confirmation

4.3.1.12  Modifying Per Part Manufacturer Part Data

When CIP is configured to display the Component Manufacturer Part field, you can modify the Per Part Manufacturer
Part Data. Fields in this section identify unique properties between the selected company and the manufacturer
part.  

Modify the Per Part Manufacturer Part Data

4.3.1.13  Add, Modify and Delete Distributor Part

Each manufacturer part number can have any number of distributor part numbers associated to it. 

Distributor parts can be added using one of the following methods:

§ Use Distributor Search to automatically add a TMP part or update an existing part

§ Add the part directly from the part entry page

§ Use the Add Distributor PNs or Add Silicon Expert PNs button to automatically add the
part when viewing a Manufacturer Part 

Distributor Part information may be modified with one of the following methods:

§ Use Distributor Search to automatically update an existing part or Distributor Sync

§ Modify the part directly from the part entry page

Distributor parts are deleted directly from the part entry page. 
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To modify the fields associated to a distributor part, select the part and scroll down to the distributor information of
the Part Information form. 

Add Distributor Part Manually

To manually add a distributor, enter the distributor name and distributor PN and then select the Add  button.

Manually Add a Distributor

Add multiple Distributor Parts

To add multiple distributor part numbers, select the desired Manufacturer Part tab and click the Add Distributor
PNs button. If you have an active subscription for the CIP Compliance module, an Add Silicon Expert PNs button
is available. Selecting the Add Silicon Expert PNs button takes you through the same steps as described in this
section. 

The Distributor Search or Compliance page opens with the search criteria auto-configured using Search by
Manufacturer Part Number with the manufacturer part number in view.  

1)  Select distributors to include in the search from the distributor search page. Then select
the Search button. 

2)  Select the distributor parts after the search results appear. Then select Add to Part
Number button.
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Add Multiple Distributor Parts

The selected distributor part numbers will be added.

Added Distributor Parts

Edit Distributor Part manually

To manually edit a distributor part, select the Edit  button of the distributor part you want to edit. The form

updates to allow you to make modifications. After you complete your updates, click the Save,  button to save

your edits. Or to discard your updates, click the Cancel,  button.
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Save or Cancel Modifications/Edits to a Distributor Part

Delete Distributor Part

To delete a distributor part, select the Delete,  button of the distributor part you want to delete. 

Delete Distributor Part

Click Delete to confirm distributor part deletion or Cancel to keep the part.

Delete Confirmation

Note: When an Arrow part number is added to CIP using a distributor search, a unique string that is used to retrieve
quantity and price data is also added. When the Arrow part number is manually added or modified, the unique
reference string becomes unavailable. Consequently, the Arrow part is unable to update during a distributor sync.

4.3.1.14  Add ECAD Model from Ultra Librarian

You are unable to place parts that do not have a Schematic Part. You may create a Schematic Part manually, using
OrCAD Library Builder or download from Ultra Librarian. When Download of Ultra Librarian Models is enabled, you
are able to download symbol and footprint models from Ultra Librarian.
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To download ECAD Models from Ultra Librarian:

1. Using the CIP client running inside Capture, select the manufacturer part section of part you
wish to download.

2. Click on the Ultra Librarian symbol next to the manufacturer part number.

3. A pop up shows with possible part matches with ECAD models.

4. Select Preview button to view the ECAD Models for each part.
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5. If this model does not match what you need, click the Return to Search button to continue
previewing the next part.

6. When you've found a match, click the Export button to start download. If Common
Directories have been configured, the download will start immediately. If no common
directories are configured, a dialog for Download Ultra Librarian Symbol to local directories
appears. Select locations for your download files and export.

7. When download is completed, the part is updated with the new symbol and PCB Footprint
name appended as shown in the following example.

4.3.1.15  Change Order of Manufacturer Parts

By default, the tab display of manufacturer parts is presented alphabetically. To change the tab order, select the

Manufacturer Part you want to re-order and click the Move Left  or Move Right  button. The new tab order

updates as the page refreshes. The Move Right button  becomes disabled when a manufacturer part is in the far



Product Version 25.1.22 for 25.1, 24.1, 23.1

Using CIP 171

September 2025

right position. Similarly, the Move Left button,  becomes disabled when Manufacturer Part is in the left-most
position. 

Click Move Right (or Left) Button to Change Manufacturer Part Tab Order

4.3.2  Comparing a Schematic Part and PCB Footprint

You can use CIP to compare Capture symbols and PCB footprints of a part from Capture. 

To compare a Capture symbol and PCB footprint, open the desired part from Capture. Click the Compare button

 to open a side-by-side view of the schematic part and PCB footprint. 

CIP Compare Button to Compare Footprint and Symbol Pins

Allegro PCB Editor opens each PCB footprint associated with the part and extracts the pin count and pin numbers for
each footprint. The pin numbers and count from each footprint is compared to the pin numbers and count for the
Schematic Part. When all pin numbers and counts match, the following pop up message opens.  
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Pin Compare Successfully

Completed

If discrepancies are found, the pin numbers and counts for each part are documented in the Pin Compare Report,
as shown in the following figure.

Pin Compare Report

If a PCB Editor license is unavailable at the time, the Pin Compare Report informs you the system was unable to get
footprint pin data.

CIP Pin Compare Report w ith Unavailable Footprint Data

Note: Mechanical pins are excluded in the comparison.
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4.3.3  Launching Library Builder to Create Schematic Part and
PCB Footprint

You can launch Library Builder  from CIP to create Capture symbols and PCB footprints. This capability is available
when you configure Library Builder  in the CIP Client Settings while running Capture.  Creation of System Capture
symbol is not available when using OrCAD Library Builder.

To use this feature, open CIP from Capture. Then open a part that has a manufacturer PN and Datasheet link

associated to it. If Library Builder  is properly configured, the Symbol button  displays next to the manufacturer
PN's Datasheet link. 

Click the Symbol button  which opens a new pop up window. 

Click the Symbol Button

Select the checkboxes next to Create Symbol and/or Create Footprint depending on which you want to create. Then,
click the drop arrow and browse to a Capture .OLB library for archiving the new symbol.  

Select .OLB Library Name Location for New Symbol

Enter a new symbol name into the input field. If creating a footprint as well, select the path to the desired footprint
location. The paths/libraries list is read from the Capture user's CAPTURE.INI file. Then click the Launch Library
Builder button. Library Builder  opens.  Take the appropriate steps to create the new symbol and/or footprint. Create
and export each of the selected items.
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Enter New Symbol Name, then click Launch Library Builder

After you create and export your items, Library Builder  closes and the Schematic Part field populates with the
<SelectedLibraryName>\<NewSymbolName>. The PCB Footprint field populates with the footprint name of the
created footprint. The symbol is ready to be previewed and/or placed. 

Schematic Part has been populated and the symbol can now be previewed/placed.

Note: CIP may log you out when creation of a symbol or footprint takes too long. When this happens, you will need to
log into CIP to complete the part update with the symbol and footprint names. 

4.3.4  Previewing and Placing a Schematic Part

When you open CIP from OrCAD Capture, you can preview a part before placing or place directly onto a schematic.
You must have a schematic design and page opened in Capture before placing a part. The preview screen uses the
same theme as your settings for Capture CIS. 

Note: Preview of a part before placing is not available in System Capture. In System Capture, you are able to place a
formal part from the Component details page. Placing of TMP parts is not available from System Capture. Only 1
System Capture Part is allowed per part. The place button will place the symbol.

You may preview or place a part when the Preview   or Place buttons are available. These buttons additionally
appear in various views in OrCAD Capture.
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To place a schematic part, click the Place button to place the symbol on the active schematic page. You may preview

the symbol before placing it by selecting the Preview button . 

Examples of Click Part Preview Button

Selecting the Place button when there are multiple symbols (e.g. CAPACITORS\CAP, CAPACITORS\CAP_P...) will
automatically place the first symbol in the list. To place other symbols, preview the symbol first by clicking the
Preview button next to the Place button. The symbol preview window opens with a drop-down list of symbols. Select
the symbol from the drop-down list you wish to use as shown in the image below. Click the Place button to place the
part on the active schematic page. Properties defined in your configured DBC file will be included with the placed
part on the schematic page. If the Manufacturer and Manufacturer PN properties are configured for transfer to design,
the manufacturer part in the left most tab will be included with the placed part. To transfer a different manufacturer
part to the design, review section on Change Order of Manufacturer Parts.

Preview Alternate Parts using the dropdown

When you have more than one footprint for a part, by default the first footprint in the list is assigned to the part when

you click the Place button. If you want to assign a different footprint to the part, click the Preview
button to preview the Schematic Part. In the preview window, select the desired PCB Footprint
from the drop-down list as shown in the image below. Click the Place button to place onto active
schematic page.
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 Select Alternate Footprint for Part Before Placing

Your successfully placed symbol will contain your selected PCB footprint.

Part Placed Successfully

If the following error message opens when you click the Place button, open a schematic page and try to place
the part again. 
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Error when Active Schematic Not

Found

4.3.5  Previewing a PCB Footprint

When you open CIP from Capture you can view PCB Footprints from CIP.  To preview a PCB footprint, open CIP from
Capture. Open the desired part and click the Preview button to the right of the PCB Footprint field.  

Preview Footprint Button

When your part has more than one footprint, you can select the footprint you want to preview from a drop-down list. 
When you select the Preview button, the viewer configured in your CIP Settings will open the selected footprint.

Select Alternate Footprint to Preview

You will receive alerts if a footprint viewer is not configured or if you do not have [Allegro Footprint] configured in your
Capture.ini file.  See the CIP Client Installation Guide, topic "Updating the CAPTURE.INI File on a Local Client
Machine," for instructions that explain how to edit your Capture.ini file. 
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Preview PCB Footprint

4.3.6  Open CIP Part from a Schematic Page

You can open CIP and view a part from an open schematic design page. Open a part in CIP from the
schematic active page by right-clicking (RMB) inside an open schematic design page and
selecting More... > CIP: Open Part. This will open a CIP tab (named CIP: <PART_NUMBER>)
with the part number displayed. The tab shows a regular CIP page so you can perform the usual
CIP actions inside it, or you may close it.

Note: This feature requires OrCAD Capture and the CIP Client plugin. It is not available when using the System
Capture plugin.

Open Part in CIP from RMB on an Open Schematic Page
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CIP tab shows the part in CIP

4.3.7  Checking Availability of a Manufacturer Part

You can use CIP to search web distributors for the availability and pricing of the manufacturer part you are viewing.
To initiate this search, open the Component Information page and scroll down to the Manufacturer Part tab and click
the Check Availability button. 

The search is launched without impacting part information in your database. Anyone can conduct this search. 

The results of your search display in a separate browser window. 

4.3.8  Part History

CIP stores Component History, history of Component to Manufacturer parts, and Manufacturer Part History.  To view
the history of a part, click the History tab for either the company part or a manufacturer part.
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History for Part and Manufacturer Part

The history of a company part may be viewed from either the "Component History" or "Component to Manufacturer
History" tabs. As shown in the graphic figure that follows, historical changes for component history and manufacturer
part history are highlighted in yellow. The fields of a component table that are disabled from Track History (Admin >
Configuration > Component table) are excluded from the history view.  The graphic below, for example, shows the
exclusion of the fields: Implementation, Implementation Type, and PSpice Template. In this example, the Track
History property for these fields are disabled from the Admin > Configuration > CIP_Capacitor table. Properties
values that are modified are presented in yellow. 
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Component History

When the number of modifications are greater than 25 records, modifications are presented in multiple pages.  

Pages of Part History

The screen image shown below shows the history of associations of manufacturer parts to the component. This
history is accessed from the view of the company part's History > Component to Manufacturer History
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Component to Manufacturer History

The Manufacturer Part History may be viewed in the manufacturer part's History tab that is located next to the
Manufacturer Part Data tab.

Manufacturer Part History

4.3.9  Where Used

You can find out where a component or a manufacturer part is used by selecting Where Used on a component
page. 

Component Where Used

Parts that are associated to BOMs are identified in the Where Used tab of the part data of the Part Information Page.
As identified in the graphic below, the number of BOMs are shown in a blue circle. When you select the Where Used
tab, the list of BOM PART_NUMBERs containing the selected part, along with the Revision, Variant, Quantity (Total:
<TotalQuantity>), RefDes, and Description.. The Where Used tab only becomes visible when the part is associated
to a BOM. To go to a specific BOM-Revision-Variant, click on the PART_NUMBER link to the BOM.
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Manufacturer Part Where Used

Manufacturer parts that are associated to multiple component part numbers are identified in the Where Used tab
under the Manufacturer Data section of the Part Information Page. As shown in the graphic below, the number of
additional part numbers are shown in blue circle. When you select the Where Used tab, the list of part numbers
display. 

The Where Used tab only displays when the manufacturer part is associated with another part.
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4.4  Creating Reuse Modules

Reuse Modules enable you to save design and part information for reuse in a subsequent design. This reduces
work when a portion of a design is duplicated across multiple designs. Additionally, BOMs that are created for
designs that use the Reuse Modules feature, may include the Reuse Module's respective parts and labels. 

The following instructions describe how to create and place Reuse Modules.

To create a Reuse Module from the Component menu

1. Open the design you want to use from Capture CIS. 

2. With the design open, select the Components > Reuse Modules menu items.  

Select Reuse Modules

3. Click the Reuse Module > New button  to open a new blank Reuse Module creation
form. 

Open Blank Form

4. Enter information into the blank Reuse Module form. Required information includes a
minimum of Part Number and Revision. It is also recommended you enter a Description. 
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5. Click the Add button  to assign the part number you entered into the form to your new
reuse module. 

Assign Part_Number

6. To add the design and parts to your Reuse Module Part Number, in the Reuse Module Items section of your

screen, click the Create Reuse Module From Design  button.   

Create Reuse Module from Open

Design

The Reuse Module pop up dialog box opens.

7. Select the open design from which you want to create the Reuse Module. 

Your selection populates the Design file field. You must annotate your design to ensure there are no duplicate
reference designators before creating the Reuse Module in CIP. 

8. Select the library to add your reuse design symbol by using the Select Library drop-arrow
and browse to select a library location.  

Select Your Source Design

9. Select the Add BOM_IGNORE=TRUE property to Reuse module checkbox if you want to add the property
BOM_IGNORE=TRUE to the created Reuse Module. CIS Part Manager excludes Reuse Modules that have the
property BOM_IGNORE=TRUE.  

10.  Click the Generate Part button to create your new Reuse Module. 

To Place a Reuse Module
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You can place your Reuse Module into an open design by clicking the Place button  that is available from the
Component > Reuse Module page.  This feature is only available when you open CIP from Capture CIS.  

Place Reuse Module

When you are finished placing, press the Esc key on your keyboard to stop placement. 

Place Your Reuse Module into Your Schematic Design

When you have multiple reuse modules and click the Place button  the first item in the list attaches to your

cursor for design placement. If you want to select an alternate reuse design, click the Preview button  and
choose the module you want to place from the REUSE_MODULE drop list as shown in the example below.
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Preview and Select an Alternate Reuse Module for Placement

4.5  CIS DB Search

Searching for parts from CIP can be done through the CIS DB Search menu or a keyword search. 

In CIS DB Search there are three types of part searches you can conduct:  

§ Search
§ Part Type
§ History Search

Each search type is accessible through a tab. The Search tab allows users to conduct a search that is based on
criteria they define.  The Part Type tab uses the same Part Type tree structure as the Capture CIS Explorer window.
The History Search tab allows users to conduct a search by the date parts were added, deleted or modified.

When performing the search from Capture, the preview and place buttons are located next to each part number
included in the search results.

Note: Preview and place buttons are not available in search results when CIP is opened in System Capture.
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CIS DB Search

4.5.1  Keyword Search

The quick/keyword search is available along the top bar. Regardless of what screen you are in you can type a string
into the Search input field and click the GO button. CIP returns the results parts that best match any part of or the
entire string. This functionality allows you to enter parametric data into the search string that may not be in an exact
order in your database. Top 100 matches will appear in the search results. Exact part number search will only return
one result.

Keyword Search in the Top Bar in CIP

If you prefer the original search functionality, you may disable full search from the Admin > Configuration.  When full
text search is disabled, the quick/keyword search queries the PART_NUMBER, Part Type, Description, Value, PCB
Footprint, and Schematic Part fields to match the search string entered by the user.
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4.5.2  Defining Search Criteria

The CIS DB Search tab enables you to perform simple searches (such as specifying that a field contains data that
meets certain criteria). You can also perform complex searches by adding parenthesis. This enables you to be more
specific regarding the criteria of the search. 

Search results display in the lower left Search Results area. Search results are displayed 500 at a time. You can
cycle through the pages of results using the buttons at the top and bottom of the search results area.

Start by selecting the Component View from the drop-down list, which controls which views will be searched.

Component View Selection

The Component View selections consist of the following:

1. All - Searches across All Component Views you've configured (Capacitors, Connectors,
etc.), as well as BOMs and Reuse Modules.

2. All Components - Searches across All Component Views you've configured, excluding 
BOMs and Reuse Modules.

3. Select <Component View> - Searches across a specific Component View you've
configured.

4. BOMs - Searches across your BOMs.

5. Reuse Modules - Searches across your Reuse Modules.

For the simple search single level logic, criteria can be expanded using the Add Row button.     Thus
you can add multiple search criteria. 
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Search Criteria and Results

You can conduct a complex search using as many levels of logic as you need to find a specific part. You can add
parentheses to specify the behavior and search order of operations in your search. The figure below provides an
example. In this example, you remember a partial part number, the value, and that it is one of two sizes. You can
specify a query where all parts that meet this criteria are displayed. 
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Controlling Search Order and Behavior

See section topic, Previewing and Placing a Schematic Part to place a part retrieved from your search. 

Only configured views are available in the Search Pull-down list. You may select an individual view or "All" views. This
method of searching helps when you search for a specific part type, such as a capacitor or a resistor. Selecting one
of the parts in the Search Results area opens the parametric data for that part in a separate form.
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Selected Part from Search Results

4.5.3  Including Additional Fields in Search Results

If you check the option, Include Additional Fields in Search Results, you are able to specify additional search fields
from the pull-down menu. This helps you obtain data from other fields  whether data populates the field.

Include Additional Fields in Search

To include additional fields in your search results

1. Check the checkbox Include Additional Fields in Search Results and click the field drop
arrow. See the image above where green highlighting outlines  this checkbox. 

The pop up selection list that opens is organized by the groups: Component/BOM; Manufacturer; Distributor;
and Where Used.  
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Pop Up Selection List of Additional Fields

2. Use your left mouse to select the additional field you want to include. Your selection populates
the field input.

3. If desired you may click the Add  or Remove  button to add or remove an additional field
included with your search results. 

4. Click the Search button   to execute your search. 

Results  are returned in the Search Results area that is located in the lower part of the screen. You can be re-
order your search results by clicking a field name at the top of a field column.  Click the field name again to
toggle the column order between ascending and descending order.

Note: When you select either the BOM, Reuse, or Mechanical Assembly field from the Where Used category, a
comma separated list of the corresponding items is included in the search results.
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Search Results Including Additional Fields

The above image shows an example of search results retrieved when additional fields were included in the
search. This image shows the PCB Footprint and Schematic Part fields that were selected from the Add
Additional Fields selection menu.  

If desired, you may save the search criteria. 

4.5.4  Viewing Last Search

When you view the details of your search results, you can easily return to your last search by clicking the last search
link. 

Last Search Link in Search Results

4.5.5  Smart Value Search

The Value field used in Capture can represent the part number or an actual value of a discrete component. When
you search for values in discrete components views (i.e. capacitors, resistors, inductors and crystals and

oscillators), you can conduct a search using numeric comparison operators that include the following: 

§ Equals (=)
§ Does Not Equal (!=)
§ Greater Than (>)
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§ Greater Than or Equal (>=) 
§ Less Than (<)
§ Less Than or Equal (<=)

Note: If you do not see these options, consult your database administrator about installing the Smart Value CLR
option to the database. The Smart Value CLR feature is not supported by AWS RDS server. If your database is
installed on AWS RDS, this functionality will not work.

Defining Numeric Criteria to Filter Search Results

When using one of these criteria, the search algorithm automatically applies the following SI units:

p pico

n nano

u micro

m milli

K Kilo

M Mega

When a numeric comparison Operator (<, <=, >, >=) is selected when searching other
Parametric FIelds, CIP will automatically attempt to convert the selected Parametric Fields
to float/number type when performing the search.

4.5.6  Exporting Part Data to Excel

Once you locate a desired part you can export the part record data to an Excel or CSV formatted file. For each format,
you can select to have the Field names appear on the top or on the left, depending on how you want to use the
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exported data. For example, if you choose the Export button    and select Excel - Left Headers, the resulting
Excel formatting has the Field Headers in the left column as shown in the following figure. Relevant data values 
appear in the cells to the right of the field headers.

Note: Export functionality is not available when using the System Capture plugin.

Export Part Data to Excel

4.5.7  Exporting Search Results

If desired, the Search Results can also be exported to an Excel or CSV formatted file. For Excel format, select the
checkbox labeled For Excel. A sample is shown below.

Note: Export functionality is not available when using the System Capture plugin.
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Export Search Results to Excel

4.5.8  Using the History Search

Using the History Search feature enables you to specify a date range to determine which parts have been added,
modified, or deleted, and by whom. History search may be performed across component views or on manufacturer
parts. 

Component History Search

The component History Search searches only the data across the component views and displays the component
part number and description of parts that meet the specified criteria. To search for a component history, select the
Component before specifying your date range and action criteria. Changes to Manufacturer parts associated to a
component are excluded from the search.  
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Search by History and Date Range

Manufacturer History Search

The Manufacturer History Search searches the data in the manufacturer parts and displays the manufacturer and
manufacturer part number along with component information. To conduct a Manufacturer History Search, select the
Manufacturer before you specify your date range and action criteria. 

Search by History and Date Range For Manufacturer

Export History Search Results

The list of parts shown in the search results may be export to CSV or Export by clicking the Export  button and
selecting the option for your export.

Note: Export functionality is not available when using the System Capture plugin.



Product Version 25.1.22 for 25.1, 24.1, 23.1

Using CIP 199

September 2025

4.5.9  Saving Search Criteria

Search criteria can be saved for later use. The criteria and field settings you can save can be specified as either
personal or global search criteria. Personal search criteria are only available to the user that saved the search.
Global searches can be used by all users. You must first define a search before you can save it. After you defined a
search, enter a name to save the search with and click the Save button. If you need to change the criteria of a saved
search, you can change the search definition and click the Save button again. 

Saving Search Criteria

To save a personal search, enter the desired search name and click Save.  To save a global search, enter the
desired search name, select the Global checkbox, and click Save.

Save Global Search (Uncheck to Save Personal Search)
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*NOTE: Users without permission to create Global searches see a grayed-out Global checkbox that is unavailable.

Save Searches for User Without Global Save Permissions

After saving a search, a pop-up window confirms that your "Search Saved Successfully."  Click the X button to close
the window.

Search Saved Successfully (Click X to Close)

To select a previously defined search, select the name of the saved search from the pull-down window.  The
searches are grouped by Global and Personal searches.

Note: If the display name of the Saved Search changes, update the template.

Selecting a Saved Search

If you want to have CIS DB Search select a specific saved search when you navigate to the CIS DB Search page,
after selecting the saved search, click the Set button under Default Search.
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Setting a Search as Default

If a search is no longer needed as your default, you can clear the default.

Clearing a Default Search

If a search is no longer required, you can delete the search from your list by first bringing it up and then clicking the
Delete button.

Deleting a Saved Search

Global Saved searches can only be deleted by users with permissions to create global searches. Users without
appropriate permission can open the search but are unable to delete it.    

Global Delete Not Available w ithout Permissions

To clear the search criteria after it is defined, click the Clear button.
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Clearing Search Criteria

4.5.10  Using Part Type Search

The Part Type tab within CIS DB Search enables users to find and view parts by Configured Views and Part Type. 
This method is similar to the CIS Explorer window in Capture CIS.  Click the plus sign  to expand levels.  Similarly,
click the minus sign  to collapse levels.

Part Type Search
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4.6  Distributor Search

The Distributor Search menu item enables users to directly search for parts from DigiKey, Newark, Future, Mouser,
and Arrow. Knowing these parts are immediately available can significantly reduce lag times and produce shorter
time-to-market. 

You can use the Distributor Search menu item to do the following:

1. Search for availability and cost of parts

2. Create a TMP part with the distributor part number 

3. Update and existing part with the distributor part number

4.6.1  Searching for a Distributor Part

After you open the Distributor Search tab, you can select distributor(s) that will be used to conduct the search. You
can search for: DigiKey, Newark, Future, Mouser, or Arrow. (Note: If your country is set differently from the base
product, the Newark distributor may appear as Premier or Farnell, depending on the country). The Search Type
allows you to conduct a search that is based on a Keyword or Manufacturer Part Number.  When you select Search
Type, only Distributors that support the search type are enabled for selection. 

Note: The Arrow and Future search only supports search strings that are entered for a manufacturer part number.
The "Arrow" and "Future" selection check box is unavailable for a keyword search. 

You may select additional Options to narrow your search results. Once all search parameters are specified, click the
Search button. You may search in one or more distributor databases. When searching across multiple distributors,
the results are limited to 25 records from each distributor.

Note: Different search algorithms used by each distributor site may result in different search results.  Please keep
this in mind when performing searches and viewing results, especially when searching across multiple
distributors. 

Select Distributor(s)



Product Version 25.1.22 for 25.1, 24.1, 23.1September 2025

CIP User Guide204

4.6.1.1  By Manufacturer Part Number

You can search by Manufacturer Part Number by selecting the drop-down option from the Search Type list. You can
search multiple distributors at the same time. Enter the Manufacturer Part Number and click the Search button to
obtain results.

Search Multiple Distributors by Manufacturer Part Number

Note: The search algorithm for each distributor site is controlled by the distributor. Future may not return search

results when you enter a string that contains a comma. 

4.6.1.2  By Keyword

You may also perform a keyword search by distributor by selecting Keyword from the Search Type drop-list. 

Keyword Search

To simultaneously search for parts from multiple distributors, type a keyword into the Search Text field and click the
Search button. Search results display in the lower part of the page. The "Arrow" and "Future" selections check boxes
are unavailable for keyword searches.

"In Stock", "RoHS Compliant" and "Lead Free" filter options are available when you select either DigiKey, Mouser, or
Newark using Keyword Search.
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Digi-Key Keyword Search

Mouser Keyword Search

Newark Keyword Search

4.6.1.3  Search Results and Part Detail

The results returned from a distributor search may be extensive since the search queries the distributor’s database
of parts to match the requested criteria. The fields returned in the search results are: Distributor (DigiKey, Newark,
Future, Mouser, or Arrow), Distributor PN, Manufacturer, Manufacturer PN, Description, Category, Quantity On Hand,
and (Unit) Price. To determine the complete price breakpoint of a part, you need to select the part and view its Part
Detail page.
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Search results may be re-ordered by clicking a column heading (Distributor, Distributor PN, etc.). The order of the
displayed results can be re-sorted by the column selected. Re-selecting the same column reverses the order of
displayed results.

Note: The search algorithm for each distributor site is controlled by the distributor. Consequently, each distributor
search responds differently to the search string provided. The Manufacturer Name may be inconsistent across all
distributors. 

Sample Distributor Search Results

Moving the mouse pointer over a part that is listed in the search results highlights the part. Highlight and click a part
to show Distributor Part Data, Attributes and an image of the actual part (if available). Each distributor provides
attribute data in its own format.

Sample Part Data and Attributes
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4.6.1.4  Warnings and Errors

Changes to distributor APIs or part data may show warnings that result from distributor searches. Sample errors are
shown in this section.

Bad Request: Bad time window

Cause: When the CIP web application server time is more than 5 minutes off from the actual time for the time zone
of the server, Digikey search will respond with the message of bad time window. 

Solution: To fix the problem ensure that the time on the CIP web application server is set correctly. You may need to
contact your IT administrator to fix get this resolved. 

Could not establish secure channel for SSL/TLS with authority 'www.newark.com'

Cause: The cipher suites used by the Newark API are unsupported by Windows Server 2012 R2/Windows 8.1. CIP
web application server installed on one of these operating systems can no longer use Newark's distributor search.

Solution: Migrate CIP web application server to different Windows Server.

Server was unable to process request. ---> Error!!!

http://www.newark.com
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Cause: When search string is fewer characters than expected by the Mouser distributor or entered in a way that is
not acceptable. Mouser server results an error.  

Solution: To fix, change you search string.

4.6.2  Creating a New TMP Part and Distributor Part

The CIP Distributor Search is an efficient way to add valid, orderable parts to your database. You may add one
distributor part from the distributor search page. To add multiple distributor parts, however, you need to open the
component page.  When adding a part while using the Client plugin, you may preview and download ECAD Models
from Ultra Librarian.

To create and add a TMP part to your database

1. Complete a Distributor Search and select the part you want to add to your database.

Double-click the desired row to select and open Part Data from search results

The Part Data information opens after you select a component for viewing.  

2. When Ultra Librarian download is enabled and CIP is opened in Capture, you will need to log in before you
can preview or download ECAD models. If you don't have an account, you can register by selecting the Click



Product Version 25.1.22 for 25.1, 24.1, 23.1

Using CIP 209

September 2025

here link. The Ultra Librarian information is not shown when CIP is open from a standard browser or when
Ultra Librarian download is disabled.

3. If you are logged in, availability of ECAD models from Ultra Librarian shows. When an exact
match is available, the part number and Preview button shows. When an exact match is not
available, a list of close match parts are shown. You may review and select close match
parts to select a model to use with your TMP part.

4. Click the Preview button to review the ECAD Models for the part identified. Click Cancel to
close the preview.
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5. Choose an appropriate Component View to add the TMP part. The example that follows
shows the selection of the Component View: Inductors. 

6. You have the option to create or update a TMP part. To add a TMP part, leave the value for
the Action field shown in the previous image as Create TMP Part.  This is the default
action.  

7. If you have a Schematic Part symbol and PCB Footprint available, you may map to a
Schematic Part and PCB Footprint before your TMP is created. The process for mapping a
Schematic Part and PCB Footprint is the same. 

· Choose the Current radio option to select an existing Schematic Part from the pick list.  
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· Choose Ultra Librarian radio option to download and use the Schematic Symbol and/or
PCB footprint corresponding to the selected part from Ultra Librarian. (This option is
shown only when Download of Ultra Librarian models option is enabled and you are using
the CIP client inside Capture.) You will need to specify a local download location if no
common directory has been configured.

· Or choose the New radio option and enter a new Schematic Part name into the field. 

Select an Existing Schematic Part

Select Ultra Librarian to download Symbol and Footprint from Ultra Librarian

Or Enter New Schematic Part Name

If you want to change the property mapping from the suggested built in mapping, or if you want to map a
Distributor property to more than one CIP property, you may change the mapping configuration before creating

your TMP part.  

8. To map a distributor property, select a CIP field from one of the Property drop down lists in
the corresponding mapping column. 
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The example below shows the distributor property "Description" being mapped to the CIP
property, "Part Type" that is available from the drop-list menu.

Example of Mapping Distributor Property "Description" to "Part Type"

To map multiple CIP properties to a distributor property, you can select the additional property from the

Property drop list and click the "+" button.   Your selection is then listed below the property selection field.

To delete a property mapping, click the Delete button  that is adjacent to that property.  

Note:  You can only map to CIP fields that your Admin has granted you permission to edit. For example, if your
Admin has not granted you permission to edit the Description field, you will not find the Description field. 
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5. After you complete your mapping, click the Add button  to generate the new TMP Part.
When adding a manufacturer part that matches a part already in the CIP database, a warning
will appear with additionally options. If the creation with the selected manufacturer part is in
error, click Cancel. An error may display in System Capture when attempting to download
models from Ultra Librarian.

Note: The Add button  is only visible after your Admin grants you the "Add TMP Parts”
permission.

Once the new part is created, the TMP-XX part number is added in the PART_NUMBER field, along with the
other parametric data for the new part. 

During the transfer of distributor data to CIP part data, CIP converts or removes the following
symbols/characters from distributor values before transferring data to the CIP database. 

· - This Greek letter is converted to "u"

· - This Greek letter is converted to "Ohm"

· ± - This character is removed

· ° - This character is removed

· ~ - This character is removed

· Spaces in the value and tolerance fields for Capacitors, Resistors, and Inductors are
automatically removed from the distributor property values during transfer to the CIP
database. 
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TMP Part Created

Manufacturer Part Already Exists

When you add an existing manufacturer part, whether to a new or existing part, the prompt shown in the image
below appears. This prompt allows you to Update/Overwrite the Distributor Data, Update/Overwrite Distributor
Data and Common Manufacturer Data, or Cancel the operation. The prompt identifies which fields will be

updated when you click the Overwrite button. If the Manufacturer Part Already Exists dialog box
opens, select the radio option that indicates the fields you want to overwrite and then click the
Overwrite button to complete your action. If you selected a duplicate manufacturer part by
accident, select Cancel.
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Update/Overwrite Prompt - Distributor Data

TMP Part Creation Error in System Capture

When Ultra Librarian download is enabled but the common download location is not fully configured, an error
generates during creation a TMP part with the Ultra Librarian option.

4.6.3  Adding a Distributor Part to an Existing TMP or Formal
Part

In addition to having the ability to create new TMP parts, the CIP Distributor Search also allows you to add distributor
and manufacturer data to an existing TMP or formal part. You also have the option to update part data when adding to
an existing part. Updating part data overwrites your changes as well. To add multiple distributor parts, you will need
to open the component page.

The Add to Existing Part feature allows (specified) users to:

· Add New Manufacturer Parts, including Distributor Data (Dist. PN, Cost, Quantity), to Existing
TMP or Formal Parts

· Update/Overwrite Distributor Data (Dist. PN, Cost, Quantity) of a Manufacturer Part that is
associated with an Existing TMP or Formal Part

· Update/Overwrite Distributor Data (Dist. PN, Cost, Quantity) and Common Manufacturer Data
(Datasheet, RoHS Compliant, Image) of a Manufacturer Part that is associated with an
Existing TMP or Formal Part

· Update/Overwrite Part Data 
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To add or update distributor and manufacturer data of an existing TMP or formal part

1. Complete a Distributor Search. Select the part you want to add to your database and select
the Component View for the part. The display updates showing options and a mapping
column. 

 

2. Select the Action, Add to Existing Part, from the drop menu. 

Mapping of Schematic Part and PCB Footprint options are unavailable for Add to Existing
Part. See example in figure below.

Select a Component View

3. Select a Part Number of an existing TMP or formal part from the drop list. The part number
you select will be used to merge your selection with the part you selected from the search
results.  If you do have permission to update formal parts, the list of part number for update includes only TMP
parts. 

4. You have the option to overwrite existing component data. If you want to overwrite component data, you may
update the distributor property mapping before adding your changes. To update existing component data,
place a check in the checkbox for Overwrite Component Data. If you do not want to change the component
data, leave the checkbox blank.

5. Click the Add button.    When adding a manufacturer part that matches a part already in
the CIP database, a warning will appear with additionally options. Review options for adding a
manufacturer part that already exists to complete your action.
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Note: The Add button is only visible to users who are granted permission to “Add TMP Parts”.

6. After completion, the part information appears with your updates.

4.7  Ultra Librarian ECAD Model Download

ECAD Models may be downloaded from Ultra Librarian when enabled in CIP Admin. This setting is enabled by
default and may be disabled by an Admin. 

ECAD model download locations may be configured for a common directory. When no common directory is
configured, each user may specify local directories when the models are downloaded. 

Models may be downloaded when creating a TMP part from Distributor Search or from viewing a component. When
an exact match is not found, close matches will be proposed for your review. Only the selected model will be
downloaded. 

You must have a valid Ultra Librarian account and be logged to preview, download or request models. You may enter

your Ultra Librarian username by clicking the [Manage Account] link at the upper right hand corner of
the CIP page.

 

Selecting ECAD Models for Close Match Parts

1. While selecting a part in Distributor Search to create as a TMP part, you may see that an
exact match of the your part number was not found. However, several close match parts
were found that have ECAD models from Ultra Librarian. 

2. You should review models for each part to determine if any of the ECAD models for the close
match part can be used. Select the Preview button for each. If you see that the model can be
used, click the Select button.
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3. The selected model will be downloaded when you create your TMP part. To select a different
model, select the Clear Selection button

4. All close match parts show again after you clear selection. No models can be downloaded
when no selection are made.

5. Click Preview and click Select to select the part you want to download. Click Cancel to
preview and select a different part.
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6. After you select a part and select the Ultra Librarian option for Schematic Part and PCB
Footprint, click Add to add the TMP part and download the model for the selected part. 

7. If common libraries are configured in CIP, the models will be downloaded automatically and
the Schematic Part and PCB Footprint will show in the created TMP part. Additionally, the
directory for symbol and footprint in the common library configuration, if not already in your
Capture.ini, will be inserted into the Capture.ini file to enable preview of the downloaded part. If
common libraries are not configured, you will need to select local directories for download.

Selecting Local Directories

1. After selecting Add with the Ultra Librarian option selected, and no common libraries are
configured, a dialog will appear with options for download. This shows each time you
download models.
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2. Enter the directory paths for each type of ECAD models that will be downloaded. The list in
the drop-down list for Capture Symbol(OLB) directory and Footprint Symbol directory are
directories from your Capture.ini file.

4. Select the radio button for Single OLB File if you want all symbol to go into the same OLB
file. You required to enter the OLB file name with this selection.

5. Configure options for the handling of models that have the same name. Symbols are
generally named with the Manufacturer Part Number. When a part is downloaded from 2
different manufacturers, the symbol name may be the same. When you download models
that have the same part number or downloaded footprint, padstack or step files name are the
same, the configured rule will be applied. 

a. Overwrite - Schematic symbol names, footprint, pad or step filenames found in the
configured location will be overwritten with the same name.

b. Skip - Schematic symbol names, footprint, pad or step filenames found in the configured
location will be preserved.

c. Append Number - Schematic symbol names, footprint, pad or step filenames found in the
configured location will be saved to a new name with _1, _2, etc appended.

6. Click Download to complete your directory options and start the download process.

7. The part is updated with the model names.

4.8  Temp. Parts

The Temp. Parts page helps you manage temporary parts (TMP-XX parts). Select the Temp. Parts menu to open all
the temporary parts created and not processed yet.  Users can optionally display processed Temp Parts as well. 
(Refer to Including Assigned Parts).

Creating and Viewing Temp Parts

Temp Parts can be created using several methods.

· Using the Distributor Search feature as described in the previous section.
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· Using the New > Add as TMP feature to create a new Temp Part.

· Using the Copy > Copy as TMP feature to create a new Temp Part from an existing Formal or
Temp Part.

· Deriving a database part in Capture CIS, from the Schematic Design or CIS Explorer window.
 Refer to the OrCAD Capture CIS User Guide for additional information.

Regardless of the creation method used, the Temp Part created is automatically assigned the next available
temporary part number (in the form of TMP-XX). This number will be reflected on the Temp. Parts list. Additionally,
CIS users are able to view and place the Temp Parts on their schematic designs.  Once they are converted to formal
parts, CIS users can update their schematics using the Part Manager. 

Note: Preview and place buttons are not available in Temp Parts page when CIP is opened in System
Capture.

Temp. Parts List 

CIP allows users to display additional parametric fields in the Temp. Parts list.  Display fields are stored on a per-
user basis, since different users may wish to see different fields in their Temp. Part list.

To customize the user display of parametric fields in the Temp. Part list

1. Open the Temp. Parts > Configure Display tab.

2. Click a parametric field(s) listed in the left column to add it to the display fields on the right.
Fields listed in the right column will be included in the Temp. Parts View. 

3. Click the Trash button to the right of a fields in the right column to remove it from the list of
included display fields.  



Product Version 25.1.22 for 25.1, 24.1, 23.1September 2025

CIP User Guide222

4. Re-order fields, if desired, by clicking and dragging any item up or down the list. 

5. Click Save and the Temp. Parts list updates the field list and associated data. 

Temp. Parts - Configure Display - Add PCB Footprint, Schematic Part, Value, and Tolerance

Temp Parts List – Additional Fields

Assigning a Temp Part to an Existing Part
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If a Temp Part was generated in error and you find that a it is a duplicate of an existing part, the Temp Part can be
assigned to the existing part by selecting the part to be assigned and clicking on the Assign to Part button. The Temp
Part information will be removed and only the existing part information will be retained.

Assign Temp. Part to an Existing Part

Changing a Temp Part to a Formal Part

For Temp Parts that are valid and should be added to the database formally, the Temp Part number will need to be

changed. Changing a Temp Part number to a formal part number can be done by selecting the Edit button 
inside the Part Information page. Part updates are reflected in both CIP and CIS, as they share a common parts
database.

Edit Temp Part
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Manually input the desired PART_NUMBER or click the auto-generate button  to pull the next available number
for the current part's View (Inductors in this case).  Update any additional fields, if desired.  Click the Save button

 to save the change(s).  The TMP-XX part is now a formal part.

Manually Input or Auto-Generate Formal PN, then Save

Formal Part Number

Including Assigned Parts

Converted Temp Parts may not be shown in the Temp Parts list if you aren't displaying Assigned Parts.  To view
Assigned Parts, click the Include Assigned Parts checkbox.  This option allows users to view converted Temp Parts
that are now Formal Parts. When a Part Number is assigned to a TMP part, a change to the Part Number of the
Original TMP Number is also updated.

*Note: This setting is stored on a per-user basis.
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Unchecked Include Assigned Parts - IND-00000001 (Formerly TMP-32) Not Shown
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Checked Include Assigned Parts - IND-00000001 (Formerly TMP-32) Shown

4.9  Compliance

Compliance Information Powered by Silicon Expert provides up-to-date compliance information for parts. The
information provided includes such information as inventory risk, life cycle risk, and conflict mineral status. To
access Compliance, click Compliance from the CIP menu bar.

Access to Compliance Information Powered by Silicon Expert

You will be able to do the following from the Compliance page:

· Enable Compliance Module by loading Compliance License and Silicon Expert API
credentials.

Note: This is required before you can use the Compliance module features.
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· Search Silicon Expert database of parts to add CIP TMP parts or update existing CIP parts
based on your search.

· Sync compliance data (on-demand or scheduled sync) for existing Silicon Expert parts in
CIP.

· View compliance summary of parts in CIP.

4.9.1  Enable Compliance Module

A Compliance Module License and Silicon Expert API Account are required to use the Compliance features in CIP.
If the following SiliconExpert landing page appears and you do not already have the aforementioned license or
account, click Learn More to learn more about Compliance Information Powered by Silicon Expert, or click Start Your
Free Trial to request a Compliance Module license and Silicon Expert evaluation account.

Note: If the links do not appear, be sure that you are connected to the internet and are not blocking any required
pages. Refer to the CIP Install Guide for more information regarding white-listing URLs for the CIP web application.

Learn More or Start Free Trial for a Silicon Expert Account

Once you have a Compliance Module License and Silicon Expert API Account, you can click the Configuration 
button located in the upper-right corner of the Compliance page and update your info in the Compliance
Configuration window.

1. Click the Choose File button. Navigate to your CIP Compliance License .TXT file that was
provided to you. Select the license file, then click Open. The license fields (Version,
Licensed To, Expiration, Status/Expiration) will be updated.

2. Enter your Silicon Expert API account credentials. Optionally, click the End User License
Agreement link to view the Silicon Expert API usage license agreement.

3. Click Update to verify your Compliance License and Silicon Expert credentials.
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a. If your CIP Compliance License is invalid or has expired, the Status will indicate such
and you'll need to select a valid license. You'll also need to re-enter your Silicon Expert API
account credentials if they were not already saved.

b. If your Silicon Expert API account is invalid or has expired, the SiliconExpert page will
remain on the initial landing page, regardless whether your CIP Compliance License is
valid or not.
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Initial Compliance Configuration Expired CIP Compliance License

Valid Compliance License, Entered SE

Credentials

4. After verifying your Compliance License, the Compliance Configuration window will close.

a. If your Silicon Expert API account is also valid, the Silicon Expert Search page will be
shown and you can begin using it.
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b. If your Silicon Expert API account is invalid or has expired, the Silicon Expert landing
page will be shown and you won't be able to use the Compliance module until you enter
valid credentials.

Note: If Silicon Expert adds new API fields (that your CIP version already supports) after your account was created,
you may need to request that Silicon Expert refreshes your API account so the new fields are available in CIP. In such

cases, you will also need to click the Configuration  button and log in again. 

4.9.2  Search

User controls within the Search tab, enable you to:

1. Search for parts by Keyword, or Manufacturer Part Number. 

2. Examine part details.

3. Save the Manufacturer PN with Silicon Expert Compliance Info to a New TMP Part or Add to
Existing Part. 

Search

To initiate a search, click the Search Type drop-list and select an option. Enter a search term in the Search Text
field and click the Search button.

Silicon Expert Search Type Drop Menu

The number of parts for which you can retrieve compliance information is determined by the terms of your Silicon
Expert API subscription. To determine how many parts you have remaining, refer to the account information section
in the upper right corner of the Silicon Expert window. The number of "Parts Used" identifies the number of parts for
which you have viewed part detail information. The parts listed in the Search Results tab (shown below) do not affect
the number of parts used. Each time you select a new part to view, that part is added to the parts used count. The
screen image below highlights this tally in the upper-right corner of the screen.

Note: Resilience Rating is returned in the Search Results page if your SE API Subscription allows it. It is subject to
change at the sole discretion of Silicon Expert. The column will be displayed either way, since CIP does not know if
your subscription includes Resilience Rating as part of the Search Results.
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Silicon Expert Account Expiration, Parts Used/Total, With Resilience Rating Values

Silicon Expert Account Expiration, Parts Used/Total, Without Resilience Rating Values

Examine Part Detail

Once you find a part you want to view from the Search Results tab, you may click it to display the Part Detail tab.
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                       Click Part from Search Results to Open Part Details

The field data in the Silicon Expert Part Detail tab is presented in the sections below. The exact Properties/Fields will
vary per specific Manufacturer PN and your company's CIP Compliance Module or Silicon Expert API subscription.

§ Key Risk Data - This section includes a part's key risk data to help quickly decide if you want
to add a part to CIP.

§ Lifecycle, Risk, and Replacement Data - This section includes a part's lifecycle (status,
grade, EOL info, etc.), risk, replacement (sources, reason, grade, etc.), counterfeit, and PCN
(date, type, source, EOL info, etc.) data.

§ Summary and Manufacturing Data - This section includes a part's summary
(AEC/automotive, military spec, datasheet, taxonomy, etc.), product image, and
manufacturing (MSL, finish/plating, reflow, etc.) data.

§ Compliance, Environmental, and Regulatory Data - This section includes a part's
compliance/environmental  (Reach, China RoHS, RoHS, WEEE, chemicals, conflict
minerals, etc.) and qualification (agency, CECC, energy, ESD, ESCC, reliability, etc.) data.

§ Package Data - This section includes a part's packaging (body/case, dimensions,
description, pin count, etc.) data.

§ Attributes - This section contains all part fields that are not included in one of the field groups
above.

The following Silicon Expert fields will have colored text based on their specific values as shown below. Field values
not matching those below will be shown in black, which is the default. These text colors will appear when viewing the
Part Detail page of the Silicon Expert search, as well as when viewing the Manufacturer PN in CIP.
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Silicon Expert Field Colors

Below is an example from a CIP Manufacturer PN containing some of the values that use colored text. In this
example, the Manufacturer PN fields have also been configured into groups and reordered using Reorder View

Fields.

CIP Manufacturer PN with Silicon Expert Field Value Colors

When Ultra Librarian download is enabled, you will need to log in before you can preview or download ECAD
models. If you don't have an account, you can register by selecting the Click here link. The Ultra Librarian
information is not shown when CIP is open from a standard browser. Ultra Librarian models may be downloaded
along with the creation of a TMP part the same way as creating a New TMP Part from Distributor Search.

Compliance information may be transferred to the CIP database by adding the information to New TMP Part or
Existing TMP or Formal Part. To add compliance data, first select a Component View.
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Select a Component View

Create TMP Part

Options available when adding a Temp Part from the Compliance page are similar to those presented when
creating a new TMP Part from Distributor Search. To add compliance information to a New Temp Part, use the Action
Create TMP Part. Then click the Add button. All Silicon Expert properties mapped to CIP fields are transferred to the
configured CIP part.

Action: Create TMP Part  
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When you select a Component View for your new TMP part, a Mapping column appears between the Silicon Expert
Property and Value columns of each field group/section. The Mapping column is shown in the image below. After
you review the SE properties associated with your new TMP part, you may select a CIP field to map to a given SE
Property to transfer its Value during TMP part creation. Each time you select a new CIP field to be mapped, you must

click the Add button  to apply the mapping. You can delete a property mapping by clicking the Delete button 

 located to the right of the CIP field name in the Mapping column.

Note:  After a CIP field is mapped to an SE Property, it is removed from the drop-down list shown in the Mapping
column. Each property has its own drop-down list that lists all CIP fields that are available to be mapped. A CIP field
can only be mapped to one SE Property, but you may map the same SE Property to multiple CIP fields.

Mapping Column Becomes Visible After the Component View is Selected

Note:  You are only able to map CIP fields that your CIP Admin has granted you permission to edit. For example, if
your Admin has not granted you permission to edit the Description field, you will not be able to map it to an SE Field..

Add to Existing Part

Options available when adding to an Existing Part (Formal or TMP) from the Compliance page are similar to those
presented when Adding a Distributor Part to an Existing TMP or Formal Part. To add compliance information to an
Existing TMP or Formal Part, select the Action Add to Existing Part. You have the option to overwrite existing
component data. If you want to overwrite component data, you may update the distributor property mapping before
adding your changes. To update existing component data, place a check in the checkbox for Overwrite Component
Data. If you do not want to change the component data, leave the checkbox blank. Click the Add button to transfer the
compliance information to the existing part.

Action: Add to Existing Part
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4.9.3  Sync

The Sync tab may be used to manually sync compliance data or enable a recurring scheduled sync. The Sync tab is
available to users with the permission to Sync Compliance data. All valid part numbers will be synchronized. 

To manually synchronize compliance data, click the Sync button.

To schedule automatic synchronization, select the Enable checkbox, then enter how often (in number of days) you
want to synchronize compliance data in the Every x Days field, and select a Start Time for when you would like to
start synchronization. Click Save to save your scheduled synchronization.

To disable automatic synchronization, uncheck Enable and click Save.

4.9.4  Summary

The Compliance Summary tab provides a summary risk analysis of parts in your CIP database or by part in an
imported BOM. Charts in the Compliance Summary enable you to review risk by type and quantity of parts that need
research. Select the Compliance Summary tab to view risk information across all parts in CIP.



Product Version 25.1.22 for 25.1, 24.1, 23.1

Using CIP 237

September 2025

Compliance Summary w ith Risk Information for All Parts

To view the summary chart corresponding to a specific BOM, select the BOM using the pull-down. Then select the
Revision and Variant and click GO.

Click on a segment of a given pie chart to view its list of corresponding parts for the selected BOM-Revision-Variant.

The Compliance Details window will appear, showing the following information:
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1) Filter: This defaults to the value of the pie segment that was clicked. The list contains all
the values of the selected risk field. To view a different pie segment value, select its value
from the filter list and the results will load automatically.

2) List of manufacturer parts in the selected BOM-Revision-Variant that contain the filtered
value.

3) Shows the selected page (when applicable) and total count that matches the filtered
criteria.

4) Export option to export the list to a CSV or Excel file.

Note: Export functionality is not available when using the System Capture plugin.

4.10  BOMs

The BOMs menu provides links to BOM form fields and controls that allow you to view, create, import, delete, and
export BOMs. This enables you to search for functionality or export additional fields to augment CIS BOM (.DSN or
.CSV) or non-CIS BOM (.CSV) information imported into CIP. 

BOM Menu Options

You can perform the following operations when you select the BOMs > View/Import menu:

· View a BOM Revision (Single or All Variants)

· Create a New BOM

· Create/Copy to a New Revision

· Import Parts (BOM Items) into a BOM
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· Delete a BOM Revision/Variant

You can perform the following operations when you select the BOMs > Export menu:

· Select and Export Existing BOM

· Create a Capture CIS BOM

· Upload and Export a Parts List

· Generate a Template for BOM Export

Note: Export functionality is not available when using the System Capture plugin.

4.10.1  BOM View/Import

The BOMs > View/Import menu allows you to select and view a BOM, create BOM part numbers, import a parts list to
a BOM, and delete a BOM. You can import part data from a CSV text file or from a design (DSN). Once your BOM is
created, you can edit BOM fields, import/update BOM Items, copy BOMs/Revisions/Variants, or delete a BOM
Revision's Core or a Variant.

When you select BOMs > View/Import, the BOM Information page selects the first BOM-Revision-Variant in the list
and displays the info of the BOM and its BOM Items.

BOMs > View/Import

BOM-Revision-Variant

After selecting the BOMs > View Import menu, you can:

· View a BOM

· Create a New BOM

· Create/Copy to a New Revision

· Import Parts into a BOM

· Delete a BOM Revision/Variant
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4.10.1.1  View a BOM

When you select BOMs > View/Import, the BOM Information page selects the first BOM-Revision-Variant in the list
and displays the info of the BOM and its BOM Items.

BOMs can be viewed in multiple ways:

· Specific Variant of selected BOM Revision

Core Design (Left) vs. variant1 (Right)

      

o Each part used on a given RefDes for the selected variant will be shown, regardless
whether it is the same part number as the core.

§ e.g. If the core and variant1 both have RefDes C1 with part EMA-00000491V22, the
actual PN will be shown for C1 when viewing the core or variant1.

o When a RefDes exists in the core and not a variant, or any variant but not in the core (not
possible with CIS Variants), the Do Not Stuff text (configurable in BOM Format) will be
shown in place of the part number for the variant.

§ e.g. If the core has RefDes C2 with part EMA-00000400V22 and variant1 does not have
a C2, the Do Not Stuff text will be shown for part number in C2 when viewing variant1.

· All Variants of selected BOM Revision
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All Variants of selected BOM Revision

o When a variant uses the same part number as the core for a given RefDes, the Same As
Core text (configurable in BOM Format) will be shown in place of the part number.

o When a RefDes exists in the core and not a variant, or any variant but not in the core (not
possible with CIS Variants), the Do Not Stuff text (configurable in BOM Format) will be
shown in place of the part number for the variant.

§ If BOM Items exist for the core or a variant and you create a new variant (or core if it
didn't exist), the BOM Items will all initially appear as Do Not Stuff because there are no
BOM Items. Once BOM Items are imported into the new variant, the configured text for
Same As Core and Do Not Stuff items will be updated accordingly. e.g. Create
variant2 in the example above and the BOM Items will all be Do Not Stuff because there
are no items in variant2 at first.

To view a specific BOM-Revision-Variant

1. Select a BOM from the drop-down list that is located in the upper-right part of the page. Select
a (BOM) Revision for the selected BOM, then select a (BOM) Variant for the selected BOM
Revision. Each time you select a different BOM, Revision, or Variant, the BOM and BOM
Items sections are updated.

Note: It may take a while to load BOMs, especially if they are large.
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Single Variant Selected (Core Design)

2. Select a BOM Display Mode: Single, Delimited, or Compact.

§ Single - Each reference designator (RefDes) is shown on a single line.

§ Delimited - Each part number is shown on a single line where RefDes are shown as a
comma separated list.

§ Compact - Each part number is shown on a single line where RefDes are shown as
ranges or a comma separated list.

Single Variant - Compact Display Mode

Note: Component part attributes (e.g. Description, Schematic Part, PCB Footprint, etc.) cannot be altered or
added when viewing or importing a BOM because they are tied to the part numbers themselves.

To view All Variants of a given BOM-Revision,

1. Select a BOM from the drop-down list that is located in the upper-right part of the page. Select
a (BOM) Revision for the selected BOM, then select All Variants for the selected BOM
Revision. Each time you select a different BOM, Revision, or Variant, the BOM and BOM
Items sections are updated.

Note: It may take a while to load BOMs, especially if they are large.

2. The top section shows the BOM Fields for the core and all variants of the selected BOM
Revision.
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3. The RefDes column shows a cumulative list of all RefDes used across the BOM Revision,
displaying a single row per RefDes. This will always display BOM Items in Single display
mode and cannot be changed when All Variants is selected.

a. The Core column appears when a core design exists. It will list all parts used on the core.

b. Each variant appears in a single column.

4. When a variant uses the same part number as the core for a given RefDes, the Same As
Core text (configurable in BOM Format) will be shown in place of the part number.

a. e.g. RefDes C8 shows EMA-0000400V22 in the Core. Since the variant1 and variant2 also
use the same part number for C8, they both show Same as Core.

5. When a RefDes exists in the core and not a variant, or any variant but not in the core (not
possible with CIS Variants), the Do Not Stuff text (configurable in BOM Format) will be
shown in place of the part number for the variant.

a. e.g. RefDes J3 shows EMA-00007478V22 in the Core. Since J3 is not used in variant1 or
variant2, they both show Do Not Stuff.

b. For Capture CIS variants, the Core design will always include all of the parts. However, if
managing your variants elsewhere and importing via the Import CSV button, the Core may
have Do Not Stuff values if at least one variant uses a RefDes not used on the Core.

6. When a RefDes of a given variant uses a different part number than the core, the actual part
number used on each variant will be displayed.

a. e.g. RefDes R1 shows EMA-00003232V22 in the Core, EMA-00002609V22 in variant1,
and EMA-00002609V22 in variant2. All display the actual part number for row R1.

All Variants Selected
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4.10.1.2  Create a New BOM

You can add a new BOM from the BOMs > View/Import, BOM Information page. 

 To create a new BOM

1. Click the New  button.  

Note: The New BOM  button is only available to users who are granted permission to add a new BOM.

New BOM Creation

A new blank BOM entry form opens. The cell shading in the new form that opens indicates required field
information that must be entered before the new BOM can be saved. The PART_NUMBER and Revision fields
are required fields. 

Auto Number Next PN

2. Manually enter a BOM PN or click the Auto-number  button to insert an automatically
generated part number for your BOM.

3. Manually enter a revision number. This is required field entry.

4. You may optionally enter a variant value if your new BOM has a variant. The variant value entered, however,
must match a CIS variant. Leave this field blank if a CIS variant is not used. 

Add New BOM

5. Click the  button to save the new BOM with all entered information. 

As shown in the image below, access to your new BOM, as well as other BOMs, is available from the drop-
down list located in the upper right corner of the screen. If desired, you can select a BOM from the drop-list and
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click the Edit button  to either enter addition field information or edit an existing value. Click the save button

 to save your modifications.

Added New BOM

6. After the BOM has been created, continue adding BOMs, Revisions, and Variants as needed.

You may now Import BOM Items to your BOM revision's core or variants.

4.10.1.3  Create/Copy to a New Revision

You can use Copy to New Revision  to create a new variant or revision for the BOM. BOM attribute data is
copied to a new revision or variant without copying the BOM items. 

To copy a BOM and create a revision

1. Select the BOM you wish to copy from the drop-list located in the upper right part of the
screen. 

Copy BOM Button

2. Select the Copy BOM button  and option for the copy.

If you select New Revision, the BOM form will appear with all fields copied except for Revision and Variant. If
you want to copy to a new Variant, the variant will be the only field that needs to be filled in.

Revision and Variant Fields

3. After the BOM has been copied, continue adding BOMs, Revisions, and Variants as needed.

You may now Import BOM Items to your BOM revision's core or variants.
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4.10.1.4  Import Parts into a BOM

Navigate to the BOMs > View/Import page and select the desired BOM-Revision-Variant. Parts can be imported from
the BOM Items section of the selected BOM. You can import parts into BOMs from a .CSV file using the

 button or from an open Capture schematic design using the  button.

Note: A BOM revision and variant must be created, as described in Creating a New BOM, before you begin the import

process. When using , the list of parts may be from a Capture CIS BOM or a BOM from another source,
as long as it is formatted in a supported .CSV file and all of the parts exist in CIP prior to import.

To import a BOM from a design (DSN) file

1. Open the design in Capture CIS and launch CIP.

2. Select BOMs > View/Import and select the desired BOM Revision from the BOM PN drop-
down list. When importing from DSN, any CIS Variants can be imported to the selected CIP
BOM Revision, regardless of the variant selected (within the BOM Revision) in CIP.

3. Click the  button, located in the BOM Items section of your screen.

4. Select the design from the Design File drop-down list and select the desired CIS Variants to
import, then click the Import BOM button. The variants in the CIP BOM Revision update with
the parts from the design.

Select DSN and BOM Variants for Import
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Note: If CIS Variants being imported do not exist in the selected CIP BOM Revision, they will be unchecked
(disabled for import) and marked with an asterisk as shown. You can continue with the import of selected
variants and import the missing ones later, or cancel the operation by clicking the X and create the missing
variants in CIP before importing.

CIS Variant is Missing in CIP and Unchecked/Disabled for Import

5. A confirmation message displays to let you know the import was successful. Click OK to
close the window.

Import Success

Note: When importing designs with variants, your design file must be opened within Capture CIS. All variants

within the design file must match the variant names in CIP when using  to automatically import
parts for selected core design and variants. 

6. After import, you can view the BOM as usual, using single variant or All Variants.

To import a single BOM (BOM-Rev-Variant) from a CSV file 

1. Select BOMs > View/Import and select the desired BOM Revision from the BOM PN drop
list, then select the Core (blank) or Specific Variant from the variant list.

2. Click the  button, located in the BOM Items section of your screen.
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3. Click the  button. Navigate to the .CSV file that contains your part list. Select the

.CSV file, click Open, then click the  button.

Note: The selected BOM must be formatted as a .CSV file. Additionally, all part numbers in the BOM must exist

in CIP prior to import, unless they match the Do Not Stuff text configured in BOM Format.

Browse to Select .CSV File

After the BOM uploads, a list of parts included in your BOM displays in the BOM Items area. Notice the blank
fields that display above each column header. 

4. Click the drop arrow to map the CSV file columns to the CIP PART_NUMBER and RefDes
columns. If the BOM part list you are importing contains a child BOM (or sub-assembly), you
also need to map the Revision and Variant columns. Otherwise, only the RefDes and
PART_NUMBER need to be mapped. Optionally, map any other BOM column fields you want
to import.

Map CSV BOM Columns to CIP and Select First Row of Data Part Table
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5. Select the first row of the data table and click the Check button to validate table
rows/columns are mapped correctly. This validation check ensures part numbers in the BOM
list are also in CIP. 

Check BOM Part Mapping

Note: All part numbers in the BOM must exist in CIP prior to import, unless they match the Do Not Stuff text

configured in BOM Format. If parts use the configured Do Not Stuff text, CIP will treat them as such.

6. Once the validation succeeds, click the Import button. A confirmation message displays to let you know the
import was successful.

Import Success

7. After import, you can view the BOM as usual, using single variant or All Variants.

To import multiple BOM Variants into a BOM Revision (Core, Variants) from a CSV file 

1. Select BOMs > View/Import and select the desired BOM Revision from the BOM PN drop
list, then select the All Variants option from the variant list.

2. Click the  button, located in the BOM Items section of your screen.

3. Click the  button. Navigate to the .CSV file that contains your part list. Select the

.CSV file, click Open, then click the  button.

Note: The selected BOM must be formatted as a .CSV file. Additionally, all part numbers in the BOM must be in

CIP prior to import, unless they match the Do Not Stuff text configured in BOM Format.

Browse to Select .CSV File

After the BOM uploads, a list of parts included in your BOM displays in the BOM Items area. Notice the blank
fields that display above each column header.
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4. Click the drop arrow to map the CSV file columns to the CIP PART_NUMBER and RefDes
columns for each of the desired variants (Core, Variants) to be updated. If the BOM part lists
you are importing contain a child BOM (e.g. sub-assembly), you also need to map the
Revision and Variant columns for each BOM Variant. Otherwise, only the RefDes and each
variant's PART_NUMBER need to be mapped.

Map CSV BOM Columns to CIP and Select First Row of Data Part Table

5. Select the first row of the data table and click the Check button to validate table
rows/columns are mapped correctly. This validation check ensures part numbers in the BOM
list are also in CIP. 

Check BOM Part Mapping

Note: All part numbers in the BOM must exist in CIP prior to import, unless they match the Do Not Stuff text

configured in BOM Format. If parts use the configured Do Not Stuff text, CIP will treat them as such.

6. After the validation succeeds, click the Import button. A confirmation message displays to let you know the
import was successful.
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Import Success

7. After import, you can view the BOM as usual, using single variant or All Variants.

4.10.1.5  Delete a BOM Revision/Variant

To delete a BOM revision variant 

1. Open the BOM revision/variant you want to delete by selecting BOMs > View/Import and
selecting the BOM name from the drop list located in the upper right corner of your screen.

2.  Select the Delete button  of the BOM you wish to delete. 

BOM Delete Button

The selected BOM revision/variant is deleted from CIP.

4.10.2  BOM Export

The BOM Export feature allows you to upload and export a CIS Bill of Materials (BOM) through use of the BOMs >
BOM Export > Upload BOM radio option. The BOM Export feature also allows you to select and export an existing CIP
BOM through use of the BOMs > BOM Export > Select BOM radio button. You can select additional fields and export
the parts list to a comma separated .CSV file or to Excel.

There are several Output Options available based on the BOM Selection option to Upload BOM or Select BOM.

BOM Export - BOM Selection Options
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After selecting the BOMs > Export menu, you can:

§ Select and Export Existing BOM

§ Create a Capture CIS BOM

§ Upload and Export a Parts List

§ Generate a Template for BOM Export

Note: Export functionality is not available when using the System Capture plugin.

4.10.2.1  Select and Export Existing BOM

To Select, Configure, and Export an Existing BOM

1. Select BOMs > Export. 

BOM Export Menu

Note: Export functionality is not available when using the System Capture plugin.

2. Choose the Select BOM radio option and click the BOM drop-down list to select the BOM file
you want to upload and export from the drop-down list.
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BOM Selection - Options when using Select BOM

3. If using a Saved Template, the default Template will load automatically. Select a Template
Type (Personal or Global), then select the desired Template to load its settings. If not using
a template, skip this step.

4. Select Additional Fields from CIP using the drop-down list to add fields to the BOM you are

exporting. After you select a field, click the Add  button to add the field name to the list of
additional fields located immediately below the selection field. Drag-and-drop a field name to

move it up and down the list. Click the red  on a field's row to remove it from the included
output fields.

a. RefDes and Quantity are added by default, since they are common BOM fields.

b. BOM Revision and Variant fields will only be included when (1) a Child BOM is present,
or (2) the Include Top Level option below is selected.

5. Select the desired Output Options. Some of these are only available with Select BOM is
chosen as the BOM Selection.

a. Include Component View - Add a column for the CIP Component View name (e.g. 
Capacitors, Connectors, etc.) to each part of the BOM.

b. Recursive - Add list of parts used for Child BOMs.

c. Include Top Level - Include the BOM number itself (i.e. Level 0). When selected, BOM
Revision and Variant fields will be included automatically.

d. Include Mechanical Parts - Include Mechanical Parts. When selected, Mechanical
Quantity and Parent PN fields will be included automatically.
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e. Manufacturer Limit - If you include Manufacturer, Manufacturer PN, or any of the
related Manufacturer/Distributor fields, you may wish to specify the number of
Manufacturer Parts to include with each part on a BOM. When unchecked, All
Manufacturer Parts will be used. - e.g. Limit Manufacturer (PN) to 1 if you only want to
include the first Manufacturer PN (left-most MFR/MFRPN tab when viewing a part in
CIP).

Note: If you include any Distributor data, it will display such data for All Distributor PNs
belonging to each Manufacturer PN.

f. Sort Order - Configure the default BOM sort order (PART_NUMBER, RefDes).

g. RefDes Display Mode - Select the format (Single, Delimited, Compact) for the parts of
the BOM you would like to export.

6. Click the Update  button to display the BOM below, after selecting the desired Additional
Fields and Output Options, .

7. Repeat Steps 4-6 until the BOM is ready for export.

8. Click the Export  button and choose whether you want the file format to be CSV or
Excel. A confirmation message appears when your export is successfully completed.

· If you choose the CSV format you are prompted to Save or Open the new (.CSV) file.  

· If you choose Open, the file opens directly in your browser window. 

· If you choose Save you are prompted to select a location to save the (.CSV) file.  

Note: Export functionality is not available when using the System Capture plugin.

Refer to the example below to see how a BOM Export output looks before exporting it. Notice how
the Description, Manufacturer, and Manufacturer PN fields are now visible in the parts list. The
new parts list also shows multiple Manufacturer PNs that are associated with single company part
numbers. There are many combinations of BOM fields and output options so keep in mind that
this is only an example of a specific export scenario.
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Configured Additional Fields and Output Options

 

4.10.2.2  Create a Capture CIS BOM

CIP supports any .CSV parts list, including (but not limited to) Capture CIS BOMs.

After you create a schematic design, you can generate a CIS BOM to upload in CIP before you export. 

To create a CIS BOM

1. Open/create your design in CIS.

2. Select it (e.g. .\cis.dsn) and select Reports > CIS Bill of Materials > Standard. 

The Standard Bill of Materials window opens. 

3. Change the Template Name to BOM Template. This enables you to reuse the template at a
later time. 

4. Select Part Number from the Output Format list, then click Remove. 

5. Scroll through the Report Properties and select PART_NUMBER, then click Add to move it
to the Output Format list. 

6. Do not check Allow Saving Title Block Properties. 

7. In the Part Reference Options, leave the default as Standard output. 



Product Version 25.1.22 for 25.1, 24.1, 23.1September 2025

CIP User Guide256

8. Check Export BOM report to Excel. 

9. Click OK to view the BOM. 

10.Review the Standard Output. 

11.Click File > Save As. Name the BOM and choose to Save it as a .CSV file. 

Please refer to the Cadence OrCAD Capture CIS User’s Guide (Open CIS, click Help > OrCAD Capture CIS Help >
CIS Help) for more information regarding the creation of a Standard CIS Bill of Materials.

4.10.2.3  Upload and Export Parts List

Uploading a parts list is a quick and simple process.  To upload a parts list, you must first create a CIS BOM from
Capture CIS (or other parts list) and save it as a (.CSV) file.  

To Upload a BOM (Parts List) 

1. Open CIP and select the BOMs > Export menu.

2. Select the Upload BOM radio button if it is not already selected. Click the Choose File
button and navigate to the BOM (parts list). Select the file and click the Open button. 

BOM Selection - Options when using Upload BOM

3. Notice the path and filename of the BOM you selected is now visible in the input field. Click
the Upload button.
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Uploading a (.CSV) Parts List

The part list opens. 

4. Enter the row numbers for the first BOM child item (First Data Row) and Header Row as
shown in the screen image below. 

When the row numbers of the First Data Row and Header Row are entered, the header row becomes
highlighted in a light shade of blue and the first row of data becomes highlighted in green (shown below).

Select First Data Row and Header Row

5. Notice the blank fields above each column, (see screen image below). Click the drop arrow
for your Part Number column and select PART_NUMBER from the list to map CIS and CIP
parts. If your parts list contains a child BOM (or sub-assembly) you may also map the
Revision and Variant columns to associate the child BOM. 

Mapping the BOM PART_NUMBER Column
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6. Continue with configuration and export of the Uploaded BOM.

To Configure and Export an Uploaded BOM

After you upload a BOM, continue with the export by adding additional fields and selecting output
options.

BOM Selection - Options when using Upload BOM

1. Verify the Header and Part Number fields are set up properly.

2. If using a Saved Template, the default Template will load automatically. Select a Template
Type (Personal or Global), then select the desired Template to load its settings. If not using
a template, skip this step.

3. Select Additional Fields from CIP using the drop-down list to add fields to the BOM you are

exporting. After you select a field, click the Add  button to add the field name to the list of
additional fields located immediately below the selection field. Drag-and-drop a field name to

move it up and down the list. Click the red  on a field's row to remove it from the included
output fields.

4. Select the desired Output Options. Some of these are only available with Select BOM is
chosen as the BOM Selection.

a. Include Component View - Add a column for the CIP Component View name (e.g. 
Capacitors, Connectors, etc.) to each part of the BOM.

b. Manufacturer Limit - If you include Manufacturer, Manufacturer PN, or any of the
related Manufacturer/Distributor fields, you may wish to specify the number of
Manufacturer Parts to include with each part on the BOMs. When unchecked, All
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Manufacturer Parts will be used. - e.g. Limit Manufacturer (PN) to 1 if you only want to
include the first Manufacturer PN (left-most MFR/MPN tab when viewing a part in CIP).

Note: If you include any Distributor data, it will display such data for All Distributor PNs
belonging to each Manufacturer PN.

5. When you are finished selecting Additional Fields and Output Options, click the Update

 button to display the BOM below.

6. Repeat Steps 3-5 until the BOM is ready for export.

7. Click the Export  button and choose whether you want the file format to be CSV or
Excel. A confirmation message appears when your export is successfully completed.

· If you choose the CSV format you are prompted to Save or Open the new (.CSV) file.  

· If you choose Open, the file opens directly in your browser window. 

· If you choose Save you are prompted to select a location to save the (.CSV) file.  

Note: Export functionality is not available when using the System Capture plugin.

Refer to the example below to see how a BOM Export can look before exporting it. Notice how the
Description, Manufacturer, and Manufacturer PN fields are now visible in the parts list. The new
parts list also shows multiple Manufacturer PNs that are associated with single company part
numbers. There are nearly an unlimited combination of BOM fields and output options so note that
this is only an example of a specific scenario.

Configured Additional Fields and Output Options
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4.10.2.4  Generate a Template for BOM Export

If you have a BOM template that you use to create your BOM, you can generate a BOM Export template. You can save
this template as either a global or a personal template. After your template is saved, you can re-use it without
reformatting your uploaded file.

After you have gone through the steps of uploading a parts list you can save the configurations to a template as
described in the steps that follow.  

To save configurations to a template

1. Select the Create New Template  button to open the New Template pop up. 

2. Enter a name for the template for which you are saving the configuration.  

3. If the template is to be used by other users, select the Global check box. Then click the Add
button.  

Using an Advanced Export Template

The saved template is included in the Template drop-down list. You may also make any template the default by

selecting a template and clicking the Set Selected Template as Default  button. The default template loads

automatically each time you open BOM Export. Click the Clear Default Template  button to clear the default
setting. If you make a change to the template, you may save the changed template by clicking the Save Changes to

Selected Template  button. Click on the Delete Selected Template  button to delete the selected template.



Product Version 25.1.22 for 25.1, 24.1, 23.1

Using CIP 261

September 2025

Save Changes to Selected Template

4.11  Virtual Librarian Service (VLS)

Virtual Librarian Service (VLS) enables access to the  menu item. VLS helps engineering
teams create their own exclusive part libraries fast and accurately, allowing engineers to focus on

innovation. VLS can be accessed via the  menu item to view, filter, and create requests, or

via the  button shown on a Manufacturer PN (MPN) to more quickly create a request for the
specific MPN. VLS options will only be shown when VLS is enabled in the configuration and when
you are logged into an Ultra Librarian account that has VLS access.

Access to Virtual Librarian Service (VLS) via VLS Menu Item

Access to Virtual Librarian Service (VLS) via VLS Button on a Manufacturer PN

When you have enabled VLS in the configuration but are not logged into an Ultra Librarian account
that has VLS access, you will see the page below.

When you have  enabled VLS in the configuration and are logged into an Ultra Librarian account
that has VLS access, you will see the summary page below where you can view, filter, and create
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requests. The page will dynamically wrap the filter and search fields based on the size of your
window, so this screenshot may not appear exactly as it does for you.

Click the  link in the title bar to open the User Guide to this section.

Note: Download functionality is not available when using the System Capture plugin.

To access the Virtual Librarian Service (VLS) menu item to view, filter, or download
attachments from existing requests,

1. Click  from the CIP menu bar. Your VLS request summary will be shown.

2. From there you will see your existing requests and have the option to filter them using the
available pick lists and text input fields.

VLS Filter Options

a. Click the pick list(s) for the desired field(s) to filter your requests.

i. Status - All Status(es), New, Open, Closed

ii. Priorities - All Priorities, Standard, High Priority

iii. Complexity - All Complexities, High, Low, Medium, Not Set

iv. Requestor - All Requestors, or select an individual from your list of requests.

v. Timespan - Last 4 Weeks, All Time

b. Enter Manufacturer and/or (Manufacturer) Part Number to search your requests. These
will filter on-the-fly so you can quickly narrow down your list of requests.

3. Review your requests and click on a specific request to open it. You have multiple options
when viewing a request.
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a. Update Request - You may update any of the editable fields or add new attachments,

then click  to update the request.

b. Download File Attachment - Click the attachment file name in blue text (e.g. lm555.pdf)
to download it.

Note: Download functionality is not available when using the System Capture plugin.

c. Delete File Attachment - Click the  button next to the file attachment you'd like to
delete it. *This is only available for files that you have uploaded, not those added by others.

d. Delete Request - Click the  button next to the (request) Update button to delete the
request. *This is only available for requests that you have created, not those added by
others.

e. Add Comments - Enter a comment in the New Comment: section, then click 
to update the request.

f. Return to Summary/Search - Click  when you are ready to return to the
summary/search list.

To create a new VLS request from the summary page,

1. Click  from the CIP menu bar. Your VLS request summary will be shown.
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2. Begin a new request by clicking the  button.

3. Add and select appropriate information regarding your request.

a. Subscription - Select your VLS subscription account if you have more than one.
Otherwise you can skip this.

b. Priority - Select the desired request priority.

c. Manufacturer - Enter the Manufacturer for the part in question.

d. (Manufacturer) Part Number - Enter the Manufacturer PN being requested.

e. Attachments - Add associated datasheets or part specs associated with your

Manufacturer PN by clicking , selecting your file, and uploading. Repeat this

process to add as many attachments as needed. Click the  button to remove an
attachment.

f. Instructions - Enter any specific instructions related to this part.

g. Request Types - Select the desired models for the request: Symbol, Footprint, or 3D
Model.

4. Click the  button to submit the request. After submitting the request, click 
when you are ready to return to the summary/search list.

To create a new VLS request from an existing part in CIP,

1. Open an existing CIP part, then scroll down to one of its Manufacturer PNs.

2. When viewing an existing CIP Manufacturer PN, click the  button next to the
Manufacturer PN.
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3. The same VLS form will appear as above, pre-populated with the Manufacturer and

(Manufacturer) Part Number from which you had clicked the  button. Complete the form

as described above, then click the  button to submit the request.

4.12  Design Parts Sync

After opening a design in OrCAD Capture that was created using CIP parts, you can run Design
Parts Sync to review all parts (Part References, RefDes) placed on the schematic design and ensure
their transferred fields are up to date with respect to your CIP database. The CIP database
connection is determined by your CIP URL under CIP > Settings. This feature does not require
an ODBC data source connection, but that is still required if you use CIS Explorer or CIS Part
Manager.

Design Parts Sync can be launched by clicking CIP > Design Parts Sync from the top menu, or
by right-clicking (RMB) inside an open schematic design page and selecting More... > CIP:
Design Parts Sync. After launching the feature, it will open to the Summary page in a new or
existing tab (CIP Design Parts Sync: <DESIGNNAME.DSN>), displaying the Summary
Information, Part Status Report, Display Mode, Export, and User Settings, and Sync Actions.

Note: This feature requires OrCAD Capture, the CIP Client plugin, and setting Transfer Fields to Design to
OrCAD using CIP or CIP and System Capture. It is not available when using the System Capture plugin.

Launch Design Parts Sync from top CIP Menu

Launch Design Parts Sync from RMB on an Open Schematic Page

The Design Parts Sync consists of the following:
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1. Summary page - This is the initial Design Parts Sync page that loads in a new or existing tab (CIP Design

Parts Sync: <DESIGNNAME.DSN>), displaying the Summary Information, Part Status Report, Display
Mode, Export, and User Settings, and Sync Actions. Data displayed on the summary page will be

refreshed each time you open the Design Parts Sync tab, click the Refresh  button,
complete an Auto Sync, or return from Processing page after processing selected parts.

2. Processing page - This loads in a Design Parts Sync tab after you select the check boxes for

the desired parts and then click . It allows the user to review the selected parts

(RefDes) to process, grouped by part number, and decide whether to ,

, or . All of the Part References associated with a single
PART_NUMBER are grouped together and can be processed together as well, but individual
items can be deselected if you do not wish to sync them at that time.

Note: If you use  in place of , it will Automatically Sync the selected design
parts with the CIP database, without user interaction. The Processing page will not be
shown in this case.

3. Part Replacement page - This loads in a Design Parts Sync tab and can be invoked from a
selected part on the schematic design or from the Summary page of Design Parts Sync. It
allows the user to select a part RefDes or set of RefDes and choose a different part number
from CIP to replace them with. It is recommended that you Sync Parts on Design with CIP
Database before replacing parts.

Refer to Sync Parts on Design with CIP Database for instructions on the following:

1. Launch Design Parts Sync.

2. Sync selected design parts with the CIP database, one part number at a time, with user
interaction.

3. Automatically Sync all selected design parts with the CIP database, without user interaction.

4.12.1  Summary

The Summary page is the initial Design Parts Sync page that loads in a new or existing tab (CIP Design Parts Sync:

<DESIGNNAME.DSN>), displaying the Summary Information, Part Status Report, Display Mode, Export,
and User Settings, and Sync Actions. Data displayed on the summary page will be refreshed each time

you open the Design Parts Sync tab, click the Refresh  button, complete an Auto Sync, or
return from Processing page after processing selected parts.

Click the  link in the title bar to open the User Guide to this section.
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Design Parts Sync - Summary View

1. Summary Information

2. Display Mode, Export, and User Settings

3. Part Status Report

4. Sync Actions

The Summary Information displays the following data:

Design Parts Sync - Summary Information

§ Refresh  button - Click to refresh the Summary Information and Part Status Report for the

current design.

§ Design Path and File Name - Design Path and File Name of the current design (DSN) file in
the form of <Design Path>\<Design File Name>.

§ RefDes - The total number of RefDes (Part References) used on the current design.

§ Parts – The total number of unique Parts (PART_NUMBERs) used on the current design.
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§ Last Checked (Date/Time) – The last date and time the summary page was loaded (initially
invoked, refreshed, and after processing).

The Display Mode and User Settings determine how the data is displayed in the Part Status Report. The current
Display Mode is always shown above the Part Status Report, while the rest of the settings can be accessed by

clicking the Settings  button. The current report can be exported using the Export  button.

· Display Mode - This allows the Part References (RefDes) used on the design to be shown using one of three
modes (Single, Delimited, Compact), similar to the options when viewing or exporting CIP BOMs. Each time the
Summary page loads in a new tab, it uses the Default Display Mode from the User Settings below, which is
initially set to Single.

(Current) Display Mode

o Single - Each reference designator is shown on a single line. *This is the initial default for
all users.

o Delimited - Each part number is shown on a single line where reference designators are
shown as a comma separated list.

o Compact - Each part number is shown on a single line where reference designators are
shown as ranges or a comma separated list.

· Export - Use the Export  button to save the Part Status Report in either CSV or Excel
format.

· User Settings:
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Settings

o Default Display Mode - Configure the default Display Mode (Single, Delimited, Compact) for the Part Status

Report, similar to the (on-the-fly) Display Mode setting. *Single is the initial default for all users.

o Default Selection State - Configure the default selected check boxes (All, None) for the Part Status Report.

*All is the initial default for all users.

o Default Sort - Configure the default sort order (Part Reference, PART_NUMBER then Part Reference) for the

Part Status Report. *Part Reference is the initial default for all users.

o Summary Displayed Fields - This shows the PART_NUMBER and a cumulative list of all CIP Fields
configured to Transfer to Design for all component views. By default, all fields set to Transfer to Design in CIP
will be shown on the right side, meaning they will be shown in the Part Status Report. Click and drag a field

up or down the list on the right to reorder it. Click the button to move a field back to the left side so it will not
be shown in the Part Status Report, though it will still be used to determine the Part Sync Status.
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o Click  to save your updates or  to discard them.

The Part Status Report is displayed in table form and includes the data columns below for all parts placed on the
design, as of the date/time shown in the Summary Information at the top of the page. The Part Sync Status and Part
Reference columns are always shown, while the rest of the columns can be shown/hidden and reordered using the

Settings  button. Data displayed in the report may be exported using the Export  button, with options for
CSV and Excel output.

Part Status Report - Example

Part Status Report - Part Sync Statuses

The Part Sync Status, Part Reference, PART_NUMBER, and other CIP Fields configured to

Transfer to Design will be highlighted and labeled based on the Part Sync Status scenarios above.

§ Check Boxes - The left-most column consists of a Select All/None check box, followed by
individual check boxes associated with each data row. e.g. Design Parts that are Found - Up
to Date, Found - Up to Date (TMP), etc. will not be selectable because their CIP transferred
fields are already up to date so there is no action to take.
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§ Part Sync Status - This indicates the status of each part (Part Reference) placed on the
design, relative to its PART_NUMBER in CIP. The Part Sync Status, Part Reference, and
PART_NUMBER will be highlighted and labeled based on the Part Sync Status values shown
above. In some cases, the same placed part may meet multiple criteria, in which case the
Part Sync Status displayed will be prioritized as shown above. *This column is always shown,
not able to be reordered.

o Part Reference and PART_NUMBER will also be highlighted under certain conditions as
shown above in the Part Status Report - Part Sync Statuses.

o When any CIP Field transferred to Design Property is out of date with CIP, the value of the
Design field in the Part Status Report will also be highlighted.

§ Part Reference - This column lists all of the Part Reference(s) for a given row. The number
of Part References depends on the Display Mode and number of unique records based on the
references and PART_NUMBER shown. The Part Reference value will be will be highlighted
under certain conditions as shown. *This column is always shown, not able to be reordered.
In Single and Delimited display mode, the Part References are clickable links that can take
you to the associated part on the design. In Compact display mode, only rows with a single
Part Reference are links.

§ PART_NUMBER - This column lists the associated PART_NUMBER for the Part
Reference(s) on a given row. This can be grouped to one or more Part Reference(s)
depending on the Display Mode and number of unique records for the RefDes and
PART_NUMBER shown. *While this column can be hidden using the User Settings, it is not
recommended. The PART_NUMBERs are clickable links that can take you to the associated
part in a new CIP tab.

§ Source Library and Source Package - These are Capture properties that include the
path/location of the schematic part along with the schematic part name itself. When a part is
placed on the design using CIP, the Schematic Part field will be used, along with the path(s)
from your Capture.INI file (unless the explicit path is specified in the Schematic Part field).
There are various ways to specify the Schematic Part (e.g. CAP, CAPACITORS\CAP, \
\CENTRALLIBRARY\CAPACITORS.OLB\CAP, etc.) so there is logic that tries to account for
this when comparing the Source Library and Source Package to the Schematic Part value in
CIP.

o If an issue/mismatch is found, you must resolve it by (1) updating the Schematic Part
value for the part in CIP, (2) updating the path(s) in your Capture.INI file, or (3) using the
Replace Cache feature in Capture. This is because the Source Library and Source
Package fields themselves are not editable properties in your Capture design. The
appropriate solution will depend on each case found.

§ Other Design Fields/Properties that are configured to Transfer to Design in CIP - The rest of the fields
shown are specific to your CIP database and consists of the fields that your CIP has set to
Transfer to Design and that are configured to be shown in your Design Parts Sync's User
Settings.

o While not required, these CIP fields are most often set to transfer to design from CIP:
Value, Description, PCB Footprint, ALT_SYMBOLS, CLASS
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o Other key parametric data fields that are commonly set to transfer to design from CIP:
Package Size, Package Height, Tolerance, Rated Voltage, Schematic Part, etc.

§ Replace Part - This context menu can be invoked by right-clicking (RMB) on a row for a single

RefDes (Single display mode) or group of RefDes (Delimited or Compact display mode) to be replaced.
Follow the instructions to continue with Part Replacement from Design Parts Sync.

The Sync Actions are used to update the transferred design properties for the parts on your design with the
associated field data from your CIP database. Select the check boxes for the desired parts (Part References aka
RefDes) and then click one of the two sync options. Hover over either button to see a tooltip with a more detailed
description.

1.  - This will open the Processing page and allow the user to review the selected parts

(RefDes) to process, grouped by part number, and decide whether to ,

, or . All of the Part References associated with a single
PART_NUMBER are grouped together and can be processed together as well, but individual
items can be deselected if you do not wish to sync them at that time.

2.  - Automatically Sync all selected design parts with the CIP database, without
user interaction. The Processing page will not be shown in this case.

4.12.2  Processing

The Processing page will launch in the same Design Parts Sync tab after you select the check boxes for the desired

parts and then click . This allows the user to review the selected parts (RefDes) to process, grouped by part

number, and decide whether to , , or . All of the Part References
associated with a single PART_NUMBER are grouped together and can be processed together as well, but
individual items can be deselected if you do not wish to sync them at that time.

Note: If you use  in place of , it will Automatically Sync the selected design parts
with the CIP database, without user interaction. The Processing page will not be shown in this
case.

Click the  link in the title bar to open the User Guide to this section.
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Design Parts Sync - Sync View

1. Current CIP PART_NUMBER and the CIP (Component) View to which it belongs. Click on
the part number (e.g. EMA-00000374V22) to open the part in a new CIP tab inside Capture.

2. Current progress, shown as a percentage (e.g. 33.3%) and as current part number out of
total selected part numbers (e.g. 1 of 3). The progress counts are also shown in
parentheses in the title bar.

3. CIP's transferred field data for the current CIP PART_NUMBER. This appears in the top data
row of the table, just below the header row, and does not have a Part Reference since it is
referring to the part in CIP and is not a RefDes placed on the design.

4. Design's transferred field/property data for each RefDes placed on the design. Out of Date
values on the design are highlighted as shown. Refer to the Part Status Report for all Part
Sync Statuses and highlight colors.

4.12.3  Sync Parts on Design with CIP Database

To launch Design Parts Sync,

1. Open a schematic design page, otherwise Design Parts Sync will be disabled.

2. Invoke Design Parts Sync using one of these methods:

a. CIP menu in Capture - Select CIP > Design Parts Sync from Capture's top menu bar.
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Launch Design Parts Sync from top CIP Menu

b. Schematic Page - Right-click (RMB) inside an open schematic design page, select More... > CIP: Design
Parts Sync.

Launch Design Parts Sync from RMB Open Schematic Page

c. Design Parts Sync will not load if you have not set Transfer Fields to Design to OrCAD using CIP
or CIP and System Capture. It must be set to one of those.

Design Parts Sync will not load if using a non-CIP option to Transfer Fields to Design

3. The Design Parts Sync will open its Summary page in a new or existing tab (if you've launched the
feature and still have the tab open).

To Sync selected design parts with the CIP database, one part number at a time, with user
interaction,

1. From an open Design Parts Sync tab, select the desired parts (Part References aka RefDes) to
sync using the check boxes to the left of the Part Sync Status column. Each time you select
a part, it will automatically select all other Part References that use the same CIP
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PART_NUMBER. Select/deselect the top check box to select/deselect All checkboxes that
are able to be checked. The default select all/none behavior is defined in the User Settings.

Note: Design Parts that are Found - Up to Date, Found - Up to Date (TMP), etc. will not be
selectable because their CIP transferred fields are already up to date so there is no action
to take.

2. Click the  button to display the Processing page and begin processing the selected parts.

3. The Processing page shows the first CIP PART_NUMBER, its Component View, and all the
design's Part References (RefDes) that use the PART_NUMBER. The table shown is similar
to the Part Status Report, except that the fields shown are specific to the (Component) View of the

PART_NUMBER shown, and the top row of the table shows the field data from CIP (i.e. the correct
data). The Part Sync Status shows the current sync status of each placed part and all Out of
Date fields are highlighted as shown. All parts are selected by default, but individual items can be

deselected if you do not wish to sync them at this time. Click  to sync the selected

parts on the design with the data from CIP, or click  to skip this group of parts and
go to the next one.

4. The next group of parts will appear and you'll be given the same options. Repeat step #3 until
you've processed all selected parts.

Note: At any time, you may click  to end the process and return to the
Summary page.

Design Parts Sync - Sync View

a. If a PART_NUMBER in CIP contains multiple PCB_Footprint values and any of the
design's parts have a footprint that does not match any of the values in CIP, it will be
outlined in red and you will need to select which PCB_Footprint to use from the pick list.
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The  button will be disabled until you choose a valid PCB_Footprint. The

 and  will remain available.

Note: If this scenario occurs when using , the primary (first) footprint in the list of
PCB_Footprint values in CIP will be used.

5. The Summary page will be refreshed, showing the applied changes in the Part Status Report.

To Automatically Sync all selected design parts with the CIP database, without user
interaction,

1. From an open Design Parts Sync tab, select the desired parts to sync using the check boxes
to the left of the Part Sync Status column. Each time you select a part, it will automatically
select all other Part References that use the same CIP PART_NUMBER. Select/deselect the
top check box to select/deselect All checkboxes that are able to be checked. The default
select all/none behavior is defined in the User Settings.

Note: Design Parts that are Found - Up to Date, Found - Up to Date (TMP), etc. will not be
selectable because their CIP transferred fields are already up to date so there is no action
to take.

2. Click the  button.

3. The confirmation pop-up dialog will appear, since this action may take a while and there is no

user interaction. Review the confirmation. Click  to continue with Auto Sync or

click  or  to cancel.

4. Once completed, the Summary page will be refreshed, showing the applied changes in the Part
Status Report.
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4.12.4  Part Replacement

The Part Replacement page will launch in a Design Parts Sync tab and can be invoked from a
selected part on the schematic design or from the Summary page of Design Parts Sync. It allows
the user to select a part RefDes or set of RefDes and choose a replacement part from the CIP
database.

Note: This feature does not replace parts on CIS Variants. When used on a design with CIS
Variants, replacing a part will only replace the parts on the core design.

Click the  link in the title bar to open the User Guide to this section.

To launch Part Replacement from Design Parts Sync,

Single Display Mode - Right-click options to Replace Single RefDes or All RefDes Associated w ith the PN

Delimited Display Mode - Right-click options to Replace Grouped RefDes or All RefDes Associated w ith the PN

1. Open a schematic design page, otherwise Design Parts Sync will be disabled.

2. Launch Design Parts Sync from Capture's top menu bar or from the right-click (RMB) menu
on a schematic design page.
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3. Select the Delimited or Compact Display Mode to group RefDes with the same company
Part Number and Part Sync Status. Separate rows/groups will be shown for RefDes that
have the same part number, but different Part Sync Status.

a. The figures above show that C2, C3, C8, and C9 all use the same Part Number. However,
C2/C3 are Found - Out of Date and C8/C9 are Found - Up to Date so there are two
groups of RefDes for the Part Number in question.

Note: It is recommended that you Sync Parts on Design with CIP Database before replacing
parts with this method, as it will improve the groupings if more parts are Found - Up to Date.

4. Right-click (RMB) on a row for a RefDes or group of RefDes to be replaced, which will display a context
menu with options to:

a. Replace CIP Part on <RefDes> - This depends on the Display Mode (Single, Delimited,
Compact) - e.g. Replace CIP Part on C8 (Single), Replace CIP Part on C8, C9
(Delimited), or Replace CIP Part on C8-C9 (Compact).

b. Replace CIP Part on All Part References Associated with <PN> - This selects all
RefDes that use the same PN and it does not depend on the Display Mode. - e.g. Replace
CIP Part on All Part References Associated with EMA-00000400V22.

5. Click on the desired replacement option to open the Part Replacement page in the existing Design Parts Sync
tab.

To launch Part Replacement from a Schematic Design Page,

1. Open a schematic design page, otherwise Part Replacement options will be disabled.

2. Right-click (RMB) on a part  page and select More... which will display a context menu with
options to:

a. CIP: Replace Part on this RefDes - Select this to only replace the selected RefDes (e.g.
R1).

b. CIP: Replace Part on All Associated RefDes - Select this to replace All Associated
RefDes (e.g. R1, R3-R7, R10, etc.) that use the same CIP part.

Launch Part Replacement from RMB on Selected Part
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3. Click on the desired replacement option to open the Part Replacement page in  a new or existing Design Parts
Sync tab (if you've launched the feature and still have the tab open).

To Filter on Potential Replacements and Select a Replacement Part,

Design Parts Sync - Part Replacement - Find a Replacement Part

1. Initially, the Component View, Source Package (Source Library and Source Package),
PCB Footprint, and Value are populated with the values from the part's RefDes to be
replaced. This set of values is used for the initial filter that is applied automatically and lists
potential replacement parts (from your CIP database) that contain all values. The potential
replacement parts are listed under the Select a Replacement Part row. If the desired
replacement part is not currently shown in the replacement list, update or clear the field filters
as desired.

Note: Some of these fields may not be editable if they are set as Required to match the
parts being replaced. If that is the case, a user with permission can view the Design Parts
Sync tab under the Admin > Configuration page.

2. Click Apply to filter on the field values shown, which will refresh the list of potential
replacement parts.

3. Review the list of replacements and repeat the steps above until a suitable replacement is
shown.

Design Parts Sync - Part Replacement - Select a Replacement Part
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4. Select the desired replacement part in one of two ways:

a. Click anywhere on the row of the desired part number, except the underlined part number
link (PART_NUMBER in the example above). This will outline the part in green, and if not
hovering over the part, will also highlight the cells in green. Field values that do not match
the part number of the affected RefDes will remain highlighted in light red.

b. Right-click (RMB) on the row of the desired part number, which will bring up an option to
replace the part.

5. Replace the part based on how you selected it in 4a/4b:

a. If you clicked on the part (4a), click the Replace button next to the Return to Summary
button.

b. If you right-clicked on the part (4b), click the context menu to Replace part using
<Selected PN>.

6. If all of values from the four replacement filter fields (1, above) match between the original part
number being replaced and the selected replacement part, the replacement will proceed.
However, if any of the values do not match between the original and replacement part, you will

be prompted with a warning asking you to confirm your replacement choice. Click 

to confirm the part replacement or  to return to replacement part list.

Note: A warning will never appear if all of your Part Replacement Filter Rules in the Admin
> Configuration > Design Parts Sync page are set to Required because they will already
match, since you won't be able to change the initial filter of potential replacements. However,
if even one of the fields is set to Optional (Warn), you could select a replacement that
doesn't match (e.g. select a different PCB Footprint), in which case you will be warned as
shown. Only the applicable warning messages will be displayed.
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Part Replacement Confirmation

4.13  Sample New Part Process Using CIP

A typical part process includes the following steps, with exceptions or variations depending on a company’s part
building methodology. 

1. Engineer creates temporary part in CIS; CIS assigns part a TMP part number

2. Engineer notifies Librarian of newly created part

3. Librarian checks the part and assigns it a formal company part number if part doesn’t already
exist.

4. Librarian enters the formal part number into the CIS database using CIP

5. Librarian notifies the engineer of the formal part number

6. Engineer performs a Link Database Part within the CIS design to update the TMP part to the
formally accepted part number 

Note: If the part already exists, the librarian will map the temporary part to the existing part number.
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Sample Flow with New TMP Part
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Sample Flow with Derive Part

4.14  Help and Support

The CIP User Guide is available to any user logged into CIP.  The CIP User Guide is a .PDF document that can be
saved locally on the user's machine after it has been opened. 

To access the guide

§ Click the [Help] link in the upper right-hand corner of the CIP screen, next to the [Change
Password] link.  Refer to the figure below. 
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[Help] Link to Access the CIP User Guide

4.15  Technical Support

Contact your local channel partner with questions on technical support. 

5 Appendix: Part Type and Description Standards

Information provided in Appendix: Part Type Standard and Description Standards lists the default build rules that are
created in each component table of the CIS database. Companies who have purchased CIP may adopt these as
their own company standards for Description and Part Type. Instructions that explain how to modify the build rules
are provided in the Block Type sections Editing a Rule and Using a Rule. 

Text enclosed within the “<” and “>” symbols indicates the field value used to populate the Part Type or Description
string. 

5.1  Part Type Standard

The Part Type delimiter shall be the backslash “\” character. For fields that do not consist of a value (i.e. empty
fields), “--” shall be used.

Each of the 12 CIP tables has a default Part Type standard.  Default Part Type standards and examples are shown
below.

Capacitors:

<Di el ec t r i c  Type>\ <Package Type>\ <Package Si ze>

Example:  

Ceramic\SMD\1206
Ceramic\TH\5.1x3.2x1.0 mm
Tantalum\SMD\2012-15

Connectors:

<Devi ce Type>\ <Package Type>

Example:

Header\TH

Crystals and Oscillators:

<Devi ce Type>\ <Package Type>



Product Version 25.1.22 for 25.1, 24.1, 23.1

Appendix: Part Type and Description Standards 285

September 2025

Example:

OSC\SMD
XTAL\SMD

Diodes:

<Devi ce Type>\ <Package Type>

Example:

LED\SMD
Schottky\SMD
Zener\SMD

ICs:

<Package Type>\ <Dev i ce Type>\ <Funct i on>

Example:

SMD\Analog Devices\Optocoupler
SMD\Converter\DC-DC Converter
TH\Logic\Flip Flop

Inductors:

<Devi ce Type>\ <Package Type>

Example:

Ferrite Bead\SMD

Misc:

<Devi ce Type>\ <Package Type>

Example:

Testpoint\TH

Relays:

<Package Type>

Example:

TH
SMD

Resistors:

<Package Type>\ <Mat er i al >\ <Package Si ze>

Example:

SMD\Thick Film\0402
SMD\Thin Film\0805

Switches:

<Swi t ch Type>\ <Package Type>\ <Swi t ch Conf i gur at i on>

Example:

Light Touch\SMD\SPST
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Transformers:

<Package Type>

Example:

SMD
TH

Transistors:

<Devi ce Type>\ <Package Type>

Example:

BJT\SMD
Darlington\TH

5.2  Description Standards

The Description delimiter shall be the comma-space “, ” string. For fields that do not consist of a value (i.e. empty
fields), “--” shall be used.

Each of the 12 CIP tables has a default Description standard.  Default Description standards and examples are
provided below.

Capacitors:

CAP, <Dielectric Type>, <Package Type>, <Value>, <Tolerance>, <Rated Voltage>, <Package Size> 

Example: CAP, Ceramic, SMD, 6800 pF, 10 %, 10 V, 0201

Connectors:

CONN, <Device Type>, <Value>, <Number of Pins>, <Package Type> 

Example: CONN, Header, 15-24-7240, 24, TH

Crystals and Oscillators:

<Device Type>, <Package Type>, <Value>, <Frequency Tolerance>

Example: OSC, SMD, 13.5 MHz, +/- 100ppm

Diodes:

DIO, <Device Type>, <Value>, <Rated Current>, <Rated Voltage>, <Rated Power>, <Package Size>

Example: DIO, Zener, BZT52C3V3, --, 3.3 V, 500 mW, SOD-123

ICs:

IC, <Device Type>, <Function>, <Value>, <Package Size>

Example: IC, Memory Devices, PROM, XC18V01, SOIC-20

Inductors:

<Device Type>, <Value>, <Tolerance>, <Rated Current>, <Package Size>
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Example: Inductor, 220 nH, 5.0 %, 0.3 A, 0603
    Ferrite Bead, 120 Ohm, 25 %, 0.2 A, 0603

Misc:

MISC, <Device Type>, <Value>, <Package Type>, <Package Size>

Example: MISC, Testpoint, 5000 Red, TH, 2.5x2.5x4.6 mm

Relays:

RELAY, <Value>, <Coil Resistance>, <Coil Voltage Maximum>, <Contact Current>, <Package Type> 

Example: Relay, G5LA-14, 69 Ohm, 5 VDC, 5 A, TH

Resistors:

RES, <Material>, <Value>, <Tolerance>, <Rated Power>, <Package Type>, <Package Size>

Example: RES, Thick Film, 240 kOhm, 5.0 %, 1/16 W, SMD, 0402 

Switches:

SW, <Switch Type>, <Value>, <Switch Configuration>, <Number of Pins>, < Package Type>

Example: SW, Light Touch, EVQPH, SPST, 4, SMD 

Transformers:

XFMR, <Value>, <Primary Voltage>, <Secondary Voltage>, <Frequency>, <Package Type>

Example: XMFR, 3FS-310, 115 V,  5/10 V, 50/60 Hz, TH  

Transistors:

XSTR, <Device Type>, <Polarity>, <Value>, <Rated Voltage>, <Rated Current>, <Package Type>  

Example: XSTR, BJT, NPN, KSH29C, 100 V, 1.0 A, SMD  

6 Appendix: Configuring the CIS .DBC File

The CIP database is used by both the CIP web application and Capture CIS. When configuration settings are

modified (as described in sections Customize CIP Fields or Component Views) Capture CIS is unaware of the
changes. Settings in the CIS .DBC file tell Capture CIS how to interpret data found in the database and how to
properly control the display in CIS Explorer. When you create or update the DBC configuration file you must open the
CIS configuration tool that is available in Capture CIS.

Note: The CIS .DBC File is not used if you use CIP to place parts and your Transfer Fields to Design option is
set to OrCAD using CIP or CIP and System Capture.

Five DBC configuration files are pre-installed with the CIP web application. Each provide a different set of
information for CIS Explorer as defined below. 

· CIP-E V7.9 CIS DB.DBC  

This DBC file is configured with out-of-the-box settings for CIP that includes distributor part
information in the manufacturer display. Each distributor part information is shown on a
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separate line along with the corresponding manufacturer part information. If any of the user
fields or other fields have an alias to another name, you will need to update the DBC file
using CIS configuration option in Capture CIS.  

· CIP-E V7.9 CIS DB_NODISTRIB.DBC  

This DBC file is configured with out-of-the-box settings for CIP that does not include distributor part information
in the manufacturer display. 

· CIP-E V7.9 CIS DB_WITHCOMPLIANCE.DBC  

This DBC file is configured with out-of-the-box settings for CIP with Compliance Module log in enabled. The
DBC file configuration includes distributor part information in the manufacturer display. 

· CIP-E V7.9 CIS DB_NORELATIONAL.DBC

This DBC file is configured with out-of-the-box settings for CIP without any relational table settings. 

· CIP-E V7.9 CIS DB_WITHCOMPLIANCE_NOSILICONEXPERTPNS.DBC

This DBC file is configured with out-of-the-box settings for CIP with Compliance Module log in enabled with all
distributor part information but without Silicon Expert Part Number. Use this DBC file if you want to include
distributor part numbers in a BOM but do not wish to include Silicon Expert part numbers.

The CIS .DBC configuration file is generally shared by all CIS Users. Only one .DBC file needs to be modified and
placed in a network location to provide read-only access for all CIS users. Consult with your project leader or
librarian before modifying the .DBC file.

This Appendix includes three sub-sections that explain how to update the DBC file and create a new file using the
CIS configuration tool. 

§ Refresh DBC file
§ Update DBC file
§ Create DBC file using CIS Configuration Wizard

Refresh DBC file

When changes to fields are minor and affect fields in component views, a simple refresh of the
DBC file is required. The configuration of the CIP/CIS .DBC file may need to be refreshed or updated after the
following situations occur:

§ The display name of an enabled field changes as described in Customize Component Fields.

§ One or more new fields are added as described in Customize Component Fields or
Component Views

When component fields are modified without updating the DBC file, CIS users may see SQL
errors in their Session log as shown in following image.
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Error message in the Capture CIS > Windows > Session log

To refresh the DBC:

1. Open Cadence OrCAD Capture CIS and select Options > CIS Configuration.

2. Select the Setup button. Then select OK.  When setup opens select OK to save the settings.

CIS Configuration Setup

Update DBC file

When changes to fields are more significant, e.g. addition or change of a view, a simple refresh of
the DBC file is insufficient to resolve errors identified in the Session log. 

To update the DBC: 

1. Open Cadence OrCAD Capture CIS and select Options > CIS Configuration.  
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2. Select the Setup button. The Configure Database window appears.

Configure Database Configuration file

3. Locate the View or Table you want to add and select the check box to enable it for
configuration. Views and table that are shown depends on permissions set in your SQL
database. You may see table names prepended with "CIP_". These are used by CIP web
application. DO NOT select any of these tables.

4. Review the list of properties and configure the fields you want to Transfer To Design. Make
sure you map the Property Type for the following fields:

§ Part_Number

§ Part_Type

§ Schematic Part

§ PCB_Footprint

5. You may make other changes to match your company Schematic guidelines. Refer to the
Cadence OrCAD Capture CIS User’s Guide (Open CIS, click Help > OrCAD Capture CIS Help
) for more information regarding Creating a Configuration File. 

6. When you complete all your changes, click OK to save the changes and then OK to exit the
tool.
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Create DBC file using CIS Configuration Wizard

A new configuration of the CIP/CIS .DBC file that may be required is dependent on the type of modification.  CIS
Configuration tools in Capture will not refresh changes made to the relational table, which includes manufacturer
and distributor fields.

Changes to the manufacturer fields using Customize Manufacturer Part Fields or Customize Component
Manufacturer Part Fields will require new DBC file. You may be able to remove the relational table settings and re-
add them. If not, you can use the CIS Configuration Wizard to create a new DBC file. 

Capture CIS utilizes the ODBC data source through its own database configuration (DBC) to
access the database. The CIP Client installer automatically adds a data source name of CIP-
E_CIS_DB. 

CIS has a built-in wizard for creating DBC files. To ensure CIS can access both Table and Views
in your database, make sure that you have “TABLES OPTION=TABLE,VIEW” included in the
[Part Management] block of your Capture.ini file. 

To create a new DBC file:

1. Read the entire procedure below before going through it so your database is configured
correctly before you begin the steps. 

2. Open Capture CIS.

3. Under Options > CIS Configuration…, click the New… button and then Next. 

4. Select the appropriate Data Source (this list is pulled from your systems ODBC data
sources, so if you don’t see one for your database, you need to add an ODBC data source
first). The default ODBC data source to use is CIP-E_CIS_DB.  Then click Next. 

5. At Database Configuration: Step 2 display, map the tables into which you want to place
parts.  from in CIS. Click Next. 

Note: The list that displays shows all tables in the SQL database. Select only view names that
are already configured in CIP. 

6. At Database Configuration: Step 3 (1 of n) display, you will repeat for each table you map
in (5) (previous step). Select the appropriate table column to map Part_Number and Value
to. Click Next.

7. At Database Configuration: Step 4 (1 of n) display, you will repeat for each table you map
in (5). Select the appropriate table column to map Part_Type and Schematic_Part to. Click
Next.

8. At Database Configuration: Step 5 (1 of n) display, you will repeat for each table you map
in (5). Select the appropriate table column to map PCB_Footprint (optional) and
PSpice_Model (optional) if you plan to use these fields. Click Next.

9. At Database Configuration: Step 6 display, select which part properties you want to
transfer to the schematic page when you place the part. Click Next.
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10. At Database Configuration: Step 7 display, click Next.  If you want to use the ICA (Internet
Component Assistant – aka ActiveParts) you must check the box for ICA Properties and
select the fields to map to your database tables (typically all of them)

11. At Database Configuration: Step 8 display, select the browsable properties (items which
will be linked to external documents, like URLs or datasheets). Click Next.

12. At Database Configuration: Step 9 display, select the visibility of the items you previously
set to transfer to the design. Click Next.

13. At Database Configuration: Step 10 display, select the keyed properties (normally only
Value)

14. Click Finish. You will now be configured with the new .DBC file. You may continue to make
changes to the DBC file before saving.

15. To add relational table (manufacturing information), select the Relational Database tab.

16. For each Primary Table Name configured, select Part_Number as the Primary Key then
select either CIS Manufacturer Parts or CIS Manufacturer Parts No Distributor
(depending on whether you want to show distributor information) for the Relational Table.

17.Click OK to save and then OK to exit.

7 Appendix: Warnings and Errors

There are several types of warnings and errors that CIP may present to a user after taking an action. Warnings
generally alert the user of a potential issue, but allow the operation to continue if desired. Errors indicate there was
an issue that prevented the operation from completing successfully. Many of these warnings and errors fall under
the topics below.

· BOM Import Errors

· CIP Scheduler Service is not running properly

· Transaction or Execution Errors and Timeouts

7.1  BOM Import Errors

BOM Import errors could be caused by various factors, such as schematic design problems (e.g.
duplicate refdes), unexpected network issues, downtime with the CIP database or web server,
etc. When importing BOM Variants, CIP will report success or error messages for each variant
selected for import. Additional details are output to the Capture Session Log.

Note: If Capture crashes or is closed during the BOM Import, no errors will be shown.

Once the issue is addressed, the user can choose to import the selected variants that were
previously unsuccessful if they don't wish to import all variants.
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Part on the schematic design not found in CIP.

Remove the part from the design, create the missing part in CIP, or use Part Replacement to swap for a valid CIP
part.

BOM Import - Design Part Not Found in CIP

Duplicate reference designators (RefDes) found in the schematic design.

BOM Import - Duplicate RefDes

BOM Import - Duplicate RefDes - Session Log

SQL Server was paused, stopped, or disconnected after clicking [Import DSN] and before
clicking [Import BOM] from BOM Import window.

BOM Import - Error right after clicking Import DSN
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BOM Import - Error right after clicking Import DSN - Session Log

SQL Server was paused, stopped, or disconnected after clicking [Import BOM] to begin
importing.

BOM Import - Error during BOM Import

BOM Import - Error during BOM Import - Session Log

7.2  CIP Scheduler Service not running

The CIP Scheduler Service is required to run the scheduled CIP tasks such as the Compliance Sync, Distributor
Sync, etc.CIP Scheduler Service will run all URLs that are configured on the server. For example, if you use the URL
http://localhost/cip-e and schedule a sync, then change the synchronization task by using a URL like
https://servername/cip-e, both URLs will be saved. To remove the extra scheduled sync, you can log in with the
original URL and disable synchronization.

To investigate the rest of the possible issues will require a person (most likely an IT personnel) who has permission
to logs or directories located on the web server.

If you are not sure if the scheduled sync is working properly, please check and correct any of the following issues:

Possible Issue 1: 

http://localhost/cip-e
https://servername/cip-e
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The CIP web application must be accessed through HTTPS, but the HTTPS certificate is not considered valid by
the server. (For example, when you go to https://servername/cip-e while on the server, you get a warning about the
certificate, and must click continue to proceed).

Solution: Install and use a valid certificate for the CIP web application, or do not force HTTPS access.

Possible Issue 2:

The URL that was used to schedule the sync is not the same as the URL normally used to access the CIP web
application. This could happen if the web application was moved to a new server, or if modifications were made
from multiple URLs.

Solution 1: If possible, navigate to the original URL, disable the scheduled sync, and save. Then navigate to the
new URL, enable the sync, and save.

Solution 2: Follow the step below to determine any URLs configured.

1. You will need to connect to the CIP server and view its event log.

2. Open Event Viewer > Applications and Services Logs > CIP Scheduler Service Log 

3. See sample screenshot. 

4. You may need to scroll down and select a different line to find the log that shows that
service started.

5. If you cannot find it, you can do the following to trigger a refresh. (1) bring up Services,
select CIP Scheduler Service, (2) click Restart and then (3) go to Event Viewer select
Refresh. (See screenshot below)

https://servername/cip-e
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6. If there are multiple URLs in the list, navigate to CIP using each base URL and disable the
scheduled synchronization there.  

7. If navigation to the undesired URL(s) is no longer possible, all URLs can be cleared out.

a. Navigate to C:
\Windows\SysWOW64\config\systemprofile\AppData\Local\EMA_Design_Automation,
_In. This folder cannot be accessed without direct permission or administrative

privileges. if attempting to navigate there directly results in a “folder not found” error,
grant your username explicit permissions to the folder or access it using an elevated
process (i.e. command prompt run as Administrator)

b. Delete all folders contained in the EMA_Design_Automation,_In folder.

8. Navigate to the correct CIP URL and schedule the sync.
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7.3  Transaction or Execution Errors and Timeouts

Several factors could cause the CIP web application to return transaction or execution errors and/or timeouts,
including but not limited to the following:

· Bulk operations that affect a large number of parts and/or fields in CIP. - E.g. Bulk Import,
Bulk Rename, BOM Import, etc.

· Updates to the Admin > Configuration that potentially affects many component views, parts,
or fields. - E.g. Modify a field for all views when your CIP contains a large number of views.

· Searches or other actions that return large amounts of data rows and fields. - E.g. Search
returns 100's of parts and is displaying many part fields, MFR/MPN, MPN fields, and
Dist/DistPN.

· Underpowered CIP Web Server or CIP Database Server, whether it be CPU, RAM, I/O,
network connection, etc.

· Unallocated resources for your CIP Database (MS SQL) Server.

· Your CIP has a very large number of views, fields, part numbers, etc., that may cause
operations to take an extended period of time to complete.

If you experience execution or transaction timeout errors such as the ones shown in the examples below, increasing
your transaction timeout settings can help avoid such errors in the future. The default timeout is ~1 minute.
Increasing the timeout will require a person (most likely IT personnel) who has permission to modify the CIP Web
Application's web.config that is located on the web server.

Add/Update the following three lines into your web.config file, after the </appSettings> section. The lines in the

example below will update the timeout to 10 minutes and give long-running transactions more time to complete. You
may need to tweak this setting depending on your environment, as the time required to complete different operations
may vary. Note: Not every CIP operation is affected by this setting so updating it may not fix the issue in every case.

<system.transactions>
      <defaultSettings timeout="00:10:00"/>
</system.transactions>

· Execution Timeout Expired. The timeout period elapsed prior to completion of the operation or the server is
not responding. Operation cancelled by user.

· The transaction associated with the current connection has completed but has not been disposed. The
transaction must be disposed before the connection can be used to execute SQL statements.
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· The operation is not valid for the state of the transaction (with or without Transaction Timeout)

  

· The transaction has aborted.

8 Appendix: Tutorial for Importing CSV Parts

This Appendix includes a tutorial that is comprised of four modules that supplement the sections, Bulk Operations of
CIP Administration, and Import. Sample parts from this tutorial may be deleted by following information in the Admin
> Bulk Operations > Bulk Delete. 

As you follow the instructions presented in this tutorial you need to access the exercise files: "Capacitors.csv" and
"SampleParts.csv". The files may be downloaded from this section of the web help.  The file "Capacitors.csv"
supports the Modules 1 and 2, while "SampleParts.csv" supports Modules 3 and 4. Each module assumes you have
successfully completed the steps of the previous module.   

§ Module 1: Configuring and mapping an import file

§ Module 2: Importing capacitors into CIP
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§ Module 3: Adding parts to CIP without updating existing parts

§ Module 4: Updating existing CIP parts

8.1  Module 1:  Configuring and Mapping an Import File

When you complete the steps in Module 1 you will be able to configure and map fields of a CSV import file to CIP.  

To configure and map an import file: 

Step 1:  If you are able to back up you database, do so now. 

Step 2:  Select Admin > Bulk Operations > Import. 

Step 3:  Click the Configuration button, then click the Choose File or Browse button (depending on your browser) to
select the Capacitors.csv file. 

Step 4:  Verify a comma is entered as the Delimiter.

Step 5:  Click the Upload button and wait a moment for the upload process to complete. The word "Success"
appears to the right of the Upload button when the file is successfully uploaded.

Successful upload of CSV file

Step 6:  Click Next to progress to the Key Field Configuration screen. Map the fields of the Capacitors.csv file as
follows: 

§ PART_NUMBER – map to Item No. field
§ Component View – map to Component Type field
§ Manufacturer – map to Mfr. field
§ Manufacturer PN – map to MPN field
§ Distributor – map to Dist field
§ Distributor PN – map to Dist PN field

Click the Next button to progress to the Capacitors Field Mappings window. 
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Step 7:  Click the Auto Map button. If a warning pops up asking you to verify whether you want to overwrite existing
data, click Overwrite. Notice how the CSV fields that have the same names as CIP fields automatically
map. 

Step 8:  Manually map the following remaining fields in the Capacitors Field Mappings window that were excluded
from the auto-mapping: 

§ Part Type – map to Component Type
§ Description – map to Short Description
§ Company Part Status – map to Status
§ Dielectric Type – map to Dielectric
§ Equivalent Series Resistance – map to ESR

Leave the remaining fields blank.
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Auto Map and Manual Mapping of Capacitors Field Mappings

Step 9:  Click the Next button multiple times until you open the Manufacturer Field Mappings. If you go beyond the
Manufacturer Field Mappings screen, click Previous to return to that screen. 

Step 10:  Select Mfr Status for the field Manufacturer PN Status. Click Next and then click Save.

You have now successfully completed the configuration of capacitors field mappings. You are ready to progress to
Module 2.  

8.2  Module 2:  Importing Capacitors into CIP

When you complete the steps in Module 2 you will be able to:

§ Simulate how CIP will be impacted before you import parts 
§ Understand the different uses of the Add Only and Add and Update buttons
§ Add capacitors to CIP

Instructions presented in this module assume you have successfully completed all steps in Module 1. If you have
not created a backup of your CIP database during Module 1, backup your database now. This module begins with
the CIP Import screen. 

To import parts into the Capacitors View
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Step 1:  Select the Simulate check box if it is not already selected and click the Add and Update button. The green
status bar indicates when the CIP simulation is complete. The results of the import simulation are
summarized below the green status bar.

Simulate how the import w ill impact CIP database before you import parts

Step 2:  Select the Logs tab and click the log file name to open and view the log. The naming convention of this file is
<YYYYMMDD>T<HHMMSS>_Simulate.txt. You can recognize the correct log by the date and time. The most
recent log is located at the top of the list. 
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Results of the Simulate Import are reported in the Log file

Step 3:  Notice the summary at the end of the log that identifies 18 parts processed, 16 parts added, 16 Mfr parts
added, and 12 distributor parts added. Two warnings are issued that say two parts have Cap is not
recognized as a Part Type Category and Component View. Although the Capacitors.csv file includes 18
parts you want to import, CIP is only able to import 16 parts.  

Log Summary at end of log  

The details of the warnings explain why the two files are excluded from the import: "No mapping found for
category 'Cap.' " 
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Log warnings explain why CIP is unable to process parts

Step 4:  Open the Capacitors.csv file in Notepad, Excel, or other txt editor. Find the two parts with the Component
Type: 'Cap.'  Change 'Cap' to 'Capacitors' and save the file. If you opened the file in Excel, notice the
Package Sizes that were originally 0603 were altered to 603 when the file was saved. 

Step 5:  Return to the CIP Import screen and Import tab. Click the Configuration button. Select and re-upload the
updated Capacitors.csv file. Using the Next button page through the Import screens to verify the
configuration mappings are still correct. Then click the Save button. 

Step 6:  Deselect the Simulate checkbox. Click the Add Only button. This time all 18 parts with 18 manufacturer parts
and 12 distributor parts are added to the database.  

18 new components added to CIP  

Step 7:  Open CIP from your browser and search for parts with PART_NUMBER containing SAMP. Notice the 18 parts
are retrieved in the search results.  
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Your search results confirm you have successfully added 18 parts to your CIP database. You are ready to progress
to Module 3. 

8.3  Module 3:  Adding Parts to CIP without Updating Existing Parts

When you complete the steps in Module 3 you will be able to:

§ Interpret data in the log before adding parts to CIP
§ Add multiple types of parts to CIP without updating existing parts 

To add new parts to all other CIP views without changing the Capacitors view

Step 1:  Select the Admin > Bulk Operations > Import menu. 

Step 2:  At the Import tab, click Configuration button to open the Import CSV File window. 

Step 3:  Click the Choose File or Browse button (depending on your browser) to select the SampleParts.csv import
file. Click Upload to upload the file and click Next. 

Step 4: Map the following fields in the Key Field Configuration: 

§ PART_NUMBER – map to Part Num  
§ Component View – map to Table 
§ Leave Manufacturer Name and Manufacturer PN fields blank. 
§ Click Next.
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Step 5:  For each of the remaining Component Field Mapping screens, map Description to Description. Click Save
when the last page displays.

Step 6:  Verify the Simulate checkbox is selected. Click Add Only.  
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Notice the summary results of the analysis. 

Step 7:  Open the Logs tab and review the Simulate log file. Notice the log summary that is reporting 11 parts are
added to the database and 29 parts were processed. Of the 29 parts processed, 18 parts were added
during the completion of Module 2 and the remaining 11 parts of the 29 are new and added to CIP. 
Because the Simulate check box was selected, however, the log summary indicates the potential impact
the import will have on CIP as the parts are not yet added to CIP.

Analyze log summary

Step 8:  Open the Import tab. Deselect the Simulate check box and click the Add Only button. When the Simulate
check box is blank, the new components are in fact added to CIP.
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Add new parts to CIP w ithout updating existing parts

Step 9: When the Add Only process is 100% complete, return to the Logs tab and review the Import log. 

Import log identifies parts added

Step 10:  Select CIS DB Search menu item.
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Step 11:  Conduct a search to retrieve PART_NUMBERS that contain SAMP and include the CIP field "Description" in
the search results. Notice 29 parts are retrieved in the search results. 

Review the record entries for the Description field. Compare the Description to the contents of the
SampleParts.csv file. The descriptions of the first import file, Capacitors.csv, included the abbreviations
CER and TANT while the second import file, SampleParts.csv spells out Ceramic and Tantalum.  When
you added the additional components to CIP as you completed the steps in Module 3 and imported parts
from SampleParts.csv, you did not update the part descriptions since Add Only was selected.  

CIP search results verify parts added without updating

existing part properties

You are ready to progress to Module 4: Updating Existing CIP Parts. 

8.4  Module 4:  Updating Existing CIP Parts

When you complete the steps in Module 4 you will be able to:

§ Understand the full Import functionality  

§ Add new parts to CIP and update existing parts
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To update Capacitors

Step 1:  Select the Admin > Bulk Operations > Import menu. At the Import tab, click Configuration button to open the
Import CSV File window. 

Step 2:  Browse to choose the import file, SampleParts.csv.  Click Upload to upload the file and click Next. 

Step 3:  Using the Next button, navigate through each Import screen to verify the mapping configuration you saved in
Module 3.  When the last window opens, (Transistors Field Mappings), Save the configuration. 

Step 4:  Select the Simulate check box and click the Add and Update button. The green status bar indicates the
completion of the analysis. 

Step 5:  Review the Simulate Log. Notice there are 18 capacitors updated and no new parts. 

Step 6:  Conduct a search for parts that have "SAMP" in the part name. Include the "Description" field in the search
results. Notice the description in the search results. The abbreviations CER and TANT indicate the
Description field is not yet updated, since Simulate Option was used.
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CIP search results

Step 7:  Return to the CIP Import tab and click the Configuration button. Choose and upload the file
SampleParts.csv. Then click Next to verify the configuration mappings of each screen. When you complete
the last screen Save the mappings. 

Step 8:  Deselect the Simulate check box and click the Add and Update button to actually update existing CIP parts.
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Step 9: Review the Import Log and notice there are 18 parts updated.

Step 10:  Conduct a database search for parts that contain SAMP in the PART_NUMBER. Include the Description in
the search results.  

Review the 29 parts in the search results. Notice the Descriptions field. CER is updated to Ceramic and
TANT is updated to Tantalum. 
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In addition to adding new parts to CIP, Module 4 has demonstrated how the Add and Update button can be
used to update the properties of existing parts. The search results shown in the above image show the
updated content of the capacitors Description property.

8.5  Troubleshooting Import Files

This troubleshooting section describes several of the most common issues that may occur with the import file.  

1) Problem: You are receiving an error message that starts with "Unable to read csv file. The
CSV appears to be corrupt near record..."
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Error "Unable to read csv file"

Cause: Your .CSV file is corrupt. This happens when you manually edit a .CSV file and accidentally delete a
comma. An import file also becomes corrupt when a comma separated field value is not enclosed in
quotation marks. This error may also occur when you use Excel to create a .CSV file. Excel creates the output
file in block. When there are many consecutive lines of data with nulls in the last few columns, Excel may fail to
pad the lines with the appropriate number of commas.

Resolution: If you are using Excel, move a column of data that has cell values for all or most rows to the far
right column. If you did not use Excel, use the line number display to help target the problem.

2) Problem: You are receiving an error that begins with the statement, "Unable to read .csv file."
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Cause: Your .CSV file either has duplicate field names (column headings) or additional columns may have
been inserted by Excel without a field name. The highlighted text in the sample above shows that "Component
Type" is the header for 2 columns.

Resolution: If you are using Excel, make sure all columns of data have a unique column heading. If you see
each column heading is unique, delete any column without data. 

3) Problem: After running Simulate, the total number of parts are identified without reference to
updated parts. 

Cause: Any number of reasons may cause this. Possible causes include: incorrect mappings or rerunning an
import file previously imported.

Resolution: Review the log file to determine why the CIP Import is unable to identify changes. Also thoroughly
check your configuration. After correcting the problem, restart the Simulate process again.

4) Encoding Warnings: Encoding warnings are shown in log file but you do not see them in
your import file.
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Cause: Opening and saving files that are exported by an application may cause the file encoding to change
from UTF-8 to ANSI. Excel may be unable to detect the encoding of the original file.

Resolution: If you open a file from Excel that has non-ASCII characters and the characters look odd, close the
file without saving. The best way to open this type of file using Excel is to rename the file to .txt. Open the .txt
using UTF-8 encoding and then export the file to UTF-8 encoding format.

9 Appendix: Sample CDS_SITE Setup for System Capture

CDS_SITE is a location that contains common System Capture project settings and library information. The Starter
Library that comes with the CIP Web Server installation provides the folder structure and corresponding sample
site.cpm and cds.lib files which enables you to get started quickly. This appendix provides a step by step guide to
setup up your CDS_SITE and place parts from CIP to your System Capture schematic.  

1. Verify that the System Capture Starter Library Option has been installed with the CIP Web
Server. If your CIP web server is an upgrade, you will need to uninstall the existing server and
run the installer again to see the System Capture Library Option.  

2. Create a share to your installed Starter_Library location. This may require a person (most likely IT
personnel) who has permission to perform this task on the web server. You may copy the Starter_Library to
another file server to ensure an accidental uninstall or upgrade doesn't change files that you want to keep or
alter.
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3. Map a drive to this share and have all users who need access to System Capture libraries create the same
map drive letter to this share. To verify this step, navigate to the \syscap\Libraries subfolder (e.g. L:
\syscap\Libraries) and look for the file Starter_Lib.csv. This file contains the starter library parts and
corresponding System Capture Model names.  
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4. Navigate to CIP using a standard browser and configure CIP to have System Capture
enabled for transfer fields to design using Admin > Configuration > Customizable Fields.
Set the Transfer Fields to Design Using option to System Capture. Review the Configure
Transfer Fields to Design section for detail information of options.

5. Import the Starter Library parts and parametric information. The System Capture Starter Library parts list
(Starter_Lib.csv) will be in syscap\Libraries subdirectory of your map drive. If you are not familiar with the CIP
bulk import functionality, you may run through the steps in the Tutorial for Importing CSV Parts.

6. Install the CIP Client making sure to include the System Capture Client feature selection during install. If you
are upgrading the CIP Client, you will need to uninstall the existing version and run the
installer again to see the System Capture option. During install, at the CDS_SITE dialog,
enter the mapped drive information (e.g. L:\syscap). 

7. After you have completed your installation following the CIP client install guide, bring up your
System Capture version (e.g. 24.1) and make sure you see the CIP menu.

8. Select CIP > Open CIP  and log in. 
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9. Navigate to Admin > Configuration > System Capture to complete System Capture setup
and create PTF file. You will need to configure the location of your PTF file. Enter
$CDS_SITE/Libraries/SysCapModel if using the starter library. You can set up substitution
rules now if you would like.

10.Click the Generate button to create the PTF. This will take some time. A CMD window will
launch to create an index for System Capture. DO NOT close this window. It will close itself
when complete.

11.Now you are ready to create a new Project.

12.Select File > New > Project  to create a new DE-HDL project, making sure the project
selection is DE-HDL.

13.Switch to the CIP tab in System Capture and search for a part, and click the Place button
next to the System Capture Part field. Placement of TMP parts are disallowed.

14.Click on the part after place to view attribute added when place.

15.To see part list of parts in System Capture, select View > Panels > Unified Search to bring
up the Unified Search tab.
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16.You can skip log in if you don't have log in information.

17.After the Unified Search tab is open, enter "EMA" in the search string to see the parts import
from the starter library.
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